Living Image® Software

User’s Manual

Version 4.0
# Contents

1 Welcome ........................................ 1
   1.1 What’s New In Living Image 4.0 Software ......................... 1
   1.2 About This Manual .................................. 2
   1.3 Contacting Caliper Technical Support ....................... 3

2 Overview of Imaging & Image Analysis .......................... 5
   2.1 Workflow Overview ..................................... 5
   2.2 Imaging Modes ......................................... 7
   2.3 About Image Sequences ................................ 10
   2.4 Image Display & Analysis ................................ 11

3 Getting Started ........................................ 15
   3.1 Starting the Living Image Software ........................ 15
   3.2 Initializing the IVIS Imaging System ...................... 17
   3.3 Checking the System Temperature ........................ 17
   3.4 About the IVIS Acquisition Control Panel & Auto Exposure Feature .................... 18
   3.5 Tracking System & User Activity ......................... 19

4 Luminescent or Fluorescent Imaging ............................. 21
   4.1 Acquire a Luminescent Image ................................ 21
   4.2 Acquire a Fluorescent Image With Epi-Illumination .............. 24
   4.3 Acquire a Fluorescent Image With Transillumination ............. 28
   4.4 Acquire a Sequence Using the Imaging Wizard .................. 32
   4.5 Manually Set Up an Image Sequence ........................ 38
   4.6 High Resolution Imaging With the Optical Zoom Lens Attachment .......... 43
   4.7 Manually Saving Image Data ................................ 44
   4.8 Exporting Image Data ..................................... 45

5 X-Ray Imaging .......................................... 47
   5.1 Acquire an X-Ray Image ................................... 47
   5.2 Acquire an Image Sequence That Includes X-Ray Images ............. 52
   5.3 High Resolution Imaging With the Optical Zoom Lens Attachment .......... 59
   5.4 Measuring Relative Density ................................ 61

6 Kinetic Imaging ........................................ 65
   6.1 Kinetic Acquisition ....................................... 65
   6.2 High Resolution Imaging With the Optical Zoom Lens Attachment .......... 70
   6.3 Viewing & Editing Data in the Kinetic Acquisition Window .............. 72
   6.4 Saving Kinetic Data ....................................... 74
   6.5 Playing Kinetic Data ....................................... 75

7 Working With Data ....................................... 81
   7.1 Opening Data ........................................... 81
   7.2 About the Image Window & Tool Palette ...................... 85
7.3 Viewing Image Information .................................................. 87
7.4 Adjusting Image Appearance .................................................. 89
7.5 Correcting Image Data ......................................................... 91
7.6 Viewing Intensity Data & Making Measurements ......................... 93
7.7 Creating a Transillumination Overview .................................. 100
7.8 Overlaying Multiple Images .................................................. 101
7.9 Rendering Intensity Data in Color .......................................... 104
7.10 Exporting or Printing Images ................................................ 106
7.11 Editing an Image Sequence ................................................. 107
7.12 Creating an Image Sequence from Individual Images ................... 108

8 Working With ROI Tools .......................................................... 111
8.1 About ROIs ........................................................................ 111
8.2 Quick Guide: Drawing Measurement ROIs on an Image or Sequence .. 112
8.3 ROI Tools ........................................................................ 114
8.4 Measurement ROIs ............................................................... 116
8.5 Subject ROIs ....................................................................... 120
8.6 Measuring Background-Corrected Signal .................................. 120
8.7 Kinetic ROIs ....................................................................... 122
8.8 Managing ROIs .................................................................... 125
8.9 Managing the ROI Measurements Table .................................... 136

9 Image Math ........................................................................ 143
9.1 Creating a New Image Using Image Math .................................. 143
9.2 Subtracting Tissue Autofluorescence ....................................... 146

10 Planar Spectral Image Analysis ................................................. 149
10.1 Image Sequence Requirements ............................................... 149
10.2 Planar Spectral Image Analysis .............................................. 149
10.3 Viewing Graphical Results ..................................................... 152
10.4 Managing Planar Spectral Imaging Results ............................... 154

11 Spectral Unmixing ................................................................. 157
11.1 Image Sequence Requirements ............................................... 157
11.2 Performing Spectral Unmixing ................................................ 157
11.3 Spectra Window .................................................................. 162
11.4 Spectral Unmixing Parameters ............................................... 164
11.5 Spectral Unmixing Options ..................................................... 165

12 Reconstructing a 3D Surface ..................................................... 169
12.1 Generating a Surface ............................................................ 170
12.2 Managing Surfaces ............................................................... 174
12.3 Export or Import a Surface .................................................... 174
### 13 Point Source Fitting
- **13.1 Image Sequence Requirements**
- **13.2 Displaying the Point Source Fitting Tools**
- **13.3 Point Source Fitting**
- **13.4 Checking the Point Source Fitting Results**
- **13.5 Exporting Results**
- **13.6 Managing Results**
- **13.7 Point Source Fitting Tools**

### 14 3D Quantification Database
- **14.1 Preparing & Imaging the Samples**
- **14.2 Creating a Quantification Database**
- **14.3 Managing Quantification Results**

### 15 3D Reconstruction of Sources
- **15.1 Reconstructing Luminescent Sources**
- **15.2 Reconstructing Fluorescent Sources**
- **15.3 3D Reconstruction Results**
- **15.4 Checking the Reconstruction Quality**
- **15.5 Measuring Sources**
- **15.6 Displaying Luminescent & Fluorescent Sources on One Surface**
- **15.7 Exporting a 3D Scene**
- **15.8 3D Tools Overview**
- **15.9 3D Tools - Surface**
- **15.10 3D Tools - Source**
- **15.11 3D Tools - Registration**
- **15.12 3D Tools - Animate**
- **15.13 DLIT/FLIT Troubleshooting**

### Appendix A IVIS Acquisition Control Panel
- **A.1 Control Panel**
- **A.2 Manually Setting the Focus**

### Appendix B Preferences
- **B.1 General Preferences**
- **B.2 User Preferences**
- **B.3 Acquisition**
- **B.4 Theme**
- **B.5 Tissue Properties**

### Appendix C Detection Sensitivity
- **C.1 CCD Detection Efficiency**
- **C.2 Binning**
- **C.3 Smoothing**
<table>
<thead>
<tr>
<th>Appendix D Image Data Display &amp; Measurement</th>
<th>251</th>
</tr>
</thead>
<tbody>
<tr>
<td>D.1 Image Data</td>
<td>251</td>
</tr>
<tr>
<td>D.2 Quantifying Image Data</td>
<td>253</td>
</tr>
<tr>
<td>D.3 Flat Fielding</td>
<td>256</td>
</tr>
<tr>
<td>D.4 Cosmic Ray Corrections</td>
<td>256</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix E Luminescent Background Sources &amp; Corrections</th>
<th>257</th>
</tr>
</thead>
<tbody>
<tr>
<td>E.1 Electronic Background</td>
<td>257</td>
</tr>
<tr>
<td>E.2 Background Light On the Sample</td>
<td>258</td>
</tr>
<tr>
<td>E.3 Background Light From the Sample</td>
<td>260</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix F Fluorescent Imaging</th>
<th>263</th>
</tr>
</thead>
<tbody>
<tr>
<td>F.1 Description and Theory of Operation</td>
<td>263</td>
</tr>
<tr>
<td>F.2 Filter Spectra</td>
<td>265</td>
</tr>
<tr>
<td>F.3 Working with Fluorescent Samples</td>
<td>267</td>
</tr>
<tr>
<td>F.4 Image Data Display</td>
<td>268</td>
</tr>
<tr>
<td>F.5 Fluorescent Background</td>
<td>269</td>
</tr>
<tr>
<td>F.6 Subtracting Instrument Fluorescent Background</td>
<td>274</td>
</tr>
<tr>
<td>F.7 Adaptive Background Subtraction</td>
<td>274</td>
</tr>
<tr>
<td>F.8 Subtracting Tissue Autofluorescence Using Background Filters</td>
<td>275</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix G Planar Spectral Imaging</th>
<th>277</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.1 Planar Spectral Imaging Theory</td>
<td>277</td>
</tr>
<tr>
<td>G.2 Optical Properties</td>
<td>279</td>
</tr>
<tr>
<td>G.3 Luciferase Spectrum</td>
<td>279</td>
</tr>
<tr>
<td>G.4 An Example of Planar Spectral Imaging</td>
<td>280</td>
</tr>
<tr>
<td>G.5 Optimizing the Precision of Planar Spectral Analysis</td>
<td>283</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix H DLIT &amp; FLIT Reconstruction of Sources</th>
<th>285</th>
</tr>
</thead>
<tbody>
<tr>
<td>H.1 Determining Surface Topography</td>
<td>285</td>
</tr>
<tr>
<td>H.2 Converting Light Emission to a Photon Density Map</td>
<td>286</td>
</tr>
<tr>
<td>H.3 Defining the Linear Relationship Between a Source and Photon Density or NTF Efficiency</td>
<td>287</td>
</tr>
<tr>
<td>H.4 Determining the Best Approximate Solution to the Linear System</td>
<td>288</td>
</tr>
<tr>
<td>H.5 Source &amp; Tissue Properties</td>
<td>288</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix I IVIS Syringe Injection System</th>
<th>291</th>
</tr>
</thead>
<tbody>
<tr>
<td>I.1 Controlling the Infusion Pump</td>
<td>291</td>
</tr>
<tr>
<td>I.2 Tracking Infusion in the Maximum vs. Time Graph</td>
<td>293</td>
</tr>
<tr>
<td>I.3 Closing the Infusion Pump Control Panel</td>
<td>293</td>
</tr>
</tbody>
</table>

| Appendix J Menu Commands, Tool Bar, & Shortcuts | 295 |

iv  Living Image Software User’s Manual
1 Welcome

What’s New In Living Image 4.0 Software ........................................... 1
About This Manual ........................................................................ 2
Contacting Caliper Technical Support .......................................... 3

The Living Image software controls image acquisition on IVIS imaging systems, and
provides tools for optimizing image display and analyzing images.

1.1 What’s New In Living Image 4.0 Software

The major new features in the Living Image software include:

<table>
<thead>
<tr>
<th>New Feature or Updated Tool</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X-Ray Imaging</strong></td>
<td></td>
</tr>
<tr>
<td>Acquire X-ray images on the IVIS Lumina XR imaging system. Co-register an X-ray image with a luminescence, fluorescence, or photographic image.</td>
<td>47</td>
</tr>
<tr>
<td>Determine relative density in an x-ray image using ROIs</td>
<td>61</td>
</tr>
<tr>
<td><strong>Fluorescence Imaging</strong></td>
<td></td>
</tr>
<tr>
<td>NTF Efficiency image available for fluorescent acquisition with transillumination</td>
<td>28</td>
</tr>
<tr>
<td><strong>Kinetic Imaging</strong></td>
<td></td>
</tr>
<tr>
<td>Acquire ventral kinetic data using the Ventral Imaging Chamber</td>
<td>65</td>
</tr>
<tr>
<td><strong>Close Up/High Resolution Imaging</strong></td>
<td></td>
</tr>
<tr>
<td>Optical Zoom Lens attachment enables close up/high resolution imaging (luminescent, fluorescent, X-ray, or kinetic imaging) on the IVIS Lumina, IVIS Lumina XR, and IVIS Kinetic imaging systems</td>
<td>43</td>
</tr>
<tr>
<td>3D Surfaces</td>
<td></td>
</tr>
<tr>
<td>Select a particular region of the subject to reconstruct</td>
<td>170</td>
</tr>
<tr>
<td>Export a 3D surface or a user-selected portion of the surface in DICOM format. Multi-frame export option supports 3D CT reconstruction in third party software.</td>
<td>175</td>
</tr>
<tr>
<td>Expanded export and import capabilities for reconstructed 3D surfaces (XMH, DXF, STL, IV)</td>
<td>175</td>
</tr>
<tr>
<td><strong>3D Sources</strong></td>
<td></td>
</tr>
<tr>
<td>Living Image software automatically selects the data to include in the reconstruction based on the Threshold% value</td>
<td>199</td>
</tr>
<tr>
<td>Select particular data for the reconstruction</td>
<td>199</td>
</tr>
<tr>
<td>Quantify the number of cells in a luminescent source or dye molecules in a fluorescent source</td>
<td>197</td>
</tr>
<tr>
<td>Display luminescent or fluorescent sources on one surface</td>
<td>212</td>
</tr>
<tr>
<td>Export source voxels or source surfaces</td>
<td>212</td>
</tr>
<tr>
<td><strong>Spectral Unmixing</strong></td>
<td></td>
</tr>
<tr>
<td>A spectral unmixing wizard for image sequence setup</td>
<td>159</td>
</tr>
<tr>
<td>Distinguish the spectral signatures of up to four different fluorescent or luminescent reporters</td>
<td></td>
</tr>
<tr>
<td>The Spectra window displays the spectra plots of the unmixed results. Add other spectra to the plot (from the Living Image source library or the spectrum associated with an ROI)</td>
<td>162</td>
</tr>
<tr>
<td>View user-selected probes in the composite view</td>
<td>161</td>
</tr>
<tr>
<td>Apply signal thresholds</td>
<td>159</td>
</tr>
<tr>
<td><strong>ROIs</strong></td>
<td></td>
</tr>
<tr>
<td>Automatically draw ROIs on all images in the Sequence View window.</td>
<td>112</td>
</tr>
</tbody>
</table>
1.2 About This Manual

This user manual explains how to acquire image data on an IVIS imaging system and analyze images using the Living Image software. The manual provides detailed instructions and screenshots that depict the system response.

**NOTE**

Sometimes the screenshots in the manual may not exactly match those displayed on your screen.

For more details on your IVIS imaging system, please see the appropriate system manual.

**Conventions Used In the Manual**

<table>
<thead>
<tr>
<th>Convention</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu commands are bolded.</td>
<td>To open image data, select <strong>File → Open Dataset</strong> on the main bar.</td>
</tr>
<tr>
<td>Toolbar button names are bolded.</td>
<td>To open image data, click the <strong>Open Dataset</strong> button 📀.</td>
</tr>
<tr>
<td>Numbered steps explain how to carry out a procedure.</td>
<td>1. To start the Living Image software, click the 📦 icon on the desktop.</td>
</tr>
<tr>
<td>Document names are italicized.</td>
<td><strong>Living Image Software User’s Guide</strong></td>
</tr>
<tr>
<td>Note information</td>
<td><strong>NOTE</strong></td>
</tr>
<tr>
<td></td>
<td>A note presents pertinent details on a topic.</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Notes may also appear in this format.</td>
</tr>
<tr>
<td>Caution information</td>
<td><strong>CAUTION</strong></td>
</tr>
<tr>
<td></td>
<td><strong>CAUTION!</strong> A caution note warns you that your actions may have nonreversible consequences or may cause loss of data.</td>
</tr>
<tr>
<td>Important information</td>
<td><strong>IMPORTANT</strong></td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT!</strong> Important information advises you of actions that are essential to the correct performance of the instrument or software.</td>
</tr>
</tbody>
</table>
Living Image Help

There are several ways to obtain help on the software features:

- To view a tooltip about a button function, put the mouse cursor over the button.
- To view a brief description about an item in the user interface, click the toolbar button, then click the item.
- Press F1 or select Help → User Guide on the menu bar to display the Living Image Software User’s Manual (.pdf).

1.3 Contacting Caliper Technical Support

If you need technical support, please contact Caliper at:

Telephone: 1.877.LabChip (877.522.2447) Toll Free in the United States
1.508.435.9761

E-mail: tech.support@caliperLS.com

Fax: 1.508.435.0950

Address: Caliper Life Sciences
68 Elm Street
Hopkinton, MA 01748
USA
2 Overview of Imaging & Image Analysis

Workflow Overview

Imaging Modes

About Image Sequences

Image Display & Analysis

This chapter provides a brief overview of imaging and image analysis.

2.1 Workflow Overview

The Living Image software provides image acquisition, viewing, and analysis functions for IVIS Imaging Systems. Figure 2.1 shows the steps to acquire an image. Figure 2.2 shows an example sequence acquisition workflow.

1. Start the Living Image software & initialize the IVIS Imaging System

2. In the control panel:
   - Select the imaging modes (for example, luminescent & photograph)
   - Set the imaging parameters
   - When you are ready to acquire the images, click Acquire

3. Enter image label information (optional)

4. The image window & Tool Palette appear when acquisition is finished

Figure 2.1 Steps to acquire a luminescent or fluorescent image
1. Start the Living Image software & initialize the IVIS Imaging System

2. In the control panel:
   - Click **Sequence Setup**
   - Click the Imaging Wizard button

3. In the Imaging Wizard, double-click Bio luminescence or Fluorescence and step through the wizard

4. In the control panel, click **Acquire Sequence**

5. Enter image label information (optional)

6. The image window appears and displays the images as they are acquired

**Figure 2.2** Steps to acquire an image sequence
2.2 Imaging Modes

Table 2.1 shows the imaging modes that are available on IVIS Imaging Systems. Table 2.2 shows examples of the different types of images.

You can acquire:

- Single images, for example, a luminescent image and a photograph. After acquisition, the Living Image software automatically coregisters images to generate an overlay image.
- An image sequence - a collection of images that are grouped together in a single folder (Figure 2.3).

Table 2.1  IVIS Imaging Systems & imaging modes

<table>
<thead>
<tr>
<th>Imaging Mode</th>
<th>IVIS Imaging System</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lumina II</td>
</tr>
<tr>
<td>Photograph</td>
<td>✓</td>
</tr>
<tr>
<td>Luminescent</td>
<td>✓</td>
</tr>
<tr>
<td>Fluorescent</td>
<td>✓</td>
</tr>
<tr>
<td>Structure</td>
<td>✓</td>
</tr>
<tr>
<td>X-ray</td>
<td>✓</td>
</tr>
<tr>
<td>Kinetics</td>
<td>✓</td>
</tr>
</tbody>
</table>

NOTE
For details on your IVIS Imaging System, please see the imaging system hardware manual.

Double-click an image in the Sequence View to open it in a separate window.

Figure 2.3  Example image sequence. Overlay images: luminescent image on photograph
### Table 2.2  Image types

<table>
<thead>
<tr>
<th>Imaging Mode</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photograph</td>
<td>A short exposure of the subject illuminated by the lights located in the ceiling of the imaging chamber. The photographic image is displayed as a grayscale image.</td>
<td><img src="image" alt="Photograph example" /></td>
</tr>
<tr>
<td>Luminescent</td>
<td>A longer exposure of the subject taken in darkness to capture low level luminescence emission. The luminescent image is displayed in pseudocolor that represents intensity. For more details on luminescent image data, see Appendix D, page 251.</td>
<td><img src="image" alt="Luminescent example" /></td>
</tr>
<tr>
<td>Fluorescent</td>
<td>An exposure of the subject illuminated by filtered light. The target fluorophore emission is captured and focused on the CCD camera. Fluorescent image data can be displayed in units of counts or photons (absolute, calibrated), or in terms of efficiency (calibrated, normalized). For more details on fluorescence image data, see Appendix F, page 263</td>
<td><img src="image" alt="Fluorescent example" /></td>
</tr>
</tbody>
</table>
### Table 2.2 Image types

<table>
<thead>
<tr>
<th>Imaging Mode</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>A structured light image of parallel laser scanned across the subject. The surface topography of the subject is determined from the structured light image.</td>
<td><img src="image" alt="Structure Image" /></td>
</tr>
<tr>
<td>X-ray</td>
<td>An exposure of the subject using the X-ray energy source on the Lumina XR. The X-ray image is displayed as a grayscale image.</td>
<td><img src="image" alt="X-ray Image" /></td>
</tr>
<tr>
<td>X-ray</td>
<td><img src="image" alt="Overlay: Fluorescent image on X-ray image" /></td>
<td></td>
</tr>
<tr>
<td>Kinetic</td>
<td>A series of images captured on the IVIS Kinetic Imaging System that enables visualization of luminescent or fluorescent signals in real time.</td>
<td><img src="image" alt="Kinetic Image" /></td>
</tr>
<tr>
<td></td>
<td>Play back kinetic data in real time or view a particular frame(s)</td>
<td></td>
</tr>
</tbody>
</table>
2.3 About Image Sequences

A sequence is a collection of images that are grouped together in a single folder. A sequence may include images that are acquired during the same session and are intended to be grouped together. For example, images taken at different time points or an image sequence for DLIT or FLIT 3-D tomographic analysis.

Images that were acquired during different sessions can also be grouped together to form a sequence (for more details, see page 108). For example, a time series could be constructed from images acquired on different days following an experimental treatment.

Some types of analyses are performed on an image sequence (see Table 2.3). The sequence requirements (number and type of images) depend on the type of analysis.

Table 2.4 shows the types of analyses that are possible on the different IVIS Imaging Systems.

Table 2.3 Analyses that require an image sequence

<table>
<thead>
<tr>
<th>Analysis</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planar spectral image</td>
<td>Computes the total flux and average depth of a luminescent source below the surface.</td>
<td>10</td>
</tr>
<tr>
<td>Display multiple fluorescent or luminescent reporters</td>
<td>Uses the Image Overlay function to display multiple luminescent or fluorescent images on one photographic image.</td>
<td>101</td>
</tr>
<tr>
<td>Subtract tissue autofluorescence using blue-shifted background filters</td>
<td>Uses the image math feature to subtract a background image from the primary image.</td>
<td>143</td>
</tr>
<tr>
<td>Point Source Fitting</td>
<td>Estimates the optical properties of tissue, the location and power of a point source, or the fluorescent yield of fluorophores.</td>
<td>177</td>
</tr>
<tr>
<td>Spectral unmixing</td>
<td>Removes tissue autofluorescence from a fluorescence image.</td>
<td>157</td>
</tr>
<tr>
<td>DLIT</td>
<td>Reconstructs the brightness and 3D location of luminescent sources.</td>
<td>195</td>
</tr>
<tr>
<td>FLIT</td>
<td>Reconstructs the brightness and 3D location of fluorescent sources.</td>
<td>202</td>
</tr>
</tbody>
</table>

Table 2.4 IVIS Imaging System capabilities

<table>
<thead>
<tr>
<th>Acquire a Sequence for...</th>
<th>Lumina</th>
<th>Lumina XR</th>
<th>100 Series</th>
<th>200 Series</th>
<th>Spectrum</th>
<th>Kinetic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planar spectral image analysis</td>
<td>optional*</td>
<td>optional*</td>
<td>optional*</td>
<td>yes</td>
<td>yes</td>
<td>optional*</td>
</tr>
<tr>
<td>Displaying multiple fluorescent or luminescent reporters</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Subtracting tissue autofluorescence using blue-shifted background filters</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Point Source Fitting</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Spectral unmixing</td>
<td>optional*</td>
<td>optional*</td>
<td>optional*</td>
<td>yes</td>
<td>yes</td>
<td>optional*</td>
</tr>
<tr>
<td>DLIT Analysis</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>FLIT Analysis</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>

*Optional, requires premium filters
2.4 Image Display & Analysis

You’ll find most of the tools for adjusting image display and analyzing images in the Tool Palette. The Tool Palette automatically appears when acquisition is finished or when you open image data. Its contents depend on the type of image data that is active. Figure 2.4 shows the tools that are available for an image or a kinetic sequence. Figure 2.5 shows the Tool Palette for an example image sequence.

Click a section of the Tool Palette to show or hide the tools.

Image Adjust Tools (page 89)
- Tune the photograph brightness, gamma (similar to contrast), or opacity
- Set the image display color scale minimum and maximum
- Select a color table for image display

Corrections/Filtering Tools (page 91)
- Subtract dark background from the image data
- Apply flat field correction to the image data
- Specify pixel binning
- Smooth the pixel signal

Image Information Tools (page 93)
- Display x,y coordinates and intensity data at a user-selected location on the image
- Display a histogram of pixel intensities in an image
- Plot the intensity (y-axis) at each pixel (x-axis) along a user-specified line in the image
- Measure distance in an image

ROI Tools (page 111)
- Measure counts or photons in a user-specified region of interest (ROI) and compute measurement statistics (for example, average, min, max, standard deviation)
- Measure efficiency, radiant efficiency, or NTF efficiency in the ROI and compute measurement statistics (for fluorescent images only)

Figure 2.4 Tools that are available for a single image (luminescent, fluorescent, X-ray) or a kinetic sequence
Image sequence (luminescent or fluorescent)

Figure 2.5  Tools palette for an example luminescent image sequence

<table>
<thead>
<tr>
<th>Analyses Requiring an Image Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Planar Spectral Imaging</strong>&lt;br&gt;(page 149)</td>
</tr>
<tr>
<td>Determines the average depth and total photon flux of a luminescent point source in a user-specified region of interest. Analyzes a sequence of luminescent images acquired using different emission filters.</td>
</tr>
</tbody>
</table>

**Image Adjust Tools**<br>(page 110)
- Tune the photograph brightness, gamma (similar to contrast), or opacity
- Set the image display color scale minimum and maximum
- Select a color table for image display

**ROI Tools**<br>(page 111)
- Measure counts or photons in a user-specified region of interest (ROI) and compute measurement statistics (for example, average, min, max, standard deviation)
- Measure efficiency in the ROI and compute measurement statistics (for fluorescent images only)
Additional tools are available in the menu bar (click **Tools** on the menu bar).

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well Plate Quantification</td>
<td>Analyzes images of known serial dilutions of luminescent cells or fluorescent dye molecules and generates a quantification database. The software uses the quantification database to determine the number of cells in a DLIT source or the number of cells or dye molecules in a FLIT source.</td>
<td>187</td>
</tr>
<tr>
<td>Image Overlay</td>
<td>Displays multiple luminescent or fluorescent images on one photograph.</td>
<td>101</td>
</tr>
<tr>
<td>Colorize</td>
<td>Renders luminescence or fluorescence data in color, enabling you to see both intensity and spectral information in a single view. The tool provides a useful way to visualize multiple probes or scale probe signals that are not in the visible range.</td>
<td>104</td>
</tr>
<tr>
<td>Transillumination Overview for &lt;name&gt;_SEQ</td>
<td>Generates an overview image for each filter pair that includes the data from all of the transillumination locations. The overview image can be analyzed using the tools in the Tool Palette.</td>
<td>100</td>
</tr>
<tr>
<td>Image Math</td>
<td>A method for mathematically combining two images (add, multiply, or subtract). Use image math to remove autofluorescence from a fluorescent image.</td>
<td>143</td>
</tr>
</tbody>
</table>
[This page intentionally blank.]
3 Getting Started

This chapter explains how to start the Living Image software and initialize the IVIS Imaging System. After it is initialized, the imaging system is ready to acquire images.

3.1 Starting the Living Image Software

The Living Image software on the PC workstation that controls the IVIS Imaging System includes both the acquisition and analysis features. The Living Image software on other workstations includes only the analysis features. For information on installing the software, see the Installation Guide included on the Living Image CD ROM. By default, the software is installed at:

PC: C:Programs:Caliper Life Sciences: Living Image

Macintosh: Applications:Caliper Life Sciences: Living Image

NOTE

All components of the IVIS Imaging System should be left on at all times due to the long cooling time required to reach operating (demand) temperature. It is also important to leave the system on to enable automatic overnight electronic background measurements. Periodically rebooting the computer is permissible and does not affect the camera operation.

To start the software:

1. **PC Users:** Click the Windows Start menu button and select *All Programs* ➔ *Living Image*. Alternatively, click the Living Image software icon on the desktop.

   Macintosh Users: Click the Living Image icon on the desktop or run the software from the application folder.

   — The main window appears (Figure 3.1).
2. Select a user ID from the drop-down list or enter a new User ID (up to three letters), and click OK.

   The control panel appears if the workstation controls the IVIS Imaging System (Figure 3.2). For more details on the control panel, see Appendix A, page 231.

**NOTE**

The Living Image software on the PC workstation that controls the IVIS Imaging System includes both the acquisition and analysis features. The Living Image software on other workstations includes only the analysis features. Macintosh users have access to the analysis features only.
3.2 Initializing the IVIS Imaging System

The imaging system must be initialized each time the Living Image software is started, or if the power has been cycled to the imaging chamber or the camera controller (a component of some IVIS Imaging Systems). The initialization procedure moves every motor-driven component in the system (for example, stage and lens) to a home position, resets all electronics and controllers, and restores all software variables to the default settings. Initialization may be useful in error situations. For further details on instrument operation, see your IVIS Imaging System hardware manual.

To initialize the IVIS Imaging System:
3. Start the Living Image software (double-click the icon on the desktop).
4. In the control panel that appears, click Initialize.
   — You will hear the motors move.

![IVIS Acquisition Control Panel](image)

**Figure 3.3** IVIS® Acquisition control panel

**NOTE**
The control panel is only available on the workstation that controls the imaging system. The items available in the control panel depend on the particular IVIS Imaging System and the imaging mode selected (luminescent or fluorescent, Image Setup or Sequence Setup mode).

3.3 Checking the System Temperature

The temperature box in the IVIS acquisition control panel indicates the temperature status of the charge coupled device (CCD) camera (Figure 3.4). After you initialize the system, the temperature box turns green when the temperature is locked at the demand temperature (-90 °C or -105 °C for IVIS Systems cooled by a Cryotiger® unit), indicating the instrument is ready for operation and image acquisition.

The demand temperature for the CCD camera is fixed. Electronic feedback control maintains the CCD camera temperature to within a few degrees of the demand temperature. The default temperature of the stage in the imaging chamber is 37 °C, but may be set to a temperature from 25-40 °C.
NOTE

The items in the control panel depend on the particular IVIS Imaging System and the imaging mode selected (luminescent or fluorescent, Image Setup or Sequence Setup mode). For more details on the control panel, see Appendix A, page 231.

The IVIS Imaging System is ready for imaging after the system is initialized and the operating (demand) temperature of the CCD camera is reached (locked).

3.4 About the IVIS Acquisition Control Panel & Auto Exposure Feature

The control panel (Figure 3.5) provides the image acquisition functions. For details on the imaging parameters in the control panel, see Appendix A, page 231.

The auto exposure setting is useful in situations where the signal strength is unknown or varies widely, for example during a time course study. When you choose auto exposure (Figure 3.5), the system acquires an image at maximum sensitivity, then calculates the required settings to achieve, as closely as possible, an image with a user-specified target max count. If the resulting image has too little signal or saturated pixels, the software adjusts the parameters and takes another image.

In most cases, the default auto exposure settings provide a good luminescent or fluorescent image. However, you can modify the auto exposure preferences to meet your needs. For more details, see page 241.
NOTE

The options available in the IVIS acquisition control panel depend on the selected imaging mode, the imaging system, and the installed filter wheel or lens option.

### 3.5 Tracking System & User Activity

The Activity window shows the imaging system activities. The software creates and saves a log of the system activities related to data acquisition, for example, the type and number of acquired images, fluorescent lamp usage, X-ray tube accumulated usage, and kinetic camera usage. This information may be useful for Caliper field service engineers to understand the imaging system behavior over time or for troubleshooting. You’ll find the activity log at C:\Program Files\Living Image.

![Activity window](image)

**Figure 3.5** IVIS acquisition control panel

**Figure 3.6** Activity window
The software tracks user time on the system (hr/min/sec per user ID) from logon until switching users or system shut down. The software creates a separate record for each month (for example, LI_USAGE_<MONTH>_2009.csv) located at C:Program Files\Caliper Life Sciences\Living Image\Usage).

Software Help

There are several ways to obtain help on the software features:

- To view a tooltip about a button function, put the mouse cursor over the button.
- To view a brief description about an item in the user interface, click the toolbar button, then click the item.

Press F1 or select Help → User Guide on the menu bar to display the Living Image Software User’s Manual (.pdf).
The IVIS Imaging System is ready to acquire images after the system is initialized and the CCD camera reaches operating (demand) temperature (locked). This chapter explains how to acquire a luminescent or fluorescent image or image sequence.

This section explains how to acquire an image in the following modes:

- Luminescent (see below)
- Fluorescent with epi-illumination (page 24)
- Fluorescent with transillumination (page 28)

### 4.1 Acquire a Luminescent Image

1. Start the Living Image software (double-click the icon on the desktop).
2. Initialize the IVIS Imaging System and confirm or wait for the CCD temperature to lock. (For more details, see page 17.)
3. In the control panel, put a check mark next to **Luminescent** and select **Auto** exposure (click the arrow).
   
   When you select Auto exposure, the software automatically determines the binning and F/Stop settings. Alternately, you can manually set the exposure, binning, and F/Stop. For more details on these control panel settings, see page 231.

4. Put a check mark next to **Photograph** and select **Auto** exposure (click the arrow).
5. Make a selection from the Field of View drop-down list. For more details on the field of view, see page 233.
6. Set the **Focus**:
   - Select **use subject height** and use the arrows or the keyboard arrows to specify a subject height (cm).
   - Select **manual focus**. For more details on manual focusing see page 236.
   - Select **scan mid range** (available on the IVIS 200 or Spectrum Imaging System only). The imaging system determines the subject height using a laser scan. This value is automatically entered in the subject height box and is used to set the focal length.

7. If necessary, click in the control panel to operate in single image mode.

   **NOTE**
   
   In single image mode, the button appears in the control panel. Click this button to set up sequence acquisition.

8. To acquire an overlay image (coregistered images) for display after acquisition, put a check mark next to **Overlay**.

   **NOTE**
   
   To view the subject(s) inside the chamber before image acquisition, take a photograph. Uncheck the Luminescent option, choose the Photograph and Auto options, and click **Acquire**.

9. When you are ready to capture the image, click **Acquire**.

   ![Edit Image Labels box](image.png)
   
   The information entered here appears in the image label (Figure 4.4).

   **Figure 4.2** Edit Image Labels box

10. In the Edit Image Labels box that appears (Figure 4.2), enter information about the image and click **OK**.
NOTE
You can enter image label information at any time during or after acquisition. If you do not want to enter image information, click Cancel.

11. If this is the first image of the session, you are prompted to enable the autosave function.

![Autosave prompt](image)

**Figure 4.3** Autosave prompt

12. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that appears.

If autosave is enabled, all images acquired during the session are automatically saved to a user-selected folder. You can choose a different folder at any time (select Acquisition → Auto-Save on the menu bar).

Image acquisition proceeds. During acquisition, the control panel Acquire button becomes a Stop button. To cancel the acquisition, click Stop in the control panel. The image window appears when acquisition is completed (Figure 4.4).

![Image window](image)

**Figure 4.4** Overlay (luminescent image on photograph) in the image window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Select the measurement units for the image display from this drop-down list. The available units depend on the type of image data. For more details on measurement units, see page 253.</td>
</tr>
</tbody>
</table>

Table 4.1 Image window
4.2 Acquire a Fluorescent Image With Epi-Illumination

Epi-illumination provides an excitation light source located above the stage. For more information about fluorescent imaging, see page 263.

1. Start the Living Image software (double-click the icon on the desktop).
2. Initialize the IVIS Imaging System and confirm or wait for the CCD temperature to lock. (For more details, see page 17.)
3. In the control panel, put a check mark next to Fluorescent and select Auto exposure (click the arrow).

   When you select Auto exposure, the software automatically determines the binning and F/Stop settings. Alternatively, you can manually set the exposure, binning, and F/Stop. For more details on these control panel settings, see page 231.
4. Select an excitation and emission filter from the drop-down lists. For more information about the standard filter sets, see Table F.1, page 266.

5. Put a check mark next to Photograph and select Auto exposure (click the arrow).

6. Make a selection from the Field of View drop-down list. For more details on the field of view, see page 233.

7. Set the Focus by selecting one of the following from the Focus drop-down list:
   - Select use subject height and use the arrows or the keyboard arrows to specify a subject height (cm).
   - Select manual focus. For more details on manual focusing see page 236.
   - Select scan mid range (available on the IVIS 200 or Spectrum Imaging System only). The imaging system determines the subject height using a laser scan. This value is automatically entered in the subject height box and is used to set the focal length.

8. If necessary, click in the control panel to operate in single image mode.

**NOTE**
In single image mode, the button appears in the control panel. Click this button to set up sequence acquisition.

9. To acquire an overlay image (coregistered images) for display after acquisition, put a check mark next to Overlay.

**NOTE**
To view the subject(s) inside the chamber before image acquisition, take a photograph. Uncheck the Fluorescent option, choose the Photograph and Auto options, and click Acquire.

10. When you are ready to capture the image, click Acquire.
11. In the Edit Image Labels box that appears, enter information about the image and click OK.

**NOTE**

You can enter image label information at any time during or after acquisition. If you do not want to enter image information, click Cancel.

12. If this is the first image of the session, you are prompted to enable the autosave function.

![Autosave prompt](image)

**Figure 4.7** Autosave prompt

13. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that appears.

If autosave is enabled, all images acquired during the session are automatically saved to a user-selected folder. You can choose a different folder at any time (select **Acquisition → Auto-Save** on the menu bar).

Image acquisition proceeds. During acquisition, the control panel Acquire button becomes a Stop button. To cancel the acquisition, click Stop in the control panel. The image window appears when acquisition is completed (**Figure 4.8**).
Check the image min and max in the color scale to determine whether the signal of interest is above the noise level and below CCD saturation.

Figure 4.8 Overlay (fluorescent image on photograph) in the image window
For more details on the items in the image window, see Table 4.1, page 23.
4.3 Acquire a Fluorescent Image With Transillumination

Transillumination provides an excitation light source located below the stage. FLIT reconstruction of fluorescent sources analyzes a transilluminated image sequence. For more information about fluorescent imaging, see page 263.

If the fluorescent source is deep relative to the imaged side of the animal, acquisition with transillumination is recommended. By default, acquisition with transillumination includes an NTF Efficiency image in which the fluorescent emission image is normalized by the transmission image measured with the same emission filter and open excitation filter (Figure 4.9).

NOTE

Transillumination is only available on the IVIS Spectrum Imaging System.

To acquire a fluorescent image with transillumination:

1. Start the Living Image software (double-click the icon on the desktop).
2. Initialize the IVIS Imaging System and confirm or wait for the CCD temperature to lock. (For more details, see page 17.)
3. In the control panel, put a check mark next to Fluorescent and Transillumination (Figure 4.10).

NOTE

The Normalization option is selected by default so that NTF Efficiency images can be produced.
4. Select an excitation and emission filter from the drop-down lists. For more information about the standard filter sets, see Table F.1, page 266.

5. Click Setup.

If you are prompted to acquire a subject photograph, click Yes.

6. In the Transillumination Setup box that appears (Figure 4.11), choose the location for transillumination and image acquisition (click a square).
7. Confirm that the Lamp Level is set to High.

8. Make a selection from the Field of View drop-down list. For more details on the field of view, see page 233.

9. Set the Focus:
   - Select use subject height and use the arrows or the keyboard arrows to specify a subject height (cm).
   - Select manual focus. For more details on manual focusing see page 236.
   - Select scan mid range (available on the IVIS 200 or Spectrum Imaging System only). The imaging system determines the subject height using a laser scan. This value is automatically entered in the subject height box and is used to set the focal length.

10. If necessary, click in the control panel to operate in single image mode.

   **NOTE**
   In single image mode, the button appears in the control panel. Click this button to set up sequence acquisition.

11. To acquire an overlay image (coregistered images) for display after acquisition, put a check mark next to Overlay.

   **NOTE**
   To view the subject(s) inside the chamber before image acquisition, take a photograph. Uncheck the Fluorescent option, choose the Photograph and Auto options, and click Acquire.

12. When you are ready to capture the image, click Acquire.
13. In the Edit Image Labels box, enter information about the image and click **OK**.

**NOTE**
You can enter image label information at any time during or after acquisition. If you do not want to enter image information, click **Cancel**.

14. If this is the first image of the session, you are prompted to enable the autosave function.

15. To enable autosave, click **Yes** in the prompt and choose a folder in the dialog box that appears.

   If autosave is enabled, all images acquired during the session are automatically saved to a user-selected folder. You can choose a different folder at any time (select **Acquisition → Auto-Save** on the menu bar).

   Image acquisition proceeds. During acquisition, the control panel **Acquire** button becomes a **Stop** button. To cancel the acquisition, click **Stop** in the control panel. The image window and Tool Palette appear when acquisition is completed (Figure 4.8, page 27).
4.4 Acquire a Sequence Using the Imaging Wizard

To acquire an image sequence, first specify the acquisition parameters for each image in the sequence editor (Figure 4.15). The Imaging Wizard provides a convenient way to do this for some imaging applications (Table 4.3). The wizard guides you through a series of steps, prompting you for the information that the software needs to set up the sequence in the sequence editor.

If you don’t use the wizard, you can set up a sequence manually (for more details, see page 38).

![Imaging Wizard](image)

**Table 4.3 Imaging Wizard options**

<table>
<thead>
<tr>
<th>Bioluminescence</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Filter</td>
<td>Acquires an image at maximum sensitivity.</td>
<td></td>
</tr>
<tr>
<td>Planar Spectral</td>
<td>Analyze the sequence to compute the average depth and total photon flux of a luminescent point source in a region of interest (ROI).</td>
<td>149</td>
</tr>
<tr>
<td>Spectral Unmixing</td>
<td>Analyze the sequence to determine spectral signature of different reporters in the same image and calculate the contribution of each reporter on each pixel in the image.</td>
<td>157</td>
</tr>
<tr>
<td>DLIT</td>
<td>Apply the DLIT algorithm to the sequence to reconstruct the 3D surface topography of the subject and the position, geometry, and strength of the luminescent sources.</td>
<td>195</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fluorescence</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Pair</td>
<td>Choose this option to acquire measurements of one or more fluorescent probes.</td>
<td></td>
</tr>
<tr>
<td>Spectral Unmixing/Filter Scan</td>
<td>Analyze a sequence to extract the signal of one or more fluorophores from the tissue autofluorescence. Helps you determine the optimum excitation and emission filter for a probe.</td>
<td>157</td>
</tr>
<tr>
<td>FLIT</td>
<td>Apply the FLIT™ algorithm to the sequence to reconstruct the 3D surface topography of the subject and the position, geometry, and strength of the fluorescent sources.</td>
<td>202</td>
</tr>
</tbody>
</table>

**NOTE**

For details on acquiring a sequence on the Lumina XR that includes X-ray images, see Chapter 5, page 47.
Sequence Setup Using the Imaging Wizard

1. Click **Sequence Setup** in the control panel (Figure 4.15).
   The sequence editor appears.
2. If necessary, click the **Remove** button and select **All** to clear the sequence editor.
3. Click the **Imaging Wizard** button.
4. In the wizard, choose bioluminescence or fluorescence imaging.
5. In the next wizard screen, choose the type of image sequence that you want to acquire. Step through the rest of the wizard.
   When you complete the wizard, the sequence information appears in the sequence editor (Figure 4.17).
NOTE

The imaging options available in the Imaging Wizard depend on the IVIS Imaging System and the installed filter set.

Acquire the Image Sequence

1. Confirm that the IVIS Imaging System is initialized and the CCD temperature is locked. (For more details, see page 17.)
2. When you are ready to acquire the images, click **Acquire Sequence** in the control panel.
   
The Edit Image Labels box appears.
3. In the Edit Image Labels box, enter information about the image and click OK. If you do not want to enter image information, click Cancel.

4. If this is the first image of the session, you are prompted to enable the autosave function.

5. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that appears.
   
   If autosave is enabled, all images acquired during the session are automatically saved to a user-selected folder. You can choose a different folder at any time (select Acquisition → Auto-Save on the menu bar).

   Image acquisition proceeds. The Sequence View window appears and displays the images as they are acquired. The Tool Palette appears when acquisition is completed (Figure 4.20).

6. To stop acquisition, click the Stop in the control panel. To pause acquisition, click Pause in the control panel.
NOTE

The Spectra window is available if the acquisition included multiple wavelengths. The Spectra window provides a convenient way to view probe spectra from the factory-installed library and ROIs. For more details, see page 162.

Table 4.4 Sequence View window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Select the measurement units for the image display from this drop-down list. The available units depend on the type of image. For more details on measurement units, see page 253.</td>
</tr>
<tr>
<td>Use Saved Colors</td>
<td>Choose this option to display the image data using the color table that was specified in the Preferences at the time of acquisition. If this option is not selected, image data are displayed using the color table currently specified in the Preferences.</td>
</tr>
</tbody>
</table>
### Table 4.4 Sequence View window (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Layout - Choose a display option for the images in a sequence (Default, Dynamic, or Film Strip). For example, here is Film Strip mode:</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>Sort by</td>
<td>Options for ordering images in the sequence window. This option only applies to images that were opened using the “Load as Group” function in the LiVing Image browser.</td>
</tr>
<tr>
<td></td>
<td>Default - Order in which the images are stored in the folder</td>
</tr>
<tr>
<td></td>
<td>TimeStamp - Ascending order of the image acquisition time</td>
</tr>
<tr>
<td></td>
<td>UserID - Ascending alphanumeric order of the user ID</td>
</tr>
<tr>
<td>Display</td>
<td>Choose the types of information to display with each image.</td>
</tr>
<tr>
<td></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td><img src="image5.png" alt="Image" /></td>
</tr>
<tr>
<td>Info</td>
<td>Click to show or hide the image label information (Figure 4.20).</td>
</tr>
<tr>
<td></td>
<td>Opens all of the images in the sequence.</td>
</tr>
<tr>
<td></td>
<td>Closes all open images.</td>
</tr>
<tr>
<td></td>
<td>Opens the Edit Sequence dialog box that enables you to add or remove images from the sequence.</td>
</tr>
<tr>
<td></td>
<td>Enables you to export the active image as a graphic file (for example, .png, .dcm).</td>
</tr>
</tbody>
</table>
4.5 Manually Set Up an Image Sequence

This section explains how to set up an image sequence if you do not use the Imaging Wizard. You can save the sequence parameters in the sequence editor to a Living Image Sequence Setup file (.xsq).

For details on image acquisition, see Acquire the Image Sequence, page 34.

NOTE

To create an image sequence, it may be convenient to edit a sequence setup generated by the Imaging Wizard or an existing sequence setup (.xsq). Save the revised sequence setup to a new name.

1. Click **Sequence Setup** in the control panel.

   The sequence editor appears.

2. If necessary, click the **Remove** button and select **All** to clear the sequence editor.
3. Choose a subject and probe.

4. In the control panel, specify the settings for the first luminescence or fluorescence image in the sequence and the photograph. (For details on the imaging parameters in the control panel, see page 231.)

**NOTE**

If you choose the photograph Reuse option in the control panel (Figure 4.23), the IVIS System acquires only one photograph for the entire sequence. If this option is not chosen, the system acquires a photograph for each image in the sequence.

5. Click the Add button.

The acquisition parameters appear in the sequence editor (Figure 4.23).

6. Repeat step 4 to step 5 for each image in the sequence.

7. To set a time delay between each acquisition, enter a time (minutes) in the Delay box in the sequence editor.

8. To save the sequence setup information (.xsq):
   a. In the sequence editor, click the Save button.
b. In the dialog box that appears, select a destination directory, enter a file name, and click **Save**.

![Figure 4.23 Control panel and sequence editor with image settings](image)

*Each row in the sequence editor specifies the acquisition parameters for one image in the sequence.*

### Table 4.5 Sequence Editor

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Imaging Wizard</strong></td>
<td>Starts the Imaging Wizard.</td>
</tr>
<tr>
<td>![Photo icon]</td>
<td>Displays a dialog box that enables you to select and open a sequence setup (.xsq), sequenceinfo.txt, or clickinfo.txt file.</td>
</tr>
<tr>
<td>![Save icon]</td>
<td>Displays a dialog box that enables you to save the information in the sequence editor to a sequence setup file (.xsq).</td>
</tr>
<tr>
<td><strong>Display Photographic Settings</strong></td>
<td>Choose this option to include the photograph exposure time, binning, and F/Stop in the sequence editor. If a subject or probe is not selected here, the default parameters appear in the tool palette.</td>
</tr>
<tr>
<td>![Subject icon]</td>
<td>If a subject and probe are specified (optional), the software uses the information to automatically set parameters in the Surface Topography, DLIT, FLIT, Spectral Unmixing, and Planar Spectral Imaging tools. If a subject or probe is not selected here, the default parameters appear in the tool palette.</td>
</tr>
<tr>
<td><strong>Number of Segments</strong></td>
<td>The sequence specified in the sequence editor is called a <strong>segment</strong>. Choose this option to set the number of segments to acquire and the time delay between segments. This is useful for acquiring data for kinetic analysis.</td>
</tr>
<tr>
<td><strong>Delay</strong></td>
<td>Specifies a time delay between each segment acquisition.</td>
</tr>
<tr>
<td>![Apply to All icon]</td>
<td>Applies the selected cell value to all cells in the same column.</td>
</tr>
<tr>
<td>![Remove icon]</td>
<td>Remove Selected - Deletes the selected row from the sequence editor.</td>
</tr>
<tr>
<td>![Remove All icon]</td>
<td>Remove All - Removes all rows from the sequence editor.</td>
</tr>
<tr>
<td>![Update icon]</td>
<td>Updates the selected row in the sequence editor with the acquisition parameters in the control panel.</td>
</tr>
<tr>
<td>![Insert icon]</td>
<td>Inserts a row above the currently selected row using the information from the control panel.</td>
</tr>
<tr>
<td>![Add icon]</td>
<td>Adds a new row at the end of the sequence setup list.</td>
</tr>
</tbody>
</table>
Editing Image Parameters

You can edit parameters in the sequence editor or in the control panel.

To edit a parameter in the sequence editor:
1. Double-click the cell that you want to edit.
2. Enter a new value in the cell or make a selection from the drop-down list.
   To apply the new value to all of the cells in the same column, click [Apply to All].
3. Click outside the cell to lose focus.

To edit a parameter in the control panel:
1. In the sequence editor, select the row that you want to modify.
2. In the control panel, choose new parameter values and/or imaging mode.
3. Click [Update] in the sequence editor.

Inserting Images in a Sequence

**Method 1:**
1. In the sequence editor, select the row next to where you want to insert the image.
2. Set the imaging mode and parameters in the control panel.
3. To insert the new image above the selected row, click [Insert].

**Method 2:**
Select the row(s) of interest and right-click the sequence editor to view a shortcut menu of edit commands.
Removing Images From a Sequence

Method 1:
1. Select the row(s) that you want to delete.
2. Click and choose Selected from the drop-down list.

Method 2:
Select the row(s) of interest and right-click the sequence editor to view a shortcut menu of edit commands (Figure 4.25).

Table 4.6  Sequence editor, shortcut menu edit commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy row(s)</td>
<td>Copies the selected row(s) to the system clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all rows in the sequence editor.</td>
</tr>
<tr>
<td>Delete row(s)</td>
<td>Deletes the selected row(s) from the sequence editor.</td>
</tr>
<tr>
<td>Replace Row(s)</td>
<td>Replaces the row(s) selected in the sequence editor with the rows in the system clipboard.</td>
</tr>
</tbody>
</table>

*Note:* The Replace function is only available when the number of rows in the system clipboard is the same as the number of rows selected in the sequence editor.

| Paste Row(s) | Adds copied rows to end of the sequence.                                   |
4.6 High Resolution Imaging With the Optical Zoom Lens Attachment

The optional Optical Zoom Lens attachment enables close up and high resolution imaging on the IVIS Lumina, IVIS Lumina XR, and IVIS Kinetic Imaging Systems. When the Zoom lens attachment is installed, only the “Z” field of view setting (2.6 cm) is available for single-image or sequence acquisition.

The imaging system is set to the Z field of view position until the Zoom lens attachment is removed. If the Zoom lens attachment is installed when the Living Image software is closed, the stage will move to the Z position when the system is initialized.

**NOTE**

When installing or removing the Optical Zoom Lens attachment, avoid touching the optical glass.

Installing the Zoom Lens Attachment

1. Choose the Zoom option in the control panel (Figure 4.26).
   
   You are prompted to insert the Zoom Lens attachment.

2. After you install the Zoom Lens attachment in the imaging chamber, click OK in the prompt.
   
   The stage moves to the “Z” field of view position.

**NOTE**

When the Zoom Lens attachment is installed, single images or sequential images can only be acquired at the Z field of view setting. During sequence setup, if you attempt to change away from the Z setting, the sequence table will be cleared. If you attempt to change from another field of view setting to the Z setting, the sequence table is cleared of all previous settings before the camera settings for the Z position are added.
Removing the Zoom Len Attachment

The imaging system is set to the “Z” field of view until the Zoom Lens attachment is removed.

1. Remove the check mark next to Zoom in the control panel (Figure 4.27).
   The stage moves to position C, then you are prompted to remove the lens attachment.
2. After you remove the Zoom Lens attachment, click OK in the prompt.
   Always store the lens wrapped in its protective container.

4.7 Manually Saving Image Data

When you acquire the first image(s) of a session, you are prompted to enable the autosave feature. If autosave is enabled, all images acquired during the session are automatically saved to this folder. You can choose a different folder at any time (select Acquisition → Auto-Save on the menu bar).

This section explains how to manually save data if you do not want to use the autosave feature.

1. Turn off the autosave feature: select Acquisition on the menu bar and remove the check mark next to Auto Save.
2. After you acquire an image or image sequence, click the Save button. Alternatively, select File → Save on the menu bar.
3. In the dialog box that appears, select a directory and click OK.

NOTE
The software automatically includes the user ID, and a date and time stamp with the data.
4.8 Exporting Image Data

You can save the active image view in different file formats (for example, .bmp, .dcm).
1. Open an image or image sequence.
2. Click the Export Graphics button.
3. In the dialog box that appears, select a directory, choose a file type, and enter a file name.
4. Click Save.

NOTE
To export a sequence to DICOM (.dcm) format, select Export → Image/Sequence as DICOM on the menu bar. This creates a directory that contains the .dcm files and a SequenceInfo.txt.
[This page intentionally blank.]
X-ray images can be acquired on the Lumina XR Imaging System. An X-ray image, luminescent or fluorescent image, and a photograph can be acquired at the same time. You can choose two images to create an overlay (Figure 5.1).

### 5.1 Acquire an X-Ray Image

This section explains how to acquire an X-ray image on the Lumina XR Imaging System. For information on including a luminescent or fluorescent image in the acquisition, see Chapter 4, page 21.

1. Start the Living Image software (double-click the icon on the desktop).
2. Initialize the Lumina XR Imaging System and confirm or wait for the CCD temperature to lock. (For more details, see page 17.)
3. In the control panel, put a check mark next to X-Ray (Figure 5.2).

**NOTE**

To enable X-ray acquisition, verify that the X-ray enabling key on the front of the Lumina XR is set to ON, and the orange X-ray enable button has been depressed and is illuminated.
4. Select the **Auto** exposure time (click the ↓ arrow). Alternately, manually set the exposure, binning, and F/Stop. (For more details on the control panel settings, see page 231.)

5. Make a selection from the Energy drop-down list.

   **Table 5.1** Lumina XR energy options

<table>
<thead>
<tr>
<th>Energy Option</th>
<th>Suitable For</th>
<th>X-Ray Energy Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animal</td>
<td>Living subject</td>
<td>35 Kv 100 μA, filtered X-rays</td>
</tr>
<tr>
<td>Specimen</td>
<td>Non-living specimen</td>
<td>28 Kv 100 μA, unfiltered X-rays</td>
</tr>
</tbody>
</table>

   **NOTE**

   A Caliper field service engineer can customize the default X-ray energy levels (Table 5.1) to settings from 5.0 - 40 Kv and from 1-100 μA with or without the low energy X-ray absorbing (Al) filter.

6. Set the **Field of View**: Make a selection from the Field of View drop-down list. For more details on the field of view, see page 233.

   **NOTE**

   To view the subject(s) inside the chamber before image acquisition, take a photographic image (uncheck the luminescent or fluorescent option, choose the Photographic and Auto options, and click **Acquire**).

7. Set the **Focus**:

   - Select **use subject height** from the Focus drop-down list and use the ← arrows or the keyboard arrows to specify a subject height (cm).

   **NOTE**

   The subject height for X-ray images is restricted to 2.8 cm or less. The subject height is critical to ensure proper optical and X-ray overlay. The subject height is used to determine the X-ray resizing coefficient. Select a subject height which suits the region of interest.
• Select **Manual focus** from the Focus drop-down list. (For more details on manual focusing see page 236.)

8. If you want to acquire a photograph, set the **Photograph** image settings:
   a. Put a check mark next to **Photograph**.
   b. Enter an exposure time or choose the Auto option.
   c. Confirm the binning and f/stop defaults or enter new values.

9. If necessary, click **Image Setup** in the control panel to operate in single image mode.

**NOTE**
In single image mode, the **Sequence Setup** button appears in the control panel. Click this button to set up sequence acquisition. (For more details on setting up a sequence, see page 52.)

10. When you are ready to acquire the image, click **Acquire**.
    The Edit Image Labels box appears.

![Image Edit Labels](Figure 5.3)
The information you enter here appears in the image label (Figure 5.6).

11. In the Edit Image Labels box, enter information about the image and click **OK** (Figure 5.3). If you do not want to enter image information, click **Cancel**.
    Image acquisition proceeds. During acquisition, the **Acquire** button becomes a **Stop** button. To cancel the acquisition, click **Stop**. When acquisition is complete, the image window appears (Figure 5.6).

12. If this is the first image of the session, you are prompted to enable the autosave function.
13. To enable autosave, click Yes in the prompt and choose a folder in the dialog box that appears.

If autosave is enabled, all images acquired during the session are automatically saved to a user-selected folder. You can choose a different folder at any time (select Acquisition → Auto-Save on the menu bar).

The acquisition proceeds and the control panel warns you that X-ray radiation is being produced (Figure 5.5). The image window and Tool Palette appear when acquisition is completed (Figure 5.6).

14. If you need to stop the acquisition, click Stop in the control panel.
NOTE

It may be necessary to use the Image Adjust tools to optimize the overlay display. Use the Opacity control to adjust the appearance of the overlay. For more details on adjusting image appearance, see page 89.

Table 5.2 Image window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Select the measurement units for the image display from this drop-down list. The available units depend on the type of image data. For more details on measurement units, see page 253.</td>
</tr>
</tbody>
</table>
| Display| Select the image type (for example, X-ray) that you want to display from this drop-down list. For more details on the different types of image displays, see Table 2.2, page 8.  
**Note:** If the acquisition included more than two imaging modes (for example, luminescent, X-ray, and photograph), additional drop-down lists appear so you can conveniently choose any two images to overlay. |
| Info   | Click to display or hide the image label information. |
|        | Opens a dialog box that enables you to export the active view as a graphic file. |
5.2 Acquire an Image Sequence That Includes X-Ray Images

To acquire an image sequence, first specify the acquisition parameters for each image in the sequence editor (Figure 5.7). The Imaging Wizard provides a convenient way to do this for some imaging applications. The wizard guides you through a series of steps, prompting you for the information that the software needs to set up the sequence in the sequence editor. If you don’t use the wizard, you can set up a sequence manually (for more details, see page 38).

Sequence Setup Using the Imaging Wizard

1. Click **Sequence Setup** in the control panel (Figure 5.7).
   
   The sequence editor appears.

2. If necessary, click the **Remove** button and select **All** to clear the sequence editor.

3. Click the **Imaging Wizard** button.
4. In the wizard, choose bioluminescence or fluorescence imaging (Figure 5.7).

5. In the next wizard screen, choose the type of image sequence that you want to acquire. Step through the rest of the wizard.

6. To include an X-ray image or photograph in the sequence, put a check mark next to the X-ray or Photograph option when you set the imaging parameters in the wizard (Figure 5.8).
Table 5.3 Imaging Wizard

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imaging Subject</td>
<td>Choose the type of subject from this drop-down list.</td>
</tr>
<tr>
<td>Exposure Parameters</td>
<td>The Auto Settings exposure option is the default. To manually set the exposure parameters, select the Manual Settings option. For more details on the exposure parameters, see page 231.</td>
</tr>
<tr>
<td>Field of View</td>
<td>Sets the size of the stage area to be imaged by adjusting the position of the stage and lens. The FOV is the width of the square area (cm) to be imaged. A smaller FOV gives a higher sensitivity measurement, so it is best to set the FOV no larger than necessary to accommodate the subject or area of interest. The FOV also affects the depth of field (range in which the subject is in focus). A smaller FOV results in a narrower depth of field, but gives a higher resolution image. Select the FOV by choosing a setting (A, B, or C) from the drop-down list. For more details on the calibrated FOV positions, see Table A.3, page 235.</td>
</tr>
</tbody>
</table>

Figure 5.8 Imaging Wizard, imaging parameters

To include a photograph or X-ray image in the acquisition, put a check mark next to the Photograph or X-ray option.

NOTE

In the control panel, the Photograph and X-ray Reuse option is selected by default (Figure 5.9). This means the same X-ray image and photograph will be used if camera conditions do not change (for example, binning or F/Stop). If you do not want to reuse the X-ray image or photograph, you can manually edit the image sequence in the sequence editor (for more details, see page 41). Alternately, remove the check mark next to Reuse in the control panel before you begin the Imaging Wizard.
7. Complete the rest of the Imaging Wizard.

When you complete the wizard, the sequence information appears in the sequence editor (Figure 5.10).

![Figure 5.9 Control panel and sequence editor](image)

**Figure 5.9** Control panel and sequence editor

**Reuse photograph & reuse X-ray options**

**Table 5.3 Imaging Wizard**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus</td>
<td>Drop-down list of focusing methods available:</td>
</tr>
<tr>
<td></td>
<td><strong>Use subject height</strong> - Choose this option to set the focal plane at the</td>
</tr>
<tr>
<td></td>
<td>specified subject height.</td>
</tr>
<tr>
<td></td>
<td><strong>Manual</strong> - Choose this option to open the Focus Image window so that</td>
</tr>
<tr>
<td></td>
<td>you can manually adjust the stage position. For more details on manual</td>
</tr>
<tr>
<td></td>
<td>focusing, see 236.</td>
</tr>
<tr>
<td>Options</td>
<td>Time Series Study - Choose this option to specify the number of</td>
</tr>
<tr>
<td></td>
<td>segments to acquire and a time delay between segments. This option is</td>
</tr>
<tr>
<td></td>
<td>useful for acquiring data for kinetic analysis.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The sequence specified in the sequence editor is called a</td>
</tr>
<tr>
<td></td>
<td><em>segment</em>.</td>
</tr>
<tr>
<td>Restart Wizard</td>
<td>Returns the wizard to the starting screen.</td>
</tr>
</tbody>
</table>

![X-ray reuse option is selected by default. One X-ray image is acquired for the sequence.](image)

**Figure 5.10** Control panel and sequence editor
Acquire the Image Sequence

1. Confirm that the IVIS Imaging System is initialized and the CCD temperature is locked. (For more details, see page 17.)

2. When you are ready to acquire the images, click **Acquire Sequence** in the control panel.

   The Edit Image Labels box appears.

3. In the Edit Image Labels box, enter information about the image and click **OK**. If you do not want to enter image information, click **Cancel**.

4. If this is the first image of the session, you are prompted for an autosave location. All images acquired during the session are automatically saved to this folder. You can choose a different folder at any time (select **Acquisition → Auto-Save** on the menu bar).

   To select a folder for autosaved data, click **Yes** in the prompt and choose a folder in the dialog box that appears.

5. To stop acquisition, click the **Stop** in the control panel. To pause acquisition, click **Pause** in the control panel.
**Figure 5.13** Image sequence and Tool Palette
Double-click an image in the sequence to open it in a separate image window.

**Table 5.4** Image window: Sequence view

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Select the measurement units for the image display from this drop-down list. The available units depend on the type of image data. For more details on measurement units, see page 253.</td>
</tr>
<tr>
<td>Use Saved Colors</td>
<td>Choose this option to display the image data using the color table that was specified in the Preferences at the time of acquisition. If this option is not selected, image data are displayed using the color table currently specified in the Preferences.</td>
</tr>
</tbody>
</table>
Table 5.4  Image window: Sequence view (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Layout - Choose a display option for the images in a sequence. For example, here is Film Strip mode:</td>
</tr>
<tr>
<td></td>
<td>Sort by - Options for ordering images in the sequence window:</td>
</tr>
<tr>
<td></td>
<td>Default - Order in which the images are stored in the folder</td>
</tr>
<tr>
<td></td>
<td>TimeStamp - Ascending order of the image acquisition time</td>
</tr>
<tr>
<td></td>
<td>UserID - Ascending alphanumeric order of the user ID</td>
</tr>
<tr>
<td>Display</td>
<td>Choose the types of information to display with each image.</td>
</tr>
<tr>
<td></td>
<td>In this example, exposure time and binning factor are displayed on each image</td>
</tr>
<tr>
<td>Info</td>
<td>Click to show or hide the image label information (Figure 5.13).</td>
</tr>
<tr>
<td></td>
<td>Opens all of the images in the sequence.</td>
</tr>
<tr>
<td></td>
<td>Closes all open images.</td>
</tr>
<tr>
<td></td>
<td>Opens the Edit Sequence dialog box that enables you to add or remove images from the sequence.</td>
</tr>
<tr>
<td></td>
<td>Enables you to export the active image as a graphic file (for example, .png, .dcm).</td>
</tr>
</tbody>
</table>
5.3 High Resolution Imaging With the Optical Zoom Lens Attachment

The optional Optical Zoom Lens attachment enables close up and high resolution imaging on the IVIS Lumina, IVIS Lumina XR, and IVIS Kinetic Imaging Systems. When the Zoom lens attachment is installed, only the “Z” field of view setting (2.6 cm) is available for single-image or sequence acquisition.

The imaging system is set to the Z field of view position until the Zoom lens attachment is removed. If the Zoom lens attachment is installed when the Living Image software is closed, the stage will move to the Z position when the system is initialized.

NOTE
When installing or removing the Optical Zoom Lens attachment, avoid touching the optical glass.

Installing the Zoom Lens Attachment

1. Choose the Zoom option in the control panel (Figure 5.14).
   You are prompted to insert the Zoom Lens attachment.
2. After you install the Zoom Lens attachment in the imaging chamber, click **OK** in the prompt.

The stage moves to the “Z” field of view position.

**NOTE**

When the Zoom Lens attachment is installed, single images or sequential images can only be acquired at the Z field of view setting. During sequence setup, if you attempt to change away from the Z setting, the sequence table will be cleared. If you attempt to change from another field of view setting to the Z setting, the sequence table is cleared of all previous settings before the camera settings for the Z position are added.

**Removing the Zoom Len Attachment**

The imaging system is set to the “Z” field of view until the Zoom Lens attachment is removed.

1. Remove the check mark next to Zoom in the control panel (Figure 5.15).

   The stage moves to position C, then you are prompted to remove the lens attachment.

2. After you remove the Zoom Lens attachment, click **OK** in the prompt.

   Always store the lens wrapped in its protective container.
5.4 Measuring Relative Density

As density increases, tissue absorbs more X-ray energy and appears darker in a raw Lumina XR X-ray image (Figure 5.16). To enable measurements of this X-ray absorption, the raw X-ray image is mathematically transformed, resulting in an image where denser material appears lighter and intensity measurements are proportional to the tissue density (Figure 5.16).

The Living Image software displays transformed X-ray images by default. To display raw X-ray images, remove the check mark next to X-Ray Absorption in the Corrections / Filtering tools (Figure 5.17).
When the X-ray data has been corrected for absorption, you can evaluate relative bone density by comparing the signal intensities of measurement ROIs. The ROI intensity increases with increasing tissue density.

**NOTE**

When acquiring X-ray images for bone density evaluation, it is best if the subject does not fill the entire field of view since the X-ray absorption measurements are referenced to the exposed scintillator plate.

**To determine relative bone density:**

1. Load an X-ray image. (For more details on opening image data, see page 81.)
2. Confirm that the X-ray absorption correction (default) is applied (Figure 5.17).
3. In the ROI tools, select Measurement ROI from the Type drop-down list (Figure 5.18).

![Figure 5.17 Corrections/Filtering tools](image1)

![Figure 5.18 X-ray image with absorption correction](image2)
4. To select the ROI shape:
   a. Click the **Circle** or **Square** button.
   b. On the drop-down list that appears, select the number of ROIs that you want to add to the image.
      — The ROI(s) and intensity label(s) appear on the image. If you are working with a sequence, open an image to show the ROI intensity.

5. Adjust the ROI position:
   a. Place the mouse pointer over the ROI. When the pointer becomes a , click the ROI.
   b. Drag the ROI.

6. Adjust the ROI dimensions:
   a. Place the mouse pointer over the ROI. When the pointer becomes a , click the ROI.
   b. Place the mouse pointer over an ROI handle so that it becomes a . Drag the handle to resize the ROI.

   **NOTE**
   You can also change the ROI position or size using the adjustment controls in the ROI Properties box (see “Moving an ROI,” page 129 and “Editing ROI Dimensions,” page 130).

7. Click the **Measure** button.

   The ROI intensity measurements appear in the X-ray image and the ROI measurements table appears. For more details on the table, see “Managing the ROI Measurements Table,” page 136. For information on how to save ROIs, see page 133.

---

![Figure 5.19 Measurement ROIs on X-ray image](image-url)
[This page intentionally blank.]
6 Kinetic Imaging

The IVIS Kinetic Imaging System is ready to acquire kinetic data after the system is initialized and the CCD camera reaches operating (demand) temperature (locked).

6.1 Kinetic Acquisition

1. Start the Living Image software (double-click the icon on the desktop).
2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. For more details, see page 17.
3. If you are acquiring ventral images (requires the subject be placed in the Ventral Imaging Chamber), choose the VIC option in the control panel.
4. When you are ready to begin imaging, click Kinetics in the control panel.

The Kinetic Acquisition window appears.
5. Select the type of data to acquire and set the acquisition parameters. (For more details on the acquisition parameters, see Table 6.1, page 67.)

6. Click the **Record** button to start acquisition. (After acquisition begins, the button changes to a **Stop** button.) To stop acquisition, click the **Stop** button.

The maximum vs. time graph appears when kinetic acquisition begins and plots the maximum intensity signal in each frame. The graph provides a convenient way to look for signal trends or select particular frames for viewing.
• Click a point in the graph to view the corresponding image (frame)
• Put the mouse pointer over the graph to view a tooltip that shows the frame number and time
• Right-click the graph to view the available shortcut menu of graph display options

Figure 6.3 Maximum vs. time graph

Table 6.1 Kinetic acquisition settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overlay</td>
<td>Choose this option to acquire photographs.</td>
</tr>
</tbody>
</table>

Select the type of data to acquire (luminescent or fluorescent) from this drop-down list. Choose the Overlay option to acquire photographs.
**Table 6.1** Kinetic acquisition settings (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Range</td>
<td>14 bit - If this option is chosen, the signal intensities range from 0 to 16383 counts per pixel.</td>
</tr>
<tr>
<td></td>
<td>16 bit - If this option is chosen, the signal intensities range from 0 to 65535 counts per pixel.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The 14 bit dynamic range enables faster imaging.</td>
</tr>
<tr>
<td>Exposure Time (msecs)</td>
<td>The exposure time for the luminescent image. Shorter exposure times enable faster frame rates; longer exposure times provide greater sensitivity. The 14 bit dynamic range enables faster imaging by attaining a higher frame rate at the cost of a smaller dynamic range.</td>
</tr>
<tr>
<td>Binning</td>
<td>Controls the pixel size on the CCD camera. Increasing the binning increases the pixel size, sensitivity, and frame rate, but reduces spatial resolution. Using larger binning for a luminescent or fluorescent image can significantly improve the signal-to-noise ratio. The loss of spatial resolution at high binning is often acceptable for <em>in vivo</em> images where light emission is diffuse. For more details on binning, see Appendix C, page 248. Recommended binning: 1-4 for imaging of cells or tissue sections, 4-8 for <em>in vivo</em> imaging of subjects, and 8-16 for <em>in vivo</em> imaging of subjects with very dim sources.</td>
</tr>
<tr>
<td>F/Stop</td>
<td>Sets the size of the camera lens aperture. The aperture size controls the amount of light detected and the depth of field. A larger f/stop number corresponds to a smaller aperture size and results in lower sensitivity because less light is collected for the image. However, a smaller aperture usually results in better image sharpness and depth of field. In kinetic mode, the photographic and luminescent (or fluorescent) image are acquired at the same F/Stop. For more details on f/stop, see Appendix C, page 247.</td>
</tr>
<tr>
<td>EM Gain</td>
<td>Multiplies the signal in real time. This option is useful for boosting low signals above the background noise. For kinetic imaging, the EM gain may be set to 50, 100, or 250. For conventional 16-bit still image acquisition, EM gain may be set to Off, 50, 100, or 250.</td>
</tr>
<tr>
<td>Excitation Filter</td>
<td>A drop-down list of fluorescence excitation filters. For fluorescent imaging, choose the appropriate filter for your application (GFP, DsRed, Cy5.5, or ICG). For luminescent imaging, <strong>Block</strong> is selected by default.</td>
</tr>
<tr>
<td>Emission Filter</td>
<td>A drop-down list of fluorescence emission filters. For fluorescent imaging, choose the appropriate filter for your application (GFP, DsRed, Cy5.5, or ICG). For luminescent imaging, <strong>Open</strong> is selected by default.</td>
</tr>
<tr>
<td>FL Lamp Level</td>
<td>Sets the illumination intensity level of the excitation lamp used in fluorescent imaging (Off, Low, High, and Inspect). Low - This setting is approximately 18% of the High setting. Inspect - Turns on the illumination lamp so that you can manually inspect the excitation lamp. <strong>Note:</strong> Make sure that the filters of interest are selected in the filter drop-down lists before you select Inspect. The Inspect operation automatically positions the selected filters in the system before turning on the lamp. Subsequent changes to the filter popup menus will have no effect until another Inspect operation is performed.</td>
</tr>
<tr>
<td>Photograph Light Level</td>
<td>Controls the brightness of the lights at the top of the imaging chamber that are used to acquire photographic images.</td>
</tr>
<tr>
<td>Accumulate</td>
<td>Select this option to view the cumulative intensity signal in real time. When this option is chosen, the software computes and visualizes the cumulative signal in each frame.</td>
</tr>
</tbody>
</table>
**Table 6.1** Kinetic acquisition settings (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Color Scale   | Auto - If this option is chosen, the software chooses the color scale minimum and maximum. **Note:** Do not choose this option if the Accumulate option is selected.  
  Minimum - A user-specified threshold for the color scale minimum that is applied to the data if the Auto option is not selected. Intensity signals less than the minimum are not displayed.  
  Maximum - A user-specified threshold for the color scale maximum that is applied to the data if the Auto option is not selected. |
| File Size     | Displays the file size of the kinetic stream (.dcm) being acquired. The file size display is only available in the Kinetic Acquisition panel. |
| Save          | Click to select an option for saving the data:  
  Save Current Image - Saves the currently selected frame (single image, photograph, and read bias).  
  Save Accumulated Image - Saves the accumulated signal for the selected frames (.tiff).  
  **Save Kinetic Data** - Saves all selected photographic, luminescent or fluorescent images (frames) and the read bias image (.dcm). The signal is not accumulated. |
| Done          | Closes the Kinetic Acquisition window                                                                                                       |
Accumulated Signal

The Accumulate option enables you to view increasing signals in real time. If you plan to accumulate signals, it is recommended that you perform a test acquisition to optimize settings so that the photographic image, luminescent, or fluorescent signal is not saturated.

To perform a test acquisition:
1. Confirm that the Accumulate option is selected. Do not select the Auto color scale option.
2. Start the acquisition (click the Record button).
3. If the photographic image is saturated, stop the acquisition (click the Stop button) and reduce the photograph light level.

CAUTION

Extended acquisition of saturated images can shorten the life of the EMCCD and should be avoided.

4. Restart the acquisition. If necessary, repeat step 3 and step 4.

6.2 High Resolution Imaging With the Optical Zoom Lens Attachment

The optional Optical Zoom Lens attachment enables close up and high resolution imaging on the IVIS Lumina, IVIS Lumina XR, and IVIS Kinetic Imaging Systems. When the Zoom lens attachment is installed, only the “Z” field of view setting (2.6 cm) is available for single-image or sequence acquisition.

The imaging system is set to the Z field of view position until the Zoom lens attachment is removed. If the Zoom lens attachment is installed when the Living Image software is closed, the stage will move to the Z position when the system is initialized.

NOTE

When installing or removing the Optical Zoom Lens attachment, avoid touching the optical glass.

Installing the Zoom Lens Attachment

1. Choose the Zoom option in the control panel (Figure 6.4).
   You are prompted to insert the Zoom Lens attachment.
2. After you install the Zoom Lens attachment in the imaging chamber, click **OK** in the prompt. The stage moves to the “Z” field of view position.

**NOTE**

When the Zoom Lens attachment is installed, single images or sequential images can only be acquired at the Z field of view setting. During sequence setup, if you attempt to change away from the Z setting, the sequence table will be cleared. If you attempt to change from another field of view setting to the Z setting, the sequence table is cleared of all previous settings before the camera settings for the Z position are added.
Removing the Zoom Len Attachment

The imaging system is set to the “Z” field of view until the Zoom Lens attachment is removed.

1. Remove the check mark next to Zoom in the control panel (Figure 6.5).
   The stage moves to position C, then you are prompted to remove the lens attachment.
2. After you remove the Zoom Lens attachment, click OK in the prompt.
   Always store the lens wrapped in its protective container.

![Control panel, remove the check mark next to Zoom](image)

Figure 6.5 Control panel, remove the check mark next to Zoom

6.3 Viewing & Editing Data in the Kinetic Acquisition Window

After stopping acquisition, you can view the data in the Kinetic Acquisition window.

1. To start the playback, click the Play button. (After playback starts, the button changes to a Stop button.)
2. To stop the playback, click the Stop button.
3. To view a particular frame, do either of the following:
   - Move the top frame slider or enter a frame number in the box next to the frame slider
   - Click a location in the Maximum vs. Time graph
4. To select a particular range of kinetic data, move the start and end frames selection handles. Alternately, enter a frame number in the box next to each slider. Only the selected frames will be played back or saved.

NOTE

Kinetic data (.dcm) can also be edited in the Image window. For more details, see page 101.
Viewing Options

After acquisition has been stopped, right-click the image to access a shortcut menu of viewing options.

Table 6.2 Kinetic view options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Area</td>
<td>To magnify a particular area, draw a box around the area that you want to zoom in on, right-click the area and select Zoom Area on the shortcut menu.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Incrementally magnifies the view.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Incrementally reduces the magnification.</td>
</tr>
<tr>
<td>Reset Zoom</td>
<td>Returns the image to the default display magnification.</td>
</tr>
<tr>
<td>Pan View</td>
<td>Enables you to view a different area of a magnified image. To view another area of the image, choose this option, then click and hold the pointer while you move the mouse over the image.</td>
</tr>
<tr>
<td>Crop Area</td>
<td>To crop the image, draw a rectangle over the area of interest in the image, then right-click the area in the box and select Crop Area on the shortcut menu.</td>
</tr>
<tr>
<td>Draw Grid</td>
<td>Displays a grid over the frame.</td>
</tr>
<tr>
<td>Draw Scale</td>
<td>Displays a scale along the x- and y-axis of the frame.</td>
</tr>
<tr>
<td>Insert Tag</td>
<td>Displays a tag with x,y pixel information at a user-selected location of the image. To insert a tag, right-click a location in the image and choose Insert Tag on the shortcut menu.</td>
</tr>
<tr>
<td>Remove Tag</td>
<td>Removes a user-selected tag from the image.</td>
</tr>
</tbody>
</table>
6.4 Saving Kinetic Data

The IVIS Kinetic instrument enables you to acquire a real-time data stream which can generate very large files. The file size limit for DICOM data is 2GB. Kinetic data acquisition automatically stops when this file size limit is reached. Table 6.3 shows how binning conditions affect the total number of frames that can be collected in overlay or luminescent/fluorescent only mode.

Table 6.3 Frames collected per 1 GB DICOM file

<table>
<thead>
<tr>
<th>Binning Level</th>
<th>Frame Size</th>
<th>Overlay Mode</th>
<th>Luminescent or Fluorescent Only</th>
<th>DICOM File Size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Total Frames Collected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bin1</td>
<td>2 MB</td>
<td>250</td>
<td>500</td>
<td>1 GB</td>
</tr>
<tr>
<td>Bin2</td>
<td>512 KB</td>
<td>975</td>
<td>1950</td>
<td></td>
</tr>
<tr>
<td>Bin 4</td>
<td>128 KB</td>
<td>3900</td>
<td>7800</td>
<td></td>
</tr>
<tr>
<td>Bin 8</td>
<td>32 KB</td>
<td>15600</td>
<td>31250</td>
<td></td>
</tr>
<tr>
<td>Bin 16</td>
<td>8 KB</td>
<td>62500</td>
<td>125000</td>
<td></td>
</tr>
</tbody>
</table>

To save data:
1. In the Kinetic Acquisition window, click the Save button and select a save option.

   **Save Option** | **Description**
   ---------------|---------------------
   **Save ➔ Current Image** | Saves the currently displayed frame.
   **Save ➔ Accumulated Image** | Saves the accumulated signal for the selected frames (.tiff).
   **Note:** It is not necessary to select the Accumulate option to save an accumulated image.
   **Save ➔ Kinetic Data** | Saves the data (photographic frames, all luminescent or fluorescent frames, and read bias) in DICOM format (.dcm).

2. In the Edit Image Labels box that appears, enter information for the image label and click OK. If you do not want to enter label information, click Cancel.
NOTE

You can edit and analyze kinetic data in the Image window.

6.5 Playing Kinetic Data

In the image window, you can:

- Play kinetic data
- Select and view a particular image
- Select a range of images and extract as a separate kinetic data set
Current image number (top slider position). To select a particular image, enter a new number or move the top slider.

Start frame (image) in the selected data range (left slider position)

Use the bottom sliders to select a range of data for viewing or export

End frame (image) in the selected data range (right slider position)

Figure 6.8  Image window, kinetic data

Put the mouse arrow over a bottom slider to view a tooltip that shows the number of selected images (frames)

Figure 6.9  Image window, selecting kinetic data for export
Table 6.4  Image window, kinetic data

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Starts playing kinetic data.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops playing kinetic data.</td>
</tr>
<tr>
<td>Edit and Save options</td>
<td>Shows or hides the bottom sliders that enable you to select a range of data and the Extract button that provides save options for the user-selected image or data.</td>
</tr>
<tr>
<td>Accumulate</td>
<td>If this option is chosen, the software computes and displays the cumulative intensity signal. Choose this option and playback the kinetic data to visualize accumulation as it happens.</td>
</tr>
<tr>
<td>Extract</td>
<td>Click to select a save option for the current image or selected data.</td>
</tr>
<tr>
<td>Extract Current Image</td>
<td>Displays the current image in a new image window. The software prompts you to save the image when you close the image window.</td>
</tr>
<tr>
<td>Extract Accumulated Image</td>
<td>The software computes the cumulative signal for each image (sum of the signal in all images up to and including the current image), then displays the cumulative signal of the current image in a new image window. The software prompts you to save the image when you close the image window.</td>
</tr>
<tr>
<td>Extract Kinetic Data</td>
<td>Choose this option if you want to save a particular range of images. Opens the Browse For Folder dialog box that enables you to select where to save the selected data.</td>
</tr>
<tr>
<td>Save As a Movie</td>
<td>Saves the kinetic data set as a movie (.mp4, .mov, .avi)</td>
</tr>
</tbody>
</table>

**Viewing Kinetic Data**

1. Open the kinetic data.
2. To start playing the kinetic data, click the **Play** button. If you want to start the playback at a particular image, first move the top slider to the starting image, then click the **Play** button.
3. To stop playing data, click the **Stop** button.
4. To view the cumulative signal during playback, choose the Accumulate option. If the accumulated image maximum exceeds the current color scale range, use the image adjust tools to adjust the color scale.
Kinetic Plot

The Kinetic Plot is a graph of the maximum signal versus time. To view the Kinetic Plot, click the button in the Image Information tools.

![Figure 6.10 Kinetic Plot](image)

Exporting Kinetic Data

You can select a range of images for export to DICOM format (includes photographs, intensity signal, and read bias) or to a movie.

1. In the image window, click the button (Figure 6.9).
2. If you want to select a particular range of data for export, use the frame range selection to select the data. Use the left slider to select the start image and the right slider to select the end image in the data range of interest.

   The top slider automatically moves to denote the location of the current image with respect to the selected data range.
3. To export the selected data to a movie:
   a. Click **Extract** and choose **Save as a Movie**.
   b. In the dialog box that appears, select a folder, enter a name for the movie, and choose the file format (for example, .mpg4).
Exporting an Image from a Kinetic Data Set

1. To select an image, move the frame slider or enter a frame number in the spin box.

2. Click **Extract** and choose **Extract Current Image**.
   
   A new image window appears and displays the selected image.

3. To save a snapshot of the current image, click the Export Graphics button in the image window. In the dialog box that appears, select a destination folder, enter a file name, select a file type, and click **Save**.

![Image window, selecting an image for export](image-url)
[This page intentionally blank.]
7 Working With Data

7.1 Opening Data

You can open (load) data from the:

- Living Image browser (see below)
- Toolbar or menu bar (page 84)

Multiple data sets can be open at the same time.

NOTE
To open a recently viewed file, select File → Recent Files on the menu bar.

Loading Data From the Living Image Browser

The Living Image Browser provides a convenient way to browse and preview data, view information about the data, and load the data.

To start the browser:
1. Click the Browse button 🎨. Alternately, select File → Browse on the menu bar.
2. In the dialog box that appears, select the folder of interest and click OK.

The Living Image Browser appears (Figure 7.1).
The next time you start the Living Image software and open the Browse For Folder box, the software automatically returns to the last folder visited.

The Living Image browser displays the selected data along with the user ID, label information, and camera configuration information.

- image
- image sequence
- kinetic data or image exported as DICOM file

3. To expand a sequence, click the + sign next to it.
4. To view data properties, right-click an item and select Properties on the shortcut menu.
5. To open data, do one of the following:
   - Double-click the data row
   - Right-click the data name and select Load on the shortcut menu
   - Select the data row and click Load.
   - Double-click the thumbnail

The image(s) and Tool Palette are displayed. Open data is highlighted in green in the browser (Figure 7.2).
Figure 7.2  Image sequence opened
Multiple data sets can be open at the same time.

Table 7.1  Living Image browser

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Browse View</td>
<td>Closes the browser table.</td>
</tr>
<tr>
<td>Close Preview</td>
<td>Closes the image preview box.</td>
</tr>
<tr>
<td>Label Set</td>
<td>A drop-down list of the available label sets which specify image information (column headers) that is displayed in the Living Image browser.</td>
</tr>
<tr>
<td>Add to List</td>
<td>If you choose this option, the data that you select in the Browse for Folder box is added to the Living Image browser. If this option is not chosen, the data that you select in the Browse for Folder box replaces the contents of the Living Image browser, except for loaded data.</td>
</tr>
<tr>
<td>Browse</td>
<td>Opens the Browse For Folder box.</td>
</tr>
<tr>
<td>View</td>
<td>The name of the Living Image browser configuration (the column headers and their order in the browser).</td>
</tr>
<tr>
<td>Configure</td>
<td>Opens a dialog box that enables you create and save custom Living Image browser configurations.</td>
</tr>
</tbody>
</table>

**Note:** To reorder a column in the browser, click the column header, then press the mouse key while you drag the header left or right. Release the mouse key to set the new position.
Opening Data from the Menu or Toolbar

Table 7.1 Living Image browser (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load as Group</td>
<td>Enables you to select particular images that you want to view as a sequence. The images may be acquired during different sessions. To select adjacent images in the browser, press and hold the Shift key while you click the first and last file in the selection. To select non-adjacent images in the browser: PC users: Press and hold the Ctrl key while you click the images in the browser Macintosh users: Press and hold the Cmd key (apple key) while you click the images in the browser. Note: The Load as Group option is only available when two or more images (non-kinetic) are selected in the browser.</td>
</tr>
<tr>
<td>Load</td>
<td>Opens the selected image or image sequence.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes a user-selected image sequence(s) from the browser.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Living Image browser.</td>
</tr>
</tbody>
</table>
7.2 About the Image Window & Tool Palette

An image, image sequence, or kinetic data set is displayed in an image window. Multiple image windows can be open at the same time.

Figure 7.4 Image windows, sequence view and single image
The options available in the image window depend on the type of active image data.

Table 7.2 Image window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Select the measurement units for the image display from this drop-down list. The available units depend on the type of image data. For more details on measurement units, see page 253.</td>
</tr>
<tr>
<td>Info</td>
<td>Click to display or hide the image label. The image label includes information you enter in the Edit Image Labels dialog box (see page 22) and other information automatically recorded by the software. Opens a dialog box that enables you to export the active view as a graphic file. Takes a “snapshot” that is displayed with the data in the Living Image Browser. For more details on the browser, see page 81.</td>
</tr>
</tbody>
</table>
Table 7.2  Image window (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display (single image)</td>
<td>A list of image types available for display, for example, overlay. For more details on the different types of image displays, see Table 2.2, page 8.</td>
</tr>
<tr>
<td>Note:</td>
<td>If the acquisition included more than two imaging modes (for example, luminescent, x-ray, and photograph), additional drop-down lists appear so you can choose any two images to overlay.</td>
</tr>
</tbody>
</table>

![Display: Overlay][1] Luminescent on Photograph

To change the foreground or background, click the button or select from the drop-down list.

<table>
<thead>
<tr>
<th>Color Scale (single image)</th>
<th>Provides a reference for the pixel intensities in a luminescent or fluorescent image. Pixels less than the color scale minimum do not appear in the image. Pixels greater than the color scale maximum are displayed in the maximum color</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Options (image sequence)</th>
<th>Layout - Choose a display option for the images in a sequence (Default, Dynamic, or Film Strip). For example, here is Film Strip mode:</th>
</tr>
</thead>
</table>

![Layout - Film Strip](image)

Sort by - Options for ordering images in the sequence window:
- Default - Order in which the images are stored in the folder
- TimeStamp - Ascending order of the image acquisition time
- UserID - Ascending alphanumeric order of the user ID

Display - Choose the types of information to display with each image.

![In this example, exposure time and binning factor are displayed on each image](image)

| ![Opens all of the images in a sequence.](image) |
| ![Closes all open images of a sequence.](image) |
The Tool Palette appears when you open an image or sequence.

Table 7.2  Image window (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Opens the Edit Sequence dialog box that enables you to add or remove images from a sequence.</td>
</tr>
</tbody>
</table>

7.3 Viewing Image Information

At acquisition, the software captures image information that includes all of the text information that is associated with an image, for example, camera parameters and any image label information entered at acquisition (Figure 7.6).

Figure 7.5  Tool palette
The options available in the Tool Palette depend on the type of active image data. For an overview of the tools, see Figure 2.4 on page 11 and Figure 2.5 on page 12.

Figure 7.6  Image window displaying image information
Another way to view information about images is available in the View menu.

1. Open an image or sequence.
2. Select **View → Image Information** on the menu bar.
   The Image Information window appears.
3. Choose an image by making a selection from the Sequences drop-down list and the Images drop-down list (Figure 7.7).

   ![Drop-down list of open sequences. Choose **Individual Images** from the list to show the open single images in the Images drop-down list.](image1)

   ![Drop-down list of images in the selected sequence. Or a list of single images if “Individual Images” is selected in the Sequences drop-down list.](image2)

   ![Choose the **Show All Sections** option to display all categories of image information.](image3)

   **Figure 7.7** Viewing image information

4. To view information of interest, select a category in the upper box to show the associated information in the lower box. For example, select luminescent image in the upper box to show the luminescent image acquisition parameters.

**Editing the Image Label**

You can edit the image label information after acquisition.

1. Open an image.
2. Select **Edit → Image Labels** on the menu bar.
3. In the Edit Image Labels box that appears (Figure 7.8), edit the information.
4. When you are finished, click OK. The image information is updated.

5. Save the image to save the updated image information (select File → Save or File → Save As on the menu bar).

### 7.4 Adjusting Image Appearance

Use the image adjust tools to adjust the appearance of an image (Figure 7.9).

**NOTE**

Not all tools are available for all image display modes.

---

Figure 7.8 Edit Image Labels

Figure 7.9 Tool palette, Image Adjust tools
Table 7.3 Image Adjust tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Click this button to incrementally zoom out on the image (reduces the image dimensions in the image window). Note: The zoom tools are also available in the shortcut menu when you right-click the image (Ctrl-click for Macintosh users).</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Click this button to incrementally zoom in on the image (incrementally magnifies the image in the image window).</td>
</tr>
<tr>
<td><img src="image" alt="Magnify Area" /></td>
<td>Click this button to magnify the area inside a rectangle that you draw using a click-and-drag operation. (Sets the dimensions of the magnified area equal to image window dimensions.)</td>
</tr>
<tr>
<td><img src="image" alt="Return Default" /></td>
<td>Click this button to return the image to the default display magnification.</td>
</tr>
<tr>
<td><img src="image" alt="Pan" /></td>
<td>Click this button to move a magnified image (pan) in the image window. For more details, see page 91.</td>
</tr>
<tr>
<td><img src="image" alt="Min/Max Info" /></td>
<td>Click this button to hide or display the image min/max information in the image window.</td>
</tr>
<tr>
<td><img src="image" alt="Color Scale" /></td>
<td>Click this button to hide or display the color scale in the image window.</td>
</tr>
<tr>
<td><img src="image" alt="Color Scale Info" /></td>
<td>Click this button to hide or display the color scale min/max information in the image window.</td>
</tr>
</tbody>
</table>
| **Photo Adjustment** | Brightness - Click and move the slider left or right to adjust the brightness of an image displayed in overlay or photograph mode. Alternatively, enter a brightness value.  
Contrast - Click and move the slider left or right to adjust the gamma of an image displayed in overlay mode. Alternatively, enter a gamma value. (Gamma is related to image contrast.)  
Opacity - Click and move the slider left or right to adjust the opacity of the pseudocolor luminescent data of an image displayed in overlay mode. Alternatively, enter an opacity value. |
| **Color Scale** | Min - The minimum pixel intensity associated with the color scale for an image. Pixels less than the minimum value are not displayed.  
Max - The maximum pixel intensity associated with the color scale for an image. Pixels greater than the maximum value are displayed in the maximum color. |
| **Limits** | Auto - If this option is chosen, the software sets the Min and Max values to optimize image display and suppress background noise. The Min and Max settings can be manually adjusted to further optimize the image display for your needs.  
Full - Choose this option to set the Max and Min values to the maximum and minimum data values in the image.  
Manual - Choose this option to enter Max and Min values for the image display.  
Individual - Applies a separate color table to each image in a sequence. **Note:** This option is only available when an image sequence is active. |
| **Color Table** | Reverse - Choose this option to reverse the selected color table.  
Logarithmic Scale - Choose this option to apply a log scale to the relationship between numerical data and the color range in the color table. A log scale increases the range of meaningful numerical data that can be displayed. |
Magnifying or Panning in the Image Window

To incrementally zoom in or out on an image:

Click the or button. Alternately, right-click the image and select **Zoom In** or **Zoom Out** on the shortcut menu.

To magnify a selected area in an image:

1. Click the button. Alternately, right-click the image and select **Area Zoom** on the shortcut menu.
2. When the pointer becomes a +, draw a rectangle around the area that you want to magnify.
   The selected area is magnified when you release the mouse button.

To reset the magnification (remove magnification):

Click the button. Alternately, right-click the image and select **Reset Zoom** on the shortcut menu.

To pan the image window:

**NOTE**

Panning helps you view different areas of a magnified image. If the image has not been magnified, you cannot pan the image.

1. Click the button.
2. When the pointer becomes a , click and hold the pointer while you move the mouse.

### 7.5 Correcting Image Data

Use the Corrections/Filtering tools to subtract background or apply corrections to the image data. (For more details on sources of background, see Appendix E, page 257.) You can also apply smoothing and soft binning to the image data. (For more information on binning and smoothing, see Appendix C, page 247.)

**Figure 7.10** Tool palette, Corrections/Filtering tools

Read Bias Subtraction and Flat Field Correction are default mandatory corrections in photons mode. In counts mode, these corrections can be cleared.
Table 7.4 Tool palette, Corrections/Filtering tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Bias Subtraction/Dark Charge Subtraction</td>
<td>Select this check box to subtract dark background from the image data. If a dark charge image is available for the imaging conditions, the dark background image, including read bias noise, will be subtracted. Otherwise, only read bias noise will be subtracted. For more details on background, see Appendix E, page 257. <strong>Note:</strong> In Radiance (Photons) mode, dark background or read bias subtraction is a mandatory default. In counts mode, the check box can be cleared.</td>
</tr>
<tr>
<td>Flat Field Correction</td>
<td>Select this check box to apply a lens correction factor to the image data. For more details on flat field correction, see Appendix D, page 256. <strong>Note:</strong> In photons mode, flat field correction is a mandatory default. In counts mode, the check box can be cleared.</td>
</tr>
<tr>
<td>Cosmic Correction</td>
<td>Select this check box to correct image data for cosmic rays or other ionizing radiation that interact with the CCD. For more details on cosmic correction, see Appendix D, page 256.</td>
</tr>
<tr>
<td>Adaptive FL Background Subtraction</td>
<td>Opens the Photo Mask Setup box that enables you to set the photo mask for adaptive fluorescent background subtraction. For more details on adaptive fluorescent background subtraction, see Appendix F, page 274.</td>
</tr>
<tr>
<td>Binning</td>
<td>Specifies the number of pixels in the image data that are grouped together to form a larger pixel (called soft binning). Binning changes the pixel size in the image (Figure 7.11). For more details on binning, see Appendix C, page 248.</td>
</tr>
<tr>
<td>Smoothing</td>
<td>Computes the average signal of the specified number of pixels and replaces the original signal with the average signal (Figure 7.11). Smoothing removes signal noise without changing pixel size.</td>
</tr>
</tbody>
</table>

![Figure 7.11 Example of binning and smoothing image data](image_url)

Binning at acquisition = 8, no smoothing  Binning = 2, smoothing = 5x5
7.6 Viewing Intensity Data & Making Measurements

The Image Information tools enable you to view intensity data and measure distance on an image. You can view pixel data in different formats:

<table>
<thead>
<tr>
<th>Image Information</th>
<th>Description</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>x,y coordinates and associated intensity</td>
<td>The x,y pixel coordinates of the mouse pointer location in the image and the intensity (counts or photons) at that location.</td>
<td>94</td>
</tr>
<tr>
<td>Histogram</td>
<td>Histogram of pixel intensities in an image.</td>
<td>95</td>
</tr>
<tr>
<td>Line profile</td>
<td>Plots a line graph of intensity data at each pixel along a user-specified horizontal or vertical line in the image</td>
<td>96</td>
</tr>
</tbody>
</table>

![Figure 7.12 Tool palette, Image Information tools](image)

**Figure 7.12** Tool palette, Image Information tools

**Table 7.5 Tool palette, Image Information tools**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Histogram icon" /></td>
<td>Click this button to display a histogram of pixel intensity. For more details, see page 95.</td>
</tr>
<tr>
<td><img src="image" alt="Line profile icon" /></td>
<td>Click this button to display a line profile. For more details, see page 96.</td>
</tr>
<tr>
<td><img src="image" alt="Distance measurement cursor icon" /></td>
<td>Click this button to display the distance measurement cursor in the image window. For more details, see page 98.</td>
</tr>
<tr>
<td><img src="image" alt="Rectangle tool icon" /></td>
<td>Click this button to draw and measure a rectangle on an image. For more details, see page 99.</td>
</tr>
<tr>
<td><img src="image" alt="Scale icon" /></td>
<td>Click this button to display/hide a scale on the x and y-axis of the image window.</td>
</tr>
<tr>
<td><img src="image" alt="Grid icon" /></td>
<td>Click this button to display/hide a grid the image window.</td>
</tr>
</tbody>
</table>

| Units | Choose the units (cm or pixels) for distance measurements in the image window. |
Viewing X,Y Coordinates & Intensity Data

1. Open an image, and the Image Information tools, choose Cm or Pixels from the Units drop-down list.
2. Put the mouse pointer over a location of in the image.
   The x,y coordinates and intensity data are displayed in the Tool Palette.

![Image](image-url)

**Figure 7.13** x,y coordinates and intensity data at the mouse pointer location
Image Histogram

The image histogram plots a frequency distribution of the pixel intensities in an image. The software sorts the intensities into groups or bins (x-axis) and plots the number of pixels per bin (y-axis).

To view the image histogram:
1. Open an image, and in the Image Information tools, click the Image Histogram button.

NOTE
By default the Auto min/max range of the image data determines the histogram range and bins (the software sets the min and max values to optimize image display and suppress background noise). To display the histogram using the full intensity range of the image, click Full in the Histogram window.

2. To edit the minimum or maximum bin intensity, enter a new value in the Min Bin or Max Bin box, or click the arrows.
3. To edit the number of bins, enter a new value in the # Bins box or click the arrows.

NOTE
In the Overlay display mode, the histogram plots the luminescent data. To obtain a histogram of the photograph, select Photograph from the Display drop-down list.

Table 7.6 Histogram window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Displays the histogram using the full intensity range of the image.</td>
</tr>
<tr>
<td>Min Bin</td>
<td>The lowest intensity bin.</td>
</tr>
<tr>
<td>Max Bin</td>
<td>The highest intensity bin.</td>
</tr>
<tr>
<td># Bins</td>
<td>The total number of bins.</td>
</tr>
<tr>
<td></td>
<td>Opens a dialog box that enables you to export the histogram (.csv).</td>
</tr>
<tr>
<td></td>
<td>Copies the histogram to the system clipboard.</td>
</tr>
</tbody>
</table>
Table 7.6 Histogram window (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open the print dialog box." /></td>
<td>Opens the print dialog box.</td>
</tr>
</tbody>
</table>

**Line Profile**

The line profile plots intensity (y-axis) at each pixel (x-axis) along a user-specified line in the image. The line profile is automatically updated when you change the line position.

**NOTE**

In the Overlay display mode, the line profile plots the luminescent data. To obtain a histogram of the photograph, select Photograph from the Display drop-down list.

**To display the line profile:**

1. Open an image, and in the Image Information tools, click the **Line Profile** button.

A line appears on the image and the Line Profile window appears.

2. To view the line profile at another location in the image, put the mouse pointer over the line. When the pointer becomes a , drag the line over the image. The blue line determines the pixel intensities that are plotted in the line profile graph.

The line profile is updated as you move the line move over the image.

![Figure 7.15 Viewing a line profile of pixel intensities](image)
Table 7.7  Line Profile window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Orientation</td>
<td>Choose Vertical, Horizontal, or Free Hand from the drop-down list to set the orientation of the line in the image window. The Free Hand orientation enables you to drag each line segment endpoint to a user-selected position.</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the line width.</td>
</tr>
<tr>
<td>Position</td>
<td>Line position (pixels).</td>
</tr>
<tr>
<td>X Min X Max</td>
<td>Displays the minimum and maximum value of the x-axis. Use the arrows to change the x-axis min or max. If photons is selected in the image window, the x-axis units = pixels. If counts is selected in the image window, the x-axis units = cm. To display the range available for the X Min or X Max, place the mouse pointer over the X Min or X Max edit box.</td>
</tr>
<tr>
<td>Y Min Y Max</td>
<td>Displays the minimum and maximum value of the y-axis. Use the arrows to change the y-axis min or max. To display the range available for the Y Min or Y Max, place the mouse pointer over the Y Min or Y Max edit box.</td>
</tr>
<tr>
<td></td>
<td>Click to reset the X and Y Min and Max values to the defaults.</td>
</tr>
<tr>
<td>Full Scale</td>
<td>Select this option to display the full X and Y-axis scales.</td>
</tr>
<tr>
<td>Logarithmic Scale</td>
<td>Select this option to apply a log scale to the y-axis.</td>
</tr>
<tr>
<td></td>
<td>Enables you to choose the grid line pattern to display in the line profile window.</td>
</tr>
<tr>
<td></td>
<td>Exports the line profile data to a .csv or .txt file.</td>
</tr>
<tr>
<td></td>
<td>Copies the line profile graph to the system clipboard.</td>
</tr>
<tr>
<td></td>
<td>Opens the Print dialog box.</td>
</tr>
</tbody>
</table>
Making Measurements

To measure distance with the measurement cursor:

1. Open an image, and in the Image Information tools, click the **Distance Measurement Cursor** button.

   A measurement cursor (A---E) appears on the image (Figure 7.16). The Tool Palette shows the position and length of the cursor.

2. To change the cursor position or size, drag the A or B end of the cursor to a new location on the image.

   The measurement information in the Tool Palette is updated.

3. To hide the cursor, click the button.

**Figure 7.16 Measurement cursor**
The Tool Palette displays the measurement cursor position and length.

**Table 7.8 Measurement cursor position & length**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="A" /></td>
<td>Pixel x,y coordinates of position A on the cursor.</td>
</tr>
<tr>
<td><img src="image" alt="B" /></td>
<td>Pixel x,y coordinates of position B on the cursor.</td>
</tr>
<tr>
<td><img src="image" alt="Distance" /></td>
<td>Length of the cursor from A to B (number of pixels), vertical distance from A to B (number of pixels).</td>
</tr>
<tr>
<td>Distance</td>
<td>Length of the cursor from A to B (number of pixels).</td>
</tr>
</tbody>
</table>
To measure distance using the crop box:
1. Open an image, and in the Image Information tools, click the Image Crop button.

2. When the mouse pointer changes to a +, draw a rectangle on the area of interest.
3. To change the size or position of the crop box, drag a handle at a corner or side of the box.
4. To delete the crop box from the image, click the button.

![Image Crop Button](image.png)

Figure 7.17 Using a crop box to make measurements

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>x,y coordinates at the upper left corner of the box.</td>
</tr>
<tr>
<td>B</td>
<td>x,y coordinates of lower right corner of the box.</td>
</tr>
<tr>
<td></td>
<td>Box width and height.</td>
</tr>
<tr>
<td>Distance</td>
<td>Length of the diagonal from the upper left to lower right corner of the box.</td>
</tr>
</tbody>
</table>

Table 7.9 Crop box position & dimensions
Tagging an Image

An image tag displays the x,y pixel coordinates of the location, and the pixel intensity (z, counts or photons). You can apply a tag at a user-specified location in an image.

**To apply a tag:**
1. Right-click a location in the image.
2. Select **Insert Tag** on the shortcut menu.

**To move a tag:**
1. Position the mouse pointer over the tag.
2. When the hand tool appears, use a click-and-drag operation to move the tag, then click the mouse to set the tag location.

A line between the pixel and the tag identifies the location associated with the tag.

### 7.7 Creating a Transillumination Overview

The transillumination overview tool combines the images of a FLIT sequence (a fluorescence sequence acquired in transillumination mode) into a single image. All of the individual fluorescent signals are stacked over one photograph and the intensity is summed. One overview is created per filter pair. If two filter pairs were used during acquisition, then two overview images will be created.

All transillumination locations are displayed simultaneously; a tool tip displays the transillumination position when you mouse over a transillumination point. An overview image is displayed in radiant efficiency and can be analyzed using the tools in the Tool Palette.

**NOTE**

If you choose the Raster Scan option in the Transillumination Setup box, the overview image is automatically generated. For more details, see page 29.

1. Load a sequence that was acquired in fluorescence transillumination mode.
2. Select **Tools → Transillumination Overview for <name>_SEQ** on the menu bar.
The overview appears.

![Image of Transillumination overview](image.png)

**Figure 7.19** Transillumination overview

### 7.8 Overlaying Multiple Images

The image overlay tool provides a convenient way to view multiple reporters in one image. You can use the image overlay tool to display multiple luminescence or fluorescence images on one photographic image.

**To coregister multiple images:**

1. Acquire an image sequence using the appropriate filters for each reporter. Alternately, create a sequence from images acquired during different sessions. (For more details, see page 108.)
2. Open the image sequence.
3. Open one of the images and optimize the image display using the color scale Min and Max sliders in the Image Adjust tools.

   To view all images in the sequence, click the Display All button to open each image (overlay mode) in a separate image window.

4. Select Tools→Image Overlay for <sequence name>_SEQ on the menu bar.

   The image overlay window appears and shows the first photograph in the sequence. To view a different photograph, make a selection from the photograph drop-down list.

5. To overlay all images, click the button.

   The overlay appears. The photograph is at the bottom of the stack and the last fluorescent or luminescent image in the list is at the top of the stack.
Figure 7.22 Generated overlay

Table 7.10 Image Overlay window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Choose the type of units for displaying the fluorescent or luminescent image. For more details on measurement units, see page 253.</td>
</tr>
<tr>
<td>Photograph</td>
<td>A drop-down list of the photographs in the image sequence.</td>
</tr>
<tr>
<td>Fluorescent or Luminescent Images</td>
<td>The sequence images.</td>
</tr>
<tr>
<td>![Copy to Clipboard]</td>
<td>Copies the overlay to the system clipboard.</td>
</tr>
<tr>
<td>![Export Overlay]</td>
<td>Click to export the overlay to a graphic file.</td>
</tr>
<tr>
<td>![Include Images]</td>
<td>Click to include all fluorescent or luminescent images in the overlay.</td>
</tr>
<tr>
<td>![Remove Images]</td>
<td>Click to remove all fluorescent or luminescent images from the photograph.</td>
</tr>
<tr>
<td>Image Adjust</td>
<td>Tools for adjusting the appearance of the highlighted fluorescent or luminescent image. Adjustments can only be made on one image at a time.</td>
</tr>
<tr>
<td>Min</td>
<td>The minimum pixel intensity associated with the color scale for an image. Pixels less than the minimum value are not displayed.</td>
</tr>
<tr>
<td>Max</td>
<td>The maximum pixel intensity associated with the color scale for an image. Pixels greater than the maximum value are displayed in the maximum color.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Controls the opacity of the fluorescent or luminescent image.</td>
</tr>
</tbody>
</table>
### 7.9 Rendering Intensity Data in Color

The colorize tool renders luminescence or fluorescence data in color, enabling you to see both intensity and spectral information in a single view. The tool provides a useful way to visualize multiple probes or scale probe signals that are not in the visible range.

**To view colorized intensity data:**

1. Open an image sequence.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Table</td>
<td>Tools selecting and modifying the color scale associated with an image.</td>
</tr>
<tr>
<td>Color Scale Type</td>
<td>Choose BlackLevel to show black at the low end of the color scale. Choose WhiteLevel to show white at the low end of the color scale.</td>
</tr>
<tr>
<td>Palette label</td>
<td>To include a brief line of text next to the color scale, enter text in the palette label box, then press the Enter key. To remove the text from the image window, delete the text in the palette label box and press Enter.</td>
</tr>
<tr>
<td>Scales per Column</td>
<td>Sets the number of color scales to display in a column.</td>
</tr>
</tbody>
</table>

#### Table 7.10 Image Overlay window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Scale Type</td>
<td>Choose BlackLevel to show black at the low end of the color scale. Choose WhiteLevel to show white at the low end of the color scale.</td>
</tr>
<tr>
<td>Palette label</td>
<td>To include a brief line of text next to the color scale, enter text in the palette label box, then press the Enter key. To remove the text from the image window, delete the text in the palette label box and press Enter.</td>
</tr>
<tr>
<td>Scales per Column</td>
<td>Sets the number of color scales to display in a column.</td>
</tr>
</tbody>
</table>

#### Figure 7.23 Microplate images

Images were acquired using different combinations of excitation and emission filters. The samples are quantum dot nanocrystals (700 or 800 nm).

2. Select **Tools → Colorize** on the menu bar.
The software renders each luminescent or fluorescent image in color and combines them into a single image (Figure 7.24).

![Colorize view](image)

**Figure 7.24** Colorize view

<table>
<thead>
<tr>
<th>Table 7.11</th>
<th>Colorize tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Colorize</td>
<td></td>
</tr>
<tr>
<td>Color Range</td>
<td>The color map indicates the color range of the selected camera setup from short to long wavelength. The two sliders determine the lower and upper limits of the color range that is used to render color. The parts of the color map outside the selected range are not used in the color rendering process. By default, the entire color range is selected.</td>
</tr>
<tr>
<td>Filter Range</td>
<td>The wavelength range of the luminescent images in the sequence. The two sliders determine the lower and upper end of the filter range. Only the parts of the image that are within the selected wavelength range are colorized. By default, the entire filter range is selected.</td>
</tr>
<tr>
<td>Color Camera</td>
<td></td>
</tr>
<tr>
<td>VIS</td>
<td>Regular camera setup that mainly renders color in the visible range. It is similar to the color response of a commercial digital camera. NIR fluorophores appear dark red to invisible using the VIS camera setup.</td>
</tr>
<tr>
<td>NIR</td>
<td>A special camera setup that extends the color response into the near infrared range. Near infrared fluorophores appear red to purple using the NIR camera setup.</td>
</tr>
<tr>
<td>Log Scale</td>
<td>If this option is chosen, the dynamic range of the brightness in the image is compressed using a log scale. This improves the visibility of dark areas in the image.</td>
</tr>
<tr>
<td>Real Color</td>
<td>If this option is chosen, the colors are rendered using the wavelengths that directly correspond to the camera setup. For example, GFP appears green using real color rendering.</td>
</tr>
<tr>
<td></td>
<td>If this option is not chosen, the original wavelength range of the image is modified to include the entire visible wavelength range of the camera setup. This helps improve the color contrast.</td>
</tr>
</tbody>
</table>
7.10 Exporting or Printing Images

The Image Layout window (Figure 7.25) provides a convenient way to:

- Annotate and export an image (for example, .bmp)
- Print an image
- Copy an image to the system clipboard

1. To open the Image Layout window, select View → Image Layout Window on the menu bar.
2. To paste the active image into the Image Layout window, click the button.
3. To resize the image, drag a handle at a corner of the image.
4. To reposition the image in the window, drag the image.

![Image Layout window](image_url)

Figure 7.25 Image Layout window

Table 7.12 Image Layout window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image_url" alt="Clear button" /></td>
<td>Clears the Image Layout window. <strong>Note:</strong> If you do not clear the layout (click the button) before you close the Image Layout window, the same window contents are displayed the next time the window is opened</td>
</tr>
<tr>
<td><img src="image_url" alt="Save button" /></td>
<td>Opens a dialog box that enables you to save the Image Layout window contents to a graphic file.</td>
</tr>
<tr>
<td><img src="image_url" alt="Paste button" /></td>
<td>Pastes the active image in the Image Layout window.</td>
</tr>
<tr>
<td><img src="image_url" alt="Copy button" /></td>
<td>Copies the contents of the Image Layout window to the system clipboard.</td>
</tr>
<tr>
<td><img src="image_url" alt="Paste clipboard button" /></td>
<td>Pastes the contents of the system clipboard to the Image Layout window.</td>
</tr>
<tr>
<td><img src="image_url" alt="Rectangle tool" /></td>
<td>Rectangle drawing tool</td>
</tr>
<tr>
<td><img src="image_url" alt="Ellipse tool" /></td>
<td>Ellipse drawing tool</td>
</tr>
</tbody>
</table>
7.11 Editing an Image Sequence

You can add or remove individual images from a sequence. Only individual images, not an image sequence, can be added to a sequence.

1. Open the image sequence that you want to edit.
2. If you plan to add images to the sequence, browse for the images that you want to add in the Living Image® browser. (For more details on browsing, see page 81.)

NOTE

If you plan to add images to the sequence, browse for the images that you want to add in the Living Image browser. (For more details on the browser, see page 81.)

3. In the image window, click the Edit button .

---

### Table 7.12 Image Layout window (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pointer tool" /></td>
<td>Pointer tool</td>
</tr>
<tr>
<td><img src="image" alt="Arrow and line drawing tool" /></td>
<td>Arrow and line drawing tool</td>
</tr>
<tr>
<td><img src="image" alt="Select an item" /></td>
<td>Select an item in the Image Layout window. To move the item to the front or back in the window, choose an option from the drop-down list.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Deletes the selected image.</td>
</tr>
<tr>
<td><img src="image" alt="Layout Style" /></td>
<td>A drop-down list of formatting options for the Image Layout window. For example, the 2x2 layout style provides 4 separate layout areas in the window. A different image can be pasted into each layout area.</td>
</tr>
<tr>
<td><img src="image" alt="Annotation" /></td>
<td>To apply notes to an image, enter text in the annotation box and press Enter. Drag the text to the location of interest in the image.</td>
</tr>
<tr>
<td><img src="image" alt="Font and size" /></td>
<td>Opens a dialog box that enables you to select a font or edit the font style and size.</td>
</tr>
<tr>
<td><img src="image" alt="Font color" /></td>
<td>Opens a color palette that enables you to select a font color or specify a custom font color.</td>
</tr>
<tr>
<td><img src="image" alt="Text editor" /></td>
<td>Opens a text editor that enables you to edit the selected text.</td>
</tr>
</tbody>
</table>
4. In the Edit Sequence box that appears, choose the image(s) to add or remove (retire) from the sequence (Figure 7.26).

To add an image to the sequence, select an image from the “Browser Images” and click **Copy**. To remove an image from the sequence, choose an image from “Sequence Clicks” and click **Retire**.

5. To restore a retired image to the sequence, select the retired image and click **Reactivate**.

6. To reorder the sequence, select an image and click **Move Up** or **Move Down**.

**NOTE**

The **Move Up** and **Move Down** buttons are only available when the sequence view window displays images in the default sort order. If the TimeStamp or UserID sort order is selected, the images cannot be reordered.

7. When you are finished editing the sequence, click **Close**.

The updated image sequence is displayed.

### 7.12 Creating an Image Sequence from Individual Images

You can create a sequence from images acquired during different sessions.

1. In the Living Image Browser, browse for the images of interest. (For more details on browsing, see page 81.)

**NOTE**

Browse for individual images (which may or may not be part of a sequence), not image sequences.
2. In the browser, select the images that you want to group together.
   To select adjacent images in the browser, press and hold the **Shift** key while you click the first and last file in the selection.
   To select non-adjacent images in the browser:
   - PC users - Press and hold the **Ctrl** key while you click the images of interest in the browser.
   - Macintosh users - Press and hold the **Cmd** key (apple key) while you click the images of interest in the browser.

3. Click **Load as Group**.
   The image thumbnails are displayed together in an image window. For details on how to save or export the image data, see Chapter 3, page 36.

Organizing Images

When multiple image windows are open, you can organize them in a cascade or tile arrangement.

Choose **Window → Cascade** or **Window → Tile** on the menu bar.
Figure 7.28 Image windows: cascade (top) or tiled (bottom)
8 Working With ROI Tools

8.1 About ROIs

A region of interest (ROI) is a user-specified area in an image (Figure 8.1). The ROI tools enable you to create three types of ROIs: measurement, average background, or subject ROI (Table 8.1). During a session, the Living Image software records information about the ROIs you create and computes statistical data for the ROI measurements. The ROI Measurements table displays the data and provides a convenient way to review or export ROI information (Figure 8.1). (For more details, see Managing the ROI Measurements Table, page 136.)

![ROI Measurements table]

Figure 8.1 Example measurement ROIs and ROI measurements table
8.2 Quick Guide: Drawing Measurement ROIs on an Image or Sequence

These steps provide a quick guide on how to apply a measurement ROI to an image or image sequence. For more details about measurement ROIs, see page 116.

1. Open an image or sequence and click ROI Tools in the Tool Palette.
2. In the ROI tools, select Measurement ROI from the Type drop-down list.
3. Click the Contour button. For an image or sequence, select Auto All from the drop-down list. For kinetic data, select Kinetic ROI.

The software automatically draws measurement ROIs on all images. The ROI label shows the total intensity in the ROI. If you are working with a sequence, open an image to view the intensity label.

![Image of measurement ROI on an image sequence]

**Figure 8.2** Open an image from a sequence to see the ROI intensity measurements.
4. If it is necessary to adjust the ROI boundaries, change any of the auto ROI parameters (use the slider or arrows) (Figure 8.3).

**NOTE**

After the ROIs have been created, right-click an ROI to view a shortcut menu of ROI commands (Ctrl-click for Macintosh users). The shortcut menu provides easy access to many functions for managing ROIs and viewing ROI properties.

5. Click the Measure button in the ROI tools to show the ROI Measurements table.

**Figure 8.3** Auto ROI parameters

Threshold % - Specifies the minimum per cent of peak pixel intensity that a pixel must have to be included in an ROI identified by the software.

**Figure 8.4** ROI Measurements table

The ROI Measurements table displays data for all ROIs created in images or sequences during a session (one ROI per row). The table provides a convenient way to review and export ROI data. For more details on the table, see “Managing the ROI Measurements Table,” page 136.
8.3 ROI Tools

Table 8.2 provides brief explanations for the ROI tools.

![ROI tools in Tool Palette]

The ROI tools that appear in the Tool Palette depend on the type of ROI selected from the Type drop-down list, and whether an image or sequence is active.

**Table 8.2 ROI tools**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Circle ROI" /></td>
<td>Click to select the number of circle ROIs to add to the active image.</td>
</tr>
<tr>
<td><img src="image" alt="Square ROI" /></td>
<td>Click to select the number of square ROIs to add to the active image.</td>
</tr>
<tr>
<td><img src="image" alt="Grid Pattern" /></td>
<td>Click to specify the grid pattern for a measurement ROI that you want to add to the active image. This tool is useful for an image of a multi-well culture plate or microplate.</td>
</tr>
<tr>
<td><img src="image" alt="Auto All" /></td>
<td>Click and select <strong>Auto All</strong> to automatically draw ROIs in the image using the auto ROI parameters. Click and select <strong>Auto 1</strong> to automatically draw one ROI at a user-selected location using the auto ROI parameters. For more details on using the auto ROI features, see page 117.</td>
</tr>
<tr>
<td><img src="image" alt="ROI Measurements" /></td>
<td>Click to display the ROI Measurements table or compute intensity signal in an ROI.</td>
</tr>
<tr>
<td><img src="image" alt="Delete ROI" /></td>
<td>Click to display a drop-down list of options to delete an ROI(s) in the active image. For more details, see page 134. <strong>Note:</strong> These commands do not delete the ROIs that are saved to the system (listed in the Menu Name drop-down list).</td>
</tr>
<tr>
<td><img src="image" alt="Apply to Sequence" /></td>
<td>Choose this option to apply the selected ROI to all images in a sequence.</td>
</tr>
</tbody>
</table>
Table 8.2 ROI tools (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Choose the ROI type from the drop-down list:</td>
</tr>
<tr>
<td>Measurement</td>
<td>Measures the signal intensity in an area of an image.</td>
</tr>
<tr>
<td>Average Bkg</td>
<td>Measures the average signal intensity in a user-specified area of the image that is considered background.</td>
</tr>
<tr>
<td>Subject ROI</td>
<td>Identifies a subject animal in an image. The software automatically associates a measurement and an average bkg ROI that are included in the same subject ROI. Using this type of ROI is optional.</td>
</tr>
<tr>
<td>Save ROIs</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the selected ROI set or the default name for a new ROI set.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected ROI set from the system. Note: This permanently removes the ROI from the system.</td>
</tr>
<tr>
<td>Load</td>
<td>Applies the ROI set selected from the Name drop-down list to the active image.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the ROI set in the active image.</td>
</tr>
<tr>
<td>Note:</td>
<td>This is a global save (the ROI is saved to the system) and the ROI set can be loaded onto any image. If you use the File ➞ Save commands to save an image that includes an ROI, the ROI is saved with the image only (not a global save) and is not available for loading onto other images. For more details, see Saving ROIs, page 133.</td>
</tr>
<tr>
<td>Auto ROI Parameters</td>
<td>Parameters that specify how the auto ROI tool draws an ROI. Note: These are advanced options that are only available if “Show Advanced Options” is selected in the general preferences.</td>
</tr>
<tr>
<td>Threshold %</td>
<td>If the Auto All or Auto 1 method is selected, the Threshold % specifies the minimum per cent of peak pixel intensity that a pixel must have to be included in an ROI identified by the software. Note: After ROIs are drawn on an image, if you modify the Threshold% (move the slider or enter a new value) the software automatically updates the ROIs.</td>
</tr>
<tr>
<td>Lower Limit</td>
<td>Specifies a multiple (1 to 10) of the color scale minimum that sets the lower threshold for identifying an ROI. For example, if the lower limit = 2 and the color scale minimum = 1000 counts, then the auto ROI tool will only draw an ROI on areas of 2000 counts or greater. This helps create ROIs only in the visible range.</td>
</tr>
<tr>
<td>Minimum Size</td>
<td>Sets the minimum size of an ROI (measured in pixels). For example if the minimum size is set at 50, then ROIs created on the image must be greater than 50 pixels in size.</td>
</tr>
<tr>
<td>Preview</td>
<td>If this option is chosen, the software draws the ROI each time a parameter is changed. ROI parameters can be saved without drawing the ROI.</td>
</tr>
<tr>
<td>Use Bkg Offset</td>
<td>Choose this option to measure background-corrected signal. This is typically used to remove natural animal background luminescence, and should not be confused with the dark-charge and read-bias ‘background’ corrections that are applied (by default) to the raw CCD data to remove electronic noise before any measurements. For more details, see page 120.</td>
</tr>
<tr>
<td>Replace ROIs</td>
<td>If this option is chosen, all auto ROIs are replaced when new ROI(s) are created.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>Restores the factory-set defaults for the auto ROI parameters.</td>
</tr>
<tr>
<td>Save/Load</td>
<td>Click to display or hide the tools that enable you to save, load, or delete auto ROIs in the active data. Note: The save function saves parameters, the not actual ROIs. This means that when you load saved auto ROI parameters, the software draws a new ROI using the saved values (Threshold%, Lower Limit, Minimum Size).</td>
</tr>
</tbody>
</table>
8.4 Measurement ROIs

To obtain the intensity signal in a user-specified area of an image, draw a measurement ROI on the image. There are three ways to draw measurement ROIs:

<table>
<thead>
<tr>
<th>Drawing Method</th>
<th>Description</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>Places one or more ROIs (circular, square, or grid shape) on the image.</td>
<td>112</td>
</tr>
<tr>
<td>Automatic</td>
<td>The software automatically locates and draws an ROI(s) on the image. To do this, the software locates the peak pixel intensities in the image and searches the neighborhood around a peak pixel. A pixel is included in the ROI if the pixel intensity is greater than the threshold%, a user-specified percentage of the peak pixel intensity.</td>
<td>117</td>
</tr>
<tr>
<td>Free draw</td>
<td>Draw line segments that define the ROI.</td>
<td>119</td>
</tr>
</tbody>
</table>

**Manually Drawing a Measurement ROI**

1. Open an image or image sequence, and in the ROI tools, select Measurement ROI from the Type drop-down list.
2. Select the ROI shape:
   a. Click the Circle, Square, or Grid button.
      The grid shape is useful for drawing a grid of ROIs on an image of a well plate.
   b. On the drop-down list that appears, select the number of ROIs that you want to add to the image or the grid ROI dimensions.
      The ROI(s) and intensity label(s) appear on the image. If you are working with a sequence, open an image to show the ROI intensity.

![Figure 8.6 Placing two circular ROIs on the image](image-url)

3. Adjust the ROI position:
a. Place the mouse pointer over the ROI. When the pointer becomes a 🔄, click the ROI.
b. Drag the ROI.

4. Adjust the ROI dimensions:
   a. Place the mouse pointer over the ROI. When the pointer becomes a 🔄, click the ROI.
   b. Place the mouse pointer over an ROI handle ⬇️ so that it becomes a 🔄. Drag the handle to resize the ROI.

**NOTE**
You can also change the ROI position or size using the adjustment controls in the ROI Properties box (see “Moving an ROI,” page 129 and “Editing ROI Dimensions,” page 130).

5. Click the **Measure** button ⌁.
   
The ROI measurements and table appear. For more details on the table, see “Managing the ROI Measurements Table,” page 136.
   
   For information on how to save ROIs, see page 116.

### Automatically Drawing Measurement ROIs

The Living Image® software can automatically identify all of the ROIs in an image or image sequence that meet the auto ROI parameter thresholds or draw one ROI at a user-specified location.

1. Open an image or image sequence, and in the ROI tools, select Measurement ROI from the Type drop-down list.
2. Click an ROI shape button (Circle 🗼, Square 🟢, or Contour 🕊) and select Auto All from the drop-down list.
   
The ROIs appear on the image or sequence thumbnails.

![Image of automatically drawing measurement ROIs](image.png)

**Figure 8.7** Automatically drawing measurement ROIs detected by the software

3. Click the **Measure** button ⌁ in the ROI tools to show the ROI Measurements table.
The ROI Measurements table displays data for all ROIs created in images or sequences during a session (one ROI per row). The table provides a convenient way to review and export ROI data. For more details on the table, see “Managing the ROI Measurements Table,” page 136.

4. Double-click a thumbnail to view the ROI measurements on the image (Figure 8.9).

![ROI Measurements table](image)

**Figure 8.8** ROI Measurements table

To automatically draw an ROI at a user-specified location:

1. Open an image.
2. Click an ROI shape button (Circle, Square, or Contour) and select Auto 1 from the drop-down list.

The create tool appears on the image.

![ROI measurements on image](image)

**Figure 8.9** ROI measurements on image
3. Use the ring to move the create tool to the area where you want to draw the ROI, then click Create.

   The ROI appears on the image and the ROI label displays the intensity signal.

4. To draw another ROI on the image, repeat step 2. to step 3.

   For information on how to save ROIs, see page 133.

---

**Drawing an ROI Using the Free Draw Method**

1. Open an image, and in the ROI tools, select the type of ROI that you want to draw from the Type drop-down list.

2. Click an ROI shape button (Circle, Square, or Contour) and select Free Draw from the drop-down list. In this example, the Contour shape was selected for the free draw method.

   The ROI shapes that are available depend on the type of ROI selected.

3. If you selected:
   - Use the pointer (+) to draw the ROI.
   - Use the pointer (+) to click around the area of interest and draw line segments that define the ROI. Right-click when the last point is near the first point in the ROI.
8.5 Subject ROIs

A subject ROI identifies a subject animal in an image. It provides a convenient way to automatically associate (link) a measurement and average background ROI for background-corrected ROI measurements when there is significant autoluminescence or autofluorescence. (For more details on background-corrected ROI measurements, see page 120.) Using a subject ROI is optional.

To draw a subject ROI using the auto ROI feature:
1. Select Subject ROI from the Type drop-down list.
2. Click the button.
3. Select Auto All.

To manually draw a subject ROI:
4. Select Subject ROI from the Type drop-down list.
5. Click the button, and select 1.
6. Position the subject ROI so that it includes the measurement ROI(s) and the associated average background ROI.

8.6 Measuring Background-Corrected Signal

If a subject has significant autoluminescence or autofluorescence, you can obtain a background-corrected ROI measurement by subtracting an average background ROI from a measurement ROI. The software computes:

Background-corrected intensity signal = Average signal in the measurement ROI - Average signal in the average background ROI
NOTE

This is an optional "background" correction that is applied in addition to the electronic dark-charge and read-bias corrections that are applied to the raw CCD data.

The Image Adjust tools and zoom feature are helpful for selecting an appropriate area for an ROI. By setting the image minimum close to zero and zooming in on a background area in the image, you can determine where naturally occurring background luminescence or autofluorescence is present. For more details on the Image Adjust tools and the zoom feature, see page 110 and Magnifying or Panning in the Image Window, page 91.

To measure background-corrected signal:

1. Draw one or more measurement ROIs on the subject. (For more details, see page 120.)
2. Draw an average background ROI on the subject:
   a. Select Average Bkg ROI from the Type drop-down list.
   b. Click the Square or Circle button and select 1.

The ROI is added to the image. For more details on adjusting the ROI position or dimensions, see page 129 and page 130.

NOTE

The average background ROI and measurement ROI do not need to be the same shape or size because the software computes the average intensity signal in each ROI.

3. Use one of the following methods to associate the average background ROI with one or more measurement ROIs:

   Method 1: Draw a subject ROI that includes the measurement ROI and the average background ROI. For details on how to draw a subject ROI, see page 120
Method 2: Right-click the measurement ROI and select **Set BkG ROI to Bkg X** on the shortcut menu that appears.

Method 3:

a. Right-click a background ROI and select **Properties** on the shortcut menu.

b. In the ROI Properties box that appears, click the Bkg ROI tab and put a check mark next to **Use as BKG for future ROIs in**.

---

### 8.7 Kinetic ROIs

Kinetic ROIs help you track signal sources on an unanesthetized, mobile subject. The software automatically creates a separate ROI in each frame based on the user-specified auto ROI settings. As a result, kinetic ROIs are continuously displayed during kinetic data playback. You can draw a kinetic ROI using any of the methods or shapes in **Table 8.1**, page 112.
NOTE

Large kinetic data sets may require more time to create, plot, and measure the ROIs because the software first applies corrections to a frame (specified in the Corrections/Filtering Tool Palette), then draws the ROIs in the frame. The process can be aborted at any time.

These steps provide a quick guide on how to apply a measurement ROI to kinetic data. For more details about measurement ROIs, see page 116.

1. Open the kinetic data and click ROI Tools in the Tool Palette.
2. In the ROI tools, select Measurement ROI from the Type drop-down list.
3. Click the Contour button and select Kinetic ROI.

   The create tool appears on the image.

4. Use the ring to move the create tool to the area where you want to draw the ROI, then click Create.

   The ROI and label appear on the image.

NOTE

When drawing kinetic ROIs on kinetic data with multiple sources, it is recommended that you start with the brightest source, then the next brightest, and so on in order to create ROIs that can be distinguished based on the signal strength.

5. If it is necessary to adjust the ROI boundaries or change any of the auto ROI parameters (use the slider or arrows):
   - Threshold % - Specifies the minimum per cent of peak pixel intensity that a pixel must have to be included in an ROI identified by the software

6. Click Done to hide the create tool.

   The kinetic data playback starts and shows the ROI in each image.
NOTE

After the ROIs have been created, right-click an ROI to view a shortcut menu of ROI commands (Ctrl-click for Macintosh users). The shortcut menu provides easy access to many functions for managing ROIs and viewing ROI properties.

7. To measure intensity in the ROI, click the Measure button \( \text{Measure} \) in the Tool Palette. The Kinetic ROI Measurements table appears (Figure 8.13).

8. To view ROI measurements for all images, click the \( \text{arrow} \) next to Current Frame and select All Frames, then click the Refresh button.

Figure 8.13 Kinetic image window and ROI measurements table

Plotting Kinetic ROI Measurements

The kinetic ROI plot provides a convenient way to view and compare kinetic ROI measurements across user-selected image frames from the same or different kinetic data sets.

1. Open one or more kinetic data sets.
2. Draw kinetic ROIs on the data sets in which you want to measure and compare ROIs.
3. In the ROI tools, click the ROI Measurements button \( \text{ROI Measurements} \).
   The ROI measurements table appears.
4. Click the Plot Kinetic ROI Measurements tab.
5. Make a selection from the Measurement Unit and ROI Measurement drop-down lists.
6. Select a data set and an ROI.
7. Click Plot ROI Measurements.
8. To add other ROI data to the graph, repeat step 6 to step 7.

8.8 Managing ROIs

In the ROI Properties box, you can view information about an ROI, change the position of the ROI on the image, and edit the ROI label or line characteristics.

**Viewing ROI Properties**

1. To view ROI properties, do one of the following:
   - Double-click an ROI in the image.
   - Right-click the ROI and select **Properties** from shortcut menu that appears.
   - Select the ROI, then select **View → Properties** on the menu bar.
   
   The ROI Properties box appears (for more details see Figure 8.17).
2. To view properties for another ROI, click the ROI in the image. Alternately, select an ROI from the ROI drop-down list in the ROI Properties dialog box (Figure 8.15).
ROI selected in the image. To view properties for another ROI, select another ROI from the drop-down list or click an ROI in the image.

Figure 8.15 Opening the ROI Properties dialog box
The items in the ROI Properties box depend on the type of ROI selected in the image. For more details see Table 8.3, page 128.

**Figure 8.16** ROI Properties, Bkg ROI tab
The items in the ROI Properties box depend on the type of ROI selected in the image. For more details see Table 8.3, page 128.
Figure 8.17 ROI Properties, Subj tab and Info tab
The items in the ROI Properties box depend on the type of ROI selected in the image. For more details see Table 8.3, page 128.

Table 8.3 ROI Properties dialog box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROI</td>
<td>A drop-down list of ROIs in the active image or image sequence. To select an ROI, double-click the ROI in the image or make a selection from the drop-down list.</td>
</tr>
<tr>
<td>ROI Label</td>
<td>Click to edit the selected ROI label name.</td>
</tr>
<tr>
<td>Image Number</td>
<td>A drop-down list of open images.</td>
</tr>
<tr>
<td>BKG ROI tab</td>
<td>The Bkg ROI tab shows a drop-down list shows all average background ROIs in the click number selected above that can be linked to a user-specified measurement ROI or subject ROI (selected from the drop-down list at the top of the dialog box).</td>
</tr>
<tr>
<td>Subj ROI</td>
<td>The Subject ROI tab shows a drop-down list of all subject ROIs in the image number selected above that can be linked to a user-specified measurement ROI or average background ROI (selected from the drop-down list at the top of the dialog box). The Bkg ROI tab shows a drop-down list shows all average background ROIs in the click number selected above that can be linked to a user-specified measurement ROI or subject ROI (selected from the drop-down list at the top of the dialog box).</td>
</tr>
<tr>
<td>Info tab</td>
<td>Information about the ROI selected in the image.</td>
</tr>
<tr>
<td>ID</td>
<td>User-entered information about a subject ROI.</td>
</tr>
</tbody>
</table>
Moving an ROI

There are two ways to move an ROI on an image:

- Drag the ROI to a new location
- Edit the settings in the ROI Properties box

**NOTE**

An ROI cannot be moved if it was created using the auto ROI tool or if the ROI position is locked.

To drag an ROI:

1. Put the mouse pointer over the ROI so that it becomes an arrow.
2. Drag the ROI.
3. Release the mouse button when the ROI is properly positioned.

To move an ROI using the ROI Properties dialog box:

1. Double-click the ROI in the image.

   The ROI Properties box appears and displays the position and dimensions of the selected ROI.

### Table 8.3 ROI Properties dialog box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label name of the selected subject ROI.</td>
</tr>
<tr>
<td>Lock Position</td>
<td>Choose this option to lock the position of the ROI selected in the image.</td>
</tr>
<tr>
<td>Xc</td>
<td>X-coordinate of the ROI selected in the image.</td>
</tr>
<tr>
<td>Yc</td>
<td>Y-coordinate of the ROI selected in the image.</td>
</tr>
<tr>
<td>Lock Size</td>
<td>Choose this option to lock the dimensions of the ROI selected in the image.</td>
</tr>
<tr>
<td>Width</td>
<td>Width (pixels or cm) of the ROI selected in the image (for more details on setting the units, see ROI Dimensions, page 138).</td>
</tr>
<tr>
<td>Height</td>
<td>Height (pixels or cm) of the ROI selected in the image.</td>
</tr>
<tr>
<td>Line Size</td>
<td>Specifies the ROI line thickness. To change the line thickness, enter a new value or click the up/down arrows.</td>
</tr>
<tr>
<td>Line Color</td>
<td>Specifies the color of the ROI line. To select a line color, click the Browse button.</td>
</tr>
<tr>
<td>Done</td>
<td>Click to close the ROI Properties box and apply any new settings, including:</td>
</tr>
<tr>
<td></td>
<td>• Linkage between a measurement ROI and subject ROI (for more details, see Drawing an ROI Using the Free Draw Method, page 119).</td>
</tr>
<tr>
<td></td>
<td>• ROI size dimensions or position</td>
</tr>
<tr>
<td></td>
<td>• Subject ROI ID information</td>
</tr>
</tbody>
</table>
2. To set ROI position, enter new Xc (pix) and Yc (pix) values in the ROI Properties box.
3. To rotate the ROI clockwise, enter the degrees in the Angle (deg) box and click outside the box.
4. To lock the current ROI position, choose the Lock Position option.

**NOTE**
The ROI position cannot be changed until the Lock Position option is cleared.

**Editing ROI Dimensions**

There are two ways to resize a circle or square ROI:
- Drag a handle on the ROI
- Edit the settings in the ROI Properties box

**NOTE**
You cannot change the size of an ROI that was created using the auto ROI or free draw tool.

**To resize an ROI using a handle:**
1. Select the ROI and put the mouse pointer over a handle (■) on the ROI.
2. When the pointer becomes a ◄ arrow, drag the handle.
To resize an ROI using the ROI Properties box:

1. Double-click the ROI in the image.

   The ROI Properties box appears and displays the positions and dimensions of the selected ROI.

2. Enter a new width or height value in the ROI Properties box.

3. To lock the current ROI size, choose the Lock Size option.

   **NOTE**
   
   The ROI size cannot be changed until the Lock Size option is cleared.
Editing the ROI Line

1. Double-click the ROI that you want to edit. The ROI Properties box appears (Figure 8.20).

2. To edit the ROI line thickness, enter a new value in the Line Size box. Alternately, click the arrows.

3. To change the ROI line color:
   a. Click the **Browse** button.
   b. The Select Color box appears.
   c. To select a basic color for the ROI line, click a basic color swatch, and click **OK**.
   d. To define a custom color, drag the crosshairs in the custom color field, adjust the brightness slider, and click **Add to Custom Colors**.
   e. To select a custom color for the ROI line, click a custom color swatch, and click **OK**.
Move or Edit the ROI Label

To move the ROI label:
1. Put the mouse pointer over the ROI label.
2. When the pointer becomes a \( \text{\textbf{\textdollar}} \), drag the label, and then click to release the label at the new location (Figure 8.21).

To edit the ROI label:
1. Double-click the ROI of interest. Alternately, right-click the ROI (Ctrl-click for Macintosh users) and select Properties on the shortcut menu.
2. In the ROI Properties box that appears, edit the name in the ROI Label box and click Done (Figure 8.21).

Saving ROIs

The software automatically saves ROIs with an image. The ROI measurements are saved to the AnalyzedClickInfo.txt file associated with the image. ROIs are saved per user and can be applied to other sequences.

To save ROIs to the system:
1. In the Name drop-down list, confirm the default name or enter a new name for the ROI(s).
2. Click **Save**.

   The ROI(s) from the image are saved to the system and can be selected from the Name drop-down list.

**To load ROIs on an image:**

1. Open an image.
2. In the ROI tools, make a selection from the Name drop-down list and click **Load**.

**NOTE**

If you load ROI(s) onto an image, then draw additional ROIs, the **Save** button changes to **Overwrite**. If you want to save this collection of ROIs using the existing name, click **Overwrite**.

---

**Deleting ROIs**

You can delete ROIs from an image or permanently remove ROIs from the system.

**To delete ROIs from an image:**

1. In the ROI tools, click the **x** button.
2. In the drop-down list that appears, select a delete command. The specified ROIs are deleted from the image.

**NOTE**

This does not delete ROIs saved to the system (global save).

**To permanently remove ROIs from the system:**

1. Select the ROI(s) that you want to delete from the drop-down list of saved ROIs.
2. Click **Delete** (Figure 8.24).
8.9 Managing the ROI Measurements Table

The ROI Measurements table shows information and data for the ROIs created during a session. The ROI measurements can be displayed in units of counts or photons, or in terms of efficiency. For more details, see Quantifying Image Data, page 253.

Viewing the ROI Measurements Table

1. Click the button. Alternately, select View → ROI Measurements on the menu bar.

Figure 8.25 Opening the ROI Measurements table

Column headers in the table include ROI information, ROI measurements and dimensions, and information about the image recorded at acquisition.
**Figure 8.26** ROI Measurements table, kinetic ROIs

**Table 8.4** ROI Measurements table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Types</td>
<td>Make a selection from the drop-down list to specify the type of ROI measurements to include in the table.</td>
</tr>
<tr>
<td>None</td>
<td>Excludes ROI measurements from the table.</td>
</tr>
<tr>
<td>Counts (luminescence)</td>
<td>Includes Total Counts, Avg Counts, Stdev Counts, Min Counts, and Max Counts in the table.</td>
</tr>
<tr>
<td>Total Counts</td>
<td>Total Counts = the sum of all counts for all pixels inside the ROI.</td>
</tr>
<tr>
<td>Avg Counts</td>
<td>Avg Counts = Total Counts/Number of pixels or super pixels.</td>
</tr>
<tr>
<td>Stdev Counts</td>
<td>Stdev Counts = standard deviation of the pixel counts inside the ROI.</td>
</tr>
<tr>
<td>Min Counts</td>
<td>Min Counts = lowest number of counts in a pixel inside the ROI.</td>
</tr>
<tr>
<td>Max Counts</td>
<td>Max counts = highest number of counts in a pixel inside the ROI.</td>
</tr>
<tr>
<td>Note:</td>
<td>These numbers are displayed if the units selected in the ROI Measurements table and the image are the same. Otherwise, N/A appears in each column.</td>
</tr>
<tr>
<td>Radiance (Photons)</td>
<td>Total Flux = the radiance (photons/sec) in each pixel summed or integrated over the ROI area (cm²) x 4π.</td>
</tr>
<tr>
<td>(fluorescence)</td>
<td>Average Radiance = the sum of the radiance from each pixel inside the ROI/number of pixels or super pixels (photons/sec/cm²/sr).</td>
</tr>
<tr>
<td>Stdev Radiance</td>
<td>Stdev Radiance = standard deviation of the pixel radiance inside the ROI.</td>
</tr>
<tr>
<td>Min Radiance</td>
<td>Min Radiance = lowest radiance for a pixel inside the ROI.</td>
</tr>
<tr>
<td>Max Radiance</td>
<td>Max Radiance = highest radiance for a pixel inside the ROI.</td>
</tr>
<tr>
<td>Note:</td>
<td>For more details on photon units, see page 254.</td>
</tr>
<tr>
<td>Radiant Efficiency</td>
<td>Epi-fluorescence - Fluorescence emission radiance per incident excitation irradiance: p/sec/cm²/sr/μW/cm²</td>
</tr>
<tr>
<td>(fluorescence)</td>
<td>Transillumination fluorescence - Fluorescence emission radiance per incident excitation power: p/sec/cm²/sr/mW</td>
</tr>
<tr>
<td>Efficiency</td>
<td>Fluorescent emission yield normalized to the incident excitation intensity (radiance of the subject/illumination intensity)</td>
</tr>
<tr>
<td>Efficiency (epi-fluorescence)</td>
<td>Fluorescent emission yield normalized to the incident excitation intensity (radiance of the subject/illumination intensity)</td>
</tr>
<tr>
<td>NTF Efficiency</td>
<td>Fluorescent emission image normalized to the transmission image which is measured with the same emission filter and open excitation filter.</td>
</tr>
</tbody>
</table>
Configuring the ROI Measurements Table

You can customize the data and information (column headers) in the ROI Measurements table. Several predefined categories are available in the Measurement Types, Click Attributes, and ROI Dimensions drop-down lists.

1. To reorder the columns, drag a column header (left or right) in the table.
2. To change the measurement units, make a selection from the Measurement Types drop-down list.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Attributes</td>
<td>Make a selection from the drop-down list to specify the click number (image file) information to include in the table. Click attributes include label name settings and camera settings.</td>
</tr>
<tr>
<td>None</td>
<td>Excludes image attributes from the table.</td>
</tr>
<tr>
<td>All Possible Values</td>
<td>Includes all of the image attributes (for example, label name settings and camera settings) in the table.</td>
</tr>
<tr>
<td>All Populated Values</td>
<td>Includes only the image attributes with values in the table.</td>
</tr>
<tr>
<td>Living Image Universal</td>
<td>Includes all Living Image Universal label name settings in the table.</td>
</tr>
<tr>
<td>ROI Dimensions</td>
<td>Make a selection from the drop-down list to specify the ROI dimensions to include in the table.</td>
</tr>
<tr>
<td>None</td>
<td>Excludes the ROI area, x,y-coordinates, and dimensions from the table.</td>
</tr>
<tr>
<td>Pixels</td>
<td>Includes ROI area, x,y-coordinates, and dimensions (in pixels) in the table.</td>
</tr>
<tr>
<td>cm</td>
<td>Includes ROI area, x,y-coordinates, and dimensions (in cm) in the table.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected row(s) in the table to the system clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Copies all rows in the table to the system clipboard.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Updates the ROI Measurements table (for example, after you draw new ROIs, move an ROI, and close or open image data).</td>
</tr>
<tr>
<td>Configure</td>
<td>Displays the Configure Measurements box that enables you to specify and organize the data categories (column headers) for the table.</td>
</tr>
<tr>
<td>Export</td>
<td>Displays the Save Measurements box so that the data can be saved to a .txt or .csv file. Note: Grid ROI measurements exported to a .csv file can be opened in a spreadsheet application like Microsoft® Excel®.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the ROI Measurements table.</td>
</tr>
</tbody>
</table>

**Figure 8.27** ROI Measurements table
3. To include image information in the ROI table, make a selection from the Image Attributes drop-down list.
4. To include ROI dimensions in the table, select units (Pixels or cm) from the ROI Dimensions drop-down list.

**To create & save a custom table configuration:**

1. In the ROI Measurements table, click **Configure**.
   The Configure Measurements box appears.

   ![Configure Measurements dialog box](image)

   **Figure 8.28** Configure Measurements dialog box

2. Do either of the following:
   - Select a configuration that you want to modify from the User Lists drop-down
   - OR
   - Select Customized (Unsaved) from the User Lists drop-down to create a new configuration

3. To add an item to the table, click an item in the Available Item list and then click **Add**.
4. To remove an item from the table, select the item that you want to remove in the Selected Items list, and click **Remove**.
5. To reorder an item in the Selected Items list, select the item and click **Move Up** or **Move Down**.

   The columns in the ROI Measurements table are updated.

6. To save the table configuration, enter a name in the Name box and click **Save**.

   **NOTE**

   You cannot overwrite a factory loaded configuration. You can modify a factory loaded configuration and save it to a new name.

   **To delete a custom table configuration:**

   1. Select the configuration from the User Lists drop-down and click **Delete**.

   **NOTE**

   Factory loaded table configurations cannot be deleted.
Copy or Export the ROI Measurements Table

**To export the table:**

1. In the ROI Measurements table, click **Export**.
2. In the dialog box that appears, select a folder and enter a name for the file (.txt), then click **Save**.

**To copy the table to the system clipboard:**

Copy selected rows - Select the rows of interest and click **Copy**. Alternatively, select the rows, then right-click the table and choose **Copy** on the shortcut menu.

All rows - Click **Select All** and then click **Copy**. Alternately, press **Ctrl+A**, then right-click the table and choose **Copy** on the shortcut menu.

![ROI Measurements Table](image-url)

**Figure 8.30** Copy all rows in the ROI Measurements table to the system clipboard
The Living Image software provides tools that enable you to mathematically combine two images to create a new image. The primary use of image math is to subtract tissue autofluorescence background from signal.

### 9.1 Creating a New Image Using Image Math

1. Load an image sequence.
2. Select **Tools → Image Math for <name>_SEQ** on the menu bar.
3. In the Image Math window that appears, select an image of interest from box A and box B.

   The Image Math window shows a thumbnail of image A, image B, and the new image.

![Image Math window](image.png)

**Figure 9.1** Opening the Image Math window

To perform image math, open an image sequence or a group of images. For more details on creating a sequence from individual images, see page 108.
4. Select a mathematical function from the Result drop-down list.
5. To include a scaling factor (k) in the function, enter a value for k.
6. To view the new image, click **Display Result for Measuring**.

**To save the new image:**

1. Click the **Save** button. Alternatively, select **File → Save** on the menu bar.
2. In the dialog box that appears, select a directory, and click **Save**.

---

**NOTE**

For more details on items in the Image Math window, see Table 9.1, page 145.
A folder of data is saved to the selected location (AnalyzedClickInfo.txt, ClickInfo.txt, luminescent and photographic TIF images).

**To export the image to a graphic file:**

1. Click the **Export** button (Figure 9.2).
2. In the dialog box that appears, select a directory, enter a file name, and select the file type from the Save as type drop-down list.
3. Click **Save**.

**Table 9.1 Image Math window**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Ranges for A and B</td>
<td>Full - Choose this option to set the Max and Min values to the maximum and minimum data values in the image. Auto - When this option is chosen, the software sets the Min and Max values to optimize image display and suppress background noise. The Min and Max settings can be manually adjusted to further optimize the image display for your needs. <strong>Note:</strong> The color scale does not affect the image math result.</td>
</tr>
<tr>
<td>Color Ranges for Result Image</td>
<td>Full - See above. Auto - See above. Min = 0 - Choose this option to set the minimum data value to zero.</td>
</tr>
<tr>
<td>Results</td>
<td>Drop-down list of mathematical functions that can be used to generate the new image, including: A - B<em>k A + B</em>k A * B*k A/B if Counts(B)&gt;k (Useful for fluorescence tomography.) (A/B)*k</td>
</tr>
<tr>
<td>k, Image Math window</td>
<td>A user-specified scaling factor applied in the results function.</td>
</tr>
<tr>
<td>k, Fluorescent Background Subtraction window</td>
<td>The software computes k = the ratio of the autofluorescent signal measured using the background filter to the autofluorescent signal measured using the excitation filter in a region on the animal where no fluorophore is present.</td>
</tr>
<tr>
<td>Compute ‘k’ from ROI</td>
<td>This option is useful for subtracting fluorescence background. Draw the same ROI in both images on an area considered background. In the “Compute ‘k’ from ROI” drop-down list, select the same ROI in each image.</td>
</tr>
<tr>
<td>with Photo from</td>
<td>Choose this option to display the new image in overlay mode using the selected photographic image. (This option is only available if one of the selected images is an overlay.)</td>
</tr>
<tr>
<td>Display Result for Measuring</td>
<td>Opens the image generated by image math in an image window.</td>
</tr>
</tbody>
</table>
### 9.2 Subtracting Tissue Autofluorescence

To remove tissue autofluorescence from image data, the IVIS Imaging System implements a subtraction method using blue-shifted background filters that emit light at a shorter wavelength (Table 9.2).

**Table 9.2** Example emission, excitation, and background filters for acquiring data that will be corrected for tissue autofluorescence

<table>
<thead>
<tr>
<th>Fluorophore</th>
<th>Emission Filter (nm)</th>
<th>Excitation Filter (Primary Image)</th>
<th>Background Filter (Background Image)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFP</td>
<td>515-575</td>
<td>445-490</td>
<td>410-440</td>
</tr>
<tr>
<td>DsRed</td>
<td>575-650</td>
<td>500-550</td>
<td>460-490</td>
</tr>
<tr>
<td>Cy5.5</td>
<td>695-770</td>
<td>615-665</td>
<td>580-610</td>
</tr>
<tr>
<td>ICG</td>
<td>810-875</td>
<td>710-760</td>
<td>665-695</td>
</tr>
</tbody>
</table>

The objective of using a background filter is to excite the tissue autofluorescence without exciting the fluorophore. To reduce autofluorescence signal in the primary image data, use the image math tool to subtract the background filter image from the primary excitation filter image. For more details on tissue autofluorescence, see Appendix F, page 275.

The software computes: 

\[
\text{Background-corrected signal} = (A - B) \times k
\]

where:

- \(A\) = primary image (acquired using the excitation filter)
- \(B\) = background image (acquired using the background filter)
- \(k\) = (primary signal/background signal)

The background signal is obtained from a measurement ROI that is located in an area where no fluorophore signal is present. The scale factor \(k\) accounts for different levels of tissue autofluorescence due to different excitation wavelengths and filter transmission characteristics.

After you acquire an image sequence that includes a primary and background image, use the image math tool to subtract tissue autofluorescence. (For more details on acquiring an image sequence, see Chapter 4, page 32.)
To subtract tissue autofluorescence:
1. Load the image sequence that includes the primary and background fluorescent images.

![Image sequence](image1)

**Figure 9.3** Image sequence

2. Open either the primary or background image and:
   a. Optimize the image display using the color scale Min and Max sliders in the Image Adjust tools.
   b. Draw a measurement ROI on an area of the animal that represents background signal (area where no fluorophore signal is present).

**NOTE**
You only need to draw the ROI on one of the images. The software copies the ROI to the other image.

![Measurement ROI](image2)

**Figure 9.4** Draw measurement ROI on an area that represents background signal
3. Select **Tools → Image Math for <name>_SEQ** on the menu bar.

4. In the Image Math window that appears, select the primary image in box A. Select the background image in box B.

   For more details on items in the Image Math window, see Table 9.1, page 145.

5. Select the math function 'A-B*k' in the Result drop-down list.

![Image Math Window](image)

**Figure 9.5** Select a math function and view the mathematical result

6. Click **Compute % from ROI**) and select the ROI (created in step 2) from the drop-down list.

   The background-corrected signal is displayed.

7. To view the mathematical result (overlay mode) in a separate image window, click **Display Result For Measuring**.

   If necessary, use the Color Scale Min and Max sliders in the Image Adjust tools to adjust the image display.

**To save the new image:**

1. Click the **Save** button. Alternately, select **File → Save** on the menu bar.

2. In the dialog box that appears, select a directory, and click **Save**.

   A folder of data is saved to the selected location (AnalyzedClickInfo.txt, ClickInfo.txt, luminescent and photographic TIF images).

**To export the new image to a graphic file:**

1. Click the **Export** button.

2. In the dialog box that appears, select a directory, enter a file name, and select the file type from the Save as type drop-down list.

3. Click **Save**.
10 Planar Spectral Image Analysis

The Living Image software applies planar spectral image analysis to a sequence to determine the average depth and total photon flux of a luminescent point source in a user-specified region of interest. For more information on planar spectral image analysis, see Appendix G, page 277.

10.1 Image Sequence Requirements

Use the Imaging Wizard to setup the image sequence required for planar spectral image analysis. (For more details on the Imaging Wizard, see Chapter 4, page 32.) At a minimum, the sequence must include a photographic and luminescent image at the first wavelength and a luminescent image at a second wavelength (560-660).

10.2 Planar Spectral Image Analysis

1. Load the image sequence that you want to analyze.

2. In the Tool Palette, click Planar Spectral Imaging.

3. In the Analyze tab, select the emission filter wavelengths for the analysis (Figure 10.2).

   It is recommended that you do not include a wavelength in the analysis if the signal is less than or equal to the autoluminescent background. If autoluminescent background
is a concern, you can create a background ROI and link it to the measurement ROI prior to planar spectral analysis. (For more details, see *Measuring Background-Corrected Signal*, page 120.)

4. In the ROI List drop-down, select **All** or a particular ROI for the analysis. If there is no measurement ROI, draw an ROI that includes the area for analysis. (For more details on drawing ROIs, see page 112.)

You only need to draw the ROI(s) on one image in the sequence. The software copies the ROI(s) to all other images of the sequence during the analysis. The ROI should include as much of the light emission from a single source as possible.
5. Choose the tissue properties:
   a. In the Properties tab, make a selection from the Tissue Properties drop-down list. Choose the tissue type most representative of the area of interest. Muscle is a good choice for a generic tissue type.

   The software automatically sets the internal medium index of refraction based on the selection in the Tissue Properties list.

6. Make a selection from the Source Spectrum drop-down list (Firefly in this example).

7. Click Analyze in the Analyze tab.

   The Results tab displays the computed average depth (mm) and total flux (photon/sec) of the luminescent point source in the specified ROI(s). For more details on the results, see page 152.

---

**Table 10.1** Planar spectral imaging tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analyze tab</strong></td>
<td>Name of sequence used for the analysis.</td>
</tr>
<tr>
<td>Sequence</td>
<td>The tissue properties and source spectrum selected in the Properties tab.</td>
</tr>
<tr>
<td>Tissue, Source</td>
<td>In the Filter box, select the acquisition wavelengths for the images in the selected sequence. To select non-adjacent wavelengths, press and hold the Ctrl key while you click the wavelengths. (Macintosh users, press and hold the Cmd key while you click the wavelengths.)</td>
</tr>
<tr>
<td>Select Filters</td>
<td>A drop-down list of the ROIs in the active image.</td>
</tr>
</tbody>
</table>
10.3 Viewing Graphical Results

1. In the Results tab, select an ROI.
2. Click **Plot Intensity** or **Plot Linear Fit**.

   The linear fit graph plots the logarithm of the intensity, normalized to the selected source spectrum and the filter transmission properties, against the optical property of the tissue ($\mu_{\text{eff}}$). The slope of the line is the source depth. If any of the measured points (in red) deviate significantly from the straight line fit, then the analysis results may be suspect. The horizontal error bars represent the uncertainty in the optical properties (usually estimated at ±10%). The vertical error bars represent noise in the image.
The intensity graph displays a graph of the measured intensity in the selected ROI at each wavelength in the analysis. The intensity is normalized to the selected source spectrum and the filter transmission properties.

**To export graph data:**

1. Click the Export Data button.
2. In the dialog box that appears, select a directory for the data and enter a file name (.csv).

The data can be opened in a spreadsheet application such as Microsoft Excel®.
10.4 Managing Planar Spectral Imaging Results

Go to the Results tab to select results that you want to view or manage.

To save results:
1. Select the results of interest (Spm_<name>) from the Name drop-down list.
2. Click **Save**.
   
The planar spectral imaging results are saved with the image.

To view results:
1. Select the results of interest from the Name drop-down list.
2. Click **Load**.

To delete results:
1. Select the results that you want to delete from the Name drop-down list.
2. Click **Delete**.

To copy selected results:
1. Right-click the results (row) of interest select **Copy** from the shortcut menu that appears.
   
The selected results are copied to the system clipboard.

To copy all results:
1. In the Results tab, right-click the results table and select **Select All** from the shortcut menu that appears.
   
All of the results are copied to the system clipboard.
To export results:
1. Right-click the results table and select **Export Results** from the shortcut menu that appears.
   In the dialog box that appears, choose a folder for the results, enter a file name (.txt), and click **Save**.
[This page intentionally blank.]
11 Spectral Unmixing

The Living Image software applies spectral unmixing to distinguish the spectral signatures of different fluorescent or luminescent reporters and calculate the respective contribution of each on every pixel of an image. Use spectral unmixing to:

- Extract the signal of one or more fluorophores from the tissue autofluorescence. Images can be acquired using epi-illumination (excitation light above the stage) or transillumination (excitation light below the stage).
- Analyze luminescent or fluorescent images when more than one reporter is used in the same animal model.

11.1 Image Sequence Requirements

Use the Imaging Wizard to set up the image sequence that is required for spectral unmixing. For more details on the wizard, see Chapter 4, page 32.

If you do not use the Imaging Wizard to set up the image sequence, it is recommended that the image sequence include images acquired using several filters that sample the emission or excitation spectra at multiple points across the entire range. Make sure that the band gap between the excitation and emission filters is sufficiently large (for example, >35 nm) so that the excitation light does not leak through the emission filter where it can be detected by the CCD.

11.2 Performing Spectral Unmixing

1. Load the image sequence.

   In the example in Figure 11.1, the fluorophore is Quantum Dots 800. Images were acquired using a 675 nm excitation filter and emission filters from 720 to 820 nm in 20 nm increments.
In spectral unmixing tools, click the Analyze tab, and put a check mark next to the emission wavelengths that you want to include in the analysis.

3. Click **Start Unmixing**.

The Spectral Unmixing Wizard appears and shows the purple data mask that specifies the analysis area. By default, the data mask includes the entire subject.

For more details on the data mask options, see **Table 11.1**.
4. If you do not want to analyze the entire subject, draw a data mask on a user-selected area using the data mask options.

Table 11.1 Data mask options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photograph</td>
<td>If this option is chosen, the software automatically draws the data mask so that it includes the entire photograph.</td>
</tr>
<tr>
<td>Threshold</td>
<td>If necessary use the threshold slider or arrows to adjust the mask so that it matches the underlying subject photograph as closely as possible without including any area outside the subject image.</td>
</tr>
<tr>
<td>Draw Mask</td>
<td>Choose this option to manually draw a data mask on an area of the photograph.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Specifies a rectangular shape for the manual data mask.</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Specifies an elliptical shape for the manual data mask.</td>
</tr>
</tbody>
</table>

5. Click **Next** in the wizard.

In this screen, you will select the subject type and signals (components) to unmix.

![Spectral Unmixing Wizard](image)

**Figure 11.3** Choose the component to unmix

1. Choose a subject type from the drop-down list.
2. Choose one or both types of background signals.
3. If the probe does not automatically appear in this list, select the probe(s). If you are not sure about the probe that was used, choose “Unknown”.

Table 11.2 Spectral unmixing wizard, choose the components to unmix

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imaging Subject</td>
<td>A drop-down list of subject types.</td>
</tr>
</tbody>
</table>
6. Click **Finish** when you are done choosing the components to unmix.

The unmixed images and results are displayed (**Figure 11.4**). The results include a signal distribution map of each unmixed result and a composite image that includes all of the fluorescent signals, each displayed in a different color.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Signals</td>
<td>Any undesired fluorescence that the camera detects; for example, autofluorescence from the animal, food, or instrument background.</td>
</tr>
<tr>
<td>Probe Information</td>
<td>Specify the probes.</td>
</tr>
<tr>
<td>Match Probe Labels</td>
<td>If the probe names are specified, the software attempts to automatically match the unmixed spectra with the specified probe names. <strong>Note:</strong> A correct match is not guaranteed due to the complexity of the in vivo spectra and filter sections, especially when only part of the emission/excitation spectrum is sampled.</td>
</tr>
<tr>
<td>Use Constraints</td>
<td>Choose this option to apply the recommended constraints when performing spectral unmixing. For more details on the constraints, see page 165. To disable the constraints, uncheck this option. Alternately, in the Options tab of the Spectral Unmixing tools, click <strong>Reset Values</strong> and then click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Number of components</td>
<td>The total number of components (background and probe signals) selected for unmixing.</td>
</tr>
</tbody>
</table>

**Figure 11.4** Spectral unmixing results

7. To analyze an unmixed image, double-click the image.
The image appears in a separate image window and the Tool Palette is available. This enables you to make ROI measurements and image adjustments that are saved with the image.

8. To adjust the composite image, double-click the composite image.

The composite image is displayed in a separate window.

Figure 11.5  Composite image window

Table 11.3  Composite image window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>The type of data displayed in the composite image.</td>
</tr>
<tr>
<td>Image list</td>
<td>A list of the images that comprise the composite (background component(s), probe(s), and a photograph).</td>
</tr>
<tr>
<td>Min/Max</td>
<td>Sets the minimum and maximum count to display in the image.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Adjusts the brightness of the component signals.</td>
</tr>
<tr>
<td>Logarithmic Scale</td>
<td>Choose this option to display signals using a logarithmic scale. This may be useful when probe signal strengths differ significantly, for example, a bright source and a dim source.</td>
</tr>
<tr>
<td>Color</td>
<td>Shows the color of the figure legend for the image selected in the image list. Double-click the color swatch to open a color palette that enables you to select a new color for the figure legend.</td>
</tr>
<tr>
<td>Label</td>
<td>The name of the image selected in the image list. To edit the name, double-click the name in this box. Right-click the label name to show a short-cut menu of edit commands (for example, Cut, Copy, Paste).</td>
</tr>
<tr>
<td></td>
<td>Copies the composite image to the system clipboard.</td>
</tr>
<tr>
<td></td>
<td>Click to export the composite image to a graphic file (for example, .jpg).</td>
</tr>
</tbody>
</table>
### 11.3 Spectra Window

The Spectra window plots the normalized spectra of the unmixed results.

![Spectra window](image)

**Figure 11.6** Spectra window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Enables you to select a spectrum to add to the graph. From Library - Choose this option to select a probe from the Living Image database. The library includes spectra of different sources obtained using excitation and emission filters. From ROI - Choose this option to display a spectrum calculated for a user-selected ROI.</td>
</tr>
<tr>
<td>-</td>
<td>Deletes the spectrum selected in the spectrum list from the plot.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of spectrum. UMX - A spectrum generated by the spectral unmixing algorithm. LIB - A user-selected library spectrum. The library includes spectra obtained of different sources obtained using excitation and emission filters. ROI - A spectrum calculated for a user-selected ROI.</td>
</tr>
</tbody>
</table>

---

**Table 11.3** Composite image window (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Opens the Print dialog box.</td>
</tr>
</tbody>
</table>
You can add library spectra or a spectrum calculated for an ROI to the plot.

**To display library spectra:**
1. Click the button and select From Library.
   
   A new row appears in the spectrum list.
2. In the new row, select a probe name from the drop-down list.

**To add spectra from an ROI:**
1. Create an ROI on an image and apply it to the sequence.
2. Click the button and select From ROI.
   
   A new row appears in the spectrum list.
3. In the new row, select an ROI name from the drop-down list.

**To remove a spectrum:**

---

**Table 11.4 Spectra window (continued)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The spectrum identifier used by the unmixing algorithm. The name cannot be modified.</td>
</tr>
<tr>
<td>Label</td>
<td>The spectrum name in the spectrum plot key. Double-click the label to edit it.</td>
</tr>
<tr>
<td>Color</td>
<td>The plot line color for a particular spectrum. For the UMX type spectrum, it is also the color in the composite image. Double-click a color swatch to open the color palette that enables you to change the plot line color for the spectrum.</td>
</tr>
<tr>
<td>Normalized</td>
<td>Normalizes ROI spectra to library spectra.</td>
</tr>
<tr>
<td>Legend</td>
<td>Click to show or hide the spectra plot legend.</td>
</tr>
<tr>
<td>Red Shift</td>
<td>Adjusts library and ROI spectra to compensate for tissue absorption (simulates the red spectral shift of a spectrum produced by a signal that is located at a depth of 5 mm in tissue).</td>
</tr>
</tbody>
</table>

---

**Adding Spectra to the Plot**

You can add library spectra or a spectrum calculated for an ROI to the plot.

**To display library spectra:**
1. Click the button and select From Library.
   
   A new row appears in the spectrum list.
2. In the new row, select a probe name from the drop-down list.

---

**Figure 11.7 Selecting a library spectrum to display**

**To add spectra from an ROI:**
1. Create an ROI on an image and apply it to the sequence.
2. Click the button and select From ROI.
   
   A new row appears in the spectrum list.
3. In the new row, select an ROI name from the drop-down list.

**To remove a spectrum:**
1. In the spectrum list, select the spectrum (row) that you want to remove.
2. Click the \( \times \) button.

### 11.4 Spectral Unmixing Parameters

The Results tab in the Spectral Unmixing Tool Palette shows the optimized fit parameters used by the software to derive the spectral unmixing results (Figure 11.8).

![Tool palette, Spectral unmixing tools, Results tab](image)

**Figure 11.8** Tool palette, Spectral unmixing tools, Results tab

**Table 11.5** Spectral unmixing tools, Results tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Spectral Unmixing Results</strong></td>
<td></td>
</tr>
<tr>
<td>Number of Iterations</td>
<td>The number of iterations that the algorithm used.</td>
</tr>
<tr>
<td>Number of Components</td>
<td>The number of components unmixed.</td>
</tr>
<tr>
<td>Number of Wavelengths</td>
<td>The number of wavelength pairs used in the analysis.</td>
</tr>
<tr>
<td>Number of Samples</td>
<td>The number of pixel samples used in the analysis.</td>
</tr>
<tr>
<td>Lack of Fit (% PCA)</td>
<td>The fitting residue compared to the data filtered by principal component analysis.</td>
</tr>
<tr>
<td>Lack of Fit (% EXP)</td>
<td>The fitting residue compared to the experimental data.</td>
</tr>
<tr>
<td>Divergence Counter</td>
<td>The number of divergences that occurred.</td>
</tr>
<tr>
<td>Maximum Iterations</td>
<td>The maximum number of iterations allowed.</td>
</tr>
<tr>
<td>Denoise (PCA)</td>
<td>Indicates how much of the data was filtered by principal component analysis.</td>
</tr>
<tr>
<td>Normalization</td>
<td>The normalization method used in the analysis.</td>
</tr>
<tr>
<td>Non-negativity Method</td>
<td>The non-negativity method used in the analysis.</td>
</tr>
<tr>
<td>Weighting Mode</td>
<td>The weighting method applied to the data.</td>
</tr>
</tbody>
</table>
Table 11.5  Spectral unmixing tools, Results tab (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Weighting Mode</td>
<td>Indicates if column-wise weighting was used.</td>
</tr>
<tr>
<td>Row Weighting Mode</td>
<td>Indicates if row-wise weighting was used.</td>
</tr>
<tr>
<td>Save Results</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the selected spectral unmixing results.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected spectral unmixing results from the system.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the spectral unmixing results.</td>
</tr>
</tbody>
</table>

11.5 Spectral Unmixing Options

In the spectral unmixing tools, the Options tab shows the user-modifiable parameters in the spectral unmixing algorithm (Figure 11.9). It is recommended that you first perform spectral unmixing using the default settings. Then, if necessary, change the option settings and reanalyze the data.

Table 11.6  Spectral unmixing options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constraints</td>
<td>The constraints for unmixing the components.</td>
</tr>
<tr>
<td>Reset Values</td>
<td>Returns all constraint settings to the default values.</td>
</tr>
<tr>
<td>Init</td>
<td>The method for generating the initial guess of the spectrum for the selected component. “Auto” means this is automatically determined by the software. Alternatively, you can used a loaded spectrum as the initial guess.</td>
</tr>
<tr>
<td>Fix</td>
<td>This option determines whether the spectrum is allowed to change. If this option is chosen, the spectrum of that component is not updated during unmixing.</td>
</tr>
</tbody>
</table>
Table 11.6  Spectral unmixing options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP</td>
<td>Sets a high pass filter for the spectrum. Signal below the HP cut-off frequency is forced to zero. Choose N/A to turn off the high pass filter. Otherwise, the value represents the high pass cut-off frequency. This constraint can help isolate components that are physically mixed and difficult to distinguish.</td>
</tr>
<tr>
<td>LP</td>
<td>Sets a low pass filter for the spectrum. Signal above the LP cut-off frequency is forced to zero. Choose N/A to turn off the low pass filter. Otherwise, the value represents the cut-off frequency of the low pass cut-off frequency. This constraint can help isolate components that are physically mixed and difficult to distinguish.</td>
</tr>
<tr>
<td>Unimod</td>
<td>Choose this option to apply the unimodality constraint. Unimodality forces the spectrum to have only one peak (one extremum). However, small magnitude extrema are allowed if they are less than the Unimod Tolerance value. This tolerance value limits the rising slope of the second spectral peak. For example, 5% tolerance means that the increase in magnitude of the neighboring nodes cannot exceed 5%.</td>
</tr>
<tr>
<td>Sort</td>
<td>Choose this option to automatically sort the unmixed spectra in ascending order of their center wavelength.</td>
</tr>
<tr>
<td>Force</td>
<td>Choose this option to force the first component to non-zero throughout the image.</td>
</tr>
<tr>
<td>Denoise by PCA</td>
<td>Determines how much of the data will be filtered by principal component analysis. Stronger denoising means less principal components will be used in the data and more details will be lost. Stronger denoising also may slow down the unmixing.</td>
</tr>
<tr>
<td>Unimod Tolerance (%)</td>
<td>The threshold for the unimodality constraint. It is the percentage of overshoot allowed for the second spectral peak.</td>
</tr>
<tr>
<td>PCA</td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td>Standard - Principle component analysis performed on the original data. Correlation - Principle component analysis performed on the correlation matrix of the original data. Covariance - Principle component analysis performed on the covariance matrix of the original data.</td>
</tr>
<tr>
<td>Explained Variance</td>
<td>Click to display the PCA variance plot (Figure 11.10).</td>
</tr>
<tr>
<td>Biplot</td>
<td>Click to display the biplot graph (Figure 11.11).</td>
</tr>
<tr>
<td>Update</td>
<td>Click to redo the spectral unmixing results with updated constraints.</td>
</tr>
</tbody>
</table>
PCA Explained Variance

The PCA Explained Variance histogram shows the part of variance (y-axis) that can be explained by a number of principal components (x-axis).

![PCA Explained Variance Histogram](image)

**Figure 11.10** PCA explained variance histogram

PCA Biplot

The PCA biplot is a visualization tool for principal component analysis. It shows a simultaneous display of $n$ observations (pixels) and $p$ variables (wavelengths) on a two-dimensional diagram.

![PCA Biplot](image)

**Figure 11.11** PCA biplot
[This page intentionally blank.]
A surface is a 3D reconstruction of the animal surface (topography) derived from structured light images. The Living Image software requires a surface to perform some types of analyses (Figure 12.1).

You can:

- Save a surface and use it for any of the analyses shown below
- Export a surface for viewing in other 3D viewer applications
- Import a surface

For more details on how the software generates a surface, see Appendix H, page 285.

Figure 12.1 Analyses that require a surface
12.1 Generating a Surface

1. Load the image sequence for the reconstruction. For example, a sequence that was acquired for DLIT analysis.
2. In the surface topography tools, make a selection from the Object drop-down list (nude mouse, fur mouse, or phantom).
3. Select an orientation (dorsal or ventral).
4. Select a smoothing level.
5. Click **Reconstruct**.

The Tomography Analysis box appears. By default, the entire subject is selected for the reconstruction.

6. If you want to reconstruct only a particular region of the subject, resize the rectangle (drag a green handle) so that it includes only the area of interest.
7. Click **Next**.

The purple data mask appears. The mask is an overlay on the subject image that defines the area of interest for the surface topography reconstruction. The mask should match the underlying photograph of the subject as closely as possible without including any area outside the subject image.
8. If it is necessary, adjust the threshold value so that the mask fits the subject image as closely as possible. To change the threshold, do one of the following:

- Press the left or right arrow keys on the keyboard.
- Move the Threshold slider left or right.
- Click the arrows or enter a new value in the box.

1. Click **Finish**.

The surface and 3D tools appear in the Tool Palette. For more details on the Tool Palette, see page 214.
Changing the View Perspective

Figure 12.6 shows examples of the available views. You can view the surface from different perspectives by doing one of the following:

- Select \( \nabla \) to change the view (Figure 12.4)
- Alternately, click the surface in the 3D View window, then press the \( \mathbf{V} \) key to cycle through the different views of the surface
- Select \( \Phi \) to display the perspective view (Figure 12.4)

Table 12.1 3D view toolbar

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Tools</td>
<td>A drop-down list of tools for viewing and working with the surface. Select ( \nabla ) to:</td>
</tr>
<tr>
<td></td>
<td>• Click and display measurement dimensions in the coronal, sagittal, or transaxial view (in the 3D view window).</td>
</tr>
<tr>
<td></td>
<td>• Drag a measurement cursor in the coronal, sagittal, or transaxial view and display measurement dimensions. (For details on measurement cursors, see page 98.)</td>
</tr>
<tr>
<td></td>
<td>Select ( \nabla ) to zoom in or out on the image (use a click-and-drag operation).</td>
</tr>
<tr>
<td></td>
<td>Select ( \nabla ) to move the subject in the window (use a click-and-drag operation).</td>
</tr>
<tr>
<td></td>
<td>Select ( \nabla ) to rotate the subject around the x, y, or z axis (use a click-and-drag operation).</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Click to hide or show the x,y,z-axis display in the 3D view window.</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Click to hide or show coronal, sagittal, and transaxial planes through the surface in the 3D view window.</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Click to show or hide a bounding box around the surface.</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Click to show or hide a grid under the surface.</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Select this tool from the drop-down list to change the view perspective (top, bottom, left, right, front, back, or perspective view). For examples of the views, see Figure 12.6.</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Select this tool from the drop-down list to display the perspective view.</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Click to show or hide measurement cursors in the coronal, sagittal, or transaxial views.</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>After you perform DLIT or FLIT analysis, click a voxel in the 3D reconstruction, then click this button to display measurements for the voxel in the 3D tools (source voxel measurements).</td>
</tr>
<tr>
<td><img src="image" alt="Image Tools" /></td>
<td>Enables you to save the 3D view to a graphic file (for example, .jpg).</td>
</tr>
</tbody>
</table>
Figure 12.5 Surface, perspective view

Figure 12.6 Alternate views of the surface
12.2 Managing Surfaces

After the surface is saved, it can be shared by the Point Source Fitting, DLIT, or FLIT tools.

![Tool palette, Surface topography tools](image)

**Figure 12.7** Tool palette, Surface topography tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the selected surface.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected surface from the system.</td>
</tr>
<tr>
<td>Load</td>
<td>Opens the selected surface.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves a surface to the selected name.</td>
</tr>
<tr>
<td>Overwrite</td>
<td>Saves the surface and overwrites the previous surface results.</td>
</tr>
</tbody>
</table>

12.3 Export or Import a Surface

A surface can be shared with other users or viewed in other 3D viewer applications.

**NOTE**

Surface import capability is only available if Show Advanced Options is selected in the general preferences (see page 238).

1. Load a surface.
2. Select **File → Export (or Import) → 3D Surface** on the menu bar.
3. In the dialog box that appears, select a folder, enter a file name, and select a file type (see Table 12.2).

**NOTE**

Importing a surface by this method is for viewing purposes only, not for coregistration with 3D reconstructions in Living Image software. To import a surface or other organs for coregistration purposes, import an organ atlas. For more details, see page 222.
### Table 12.2 Surface file types

<table>
<thead>
<tr>
<th>Export Option</th>
<th>Description</th>
<th>Export</th>
<th>Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface mesh (.xmh)</td>
<td>A native file format of the Living Image software that is used to exchange 3D surface information between Living Image software and other third party analysis tools. It is based on a basic indexed face set format which stores all of the vertex information first, then stores the triangle information in terms of indexes into the vertex list.</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>AutoCAD DXF (.dxf)</td>
<td>Drawing exchange format that is compatible with most DXF file viewers.</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>VRML 1.0 (.wrl)</td>
<td>VRML 1.0 (.wrl) - Virtual reality modeling language format that is compatible with most VRML viewers.</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Open Inventor (.iv)</td>
<td>The ASCII version of the IV file format which is supported by all IV viewers.</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>STL (.stl or ASCII format)</td>
<td>Stereo lithography binary format compatible with most STL viewers.</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
The point source fitting algorithm is a tool for advanced users that can be used to estimate the optical properties of tissue, the location and power of a point source, or the fluorescent yield of fluorophores.

### 13.1 Image Sequence Requirements

The software analyzes the images in a sequence acquired in one of the following imaging modes:

- Luminescence
- Transillumination fluorescence (bottom-illuminated fluorescence)
- Epi-illumination fluorescence (top-illuminated fluorescence)
- Transmission

The point source fitting algorithm requires an image sequence that includes one or more images and a structured light image.

### 13.2 Displaying the Point Source Fitting Tools

The default Tool Palette does not include the point source fitting tools. These tools are available if the advanced options are selected in the user preferences.

1. Select **Edit → Preferences** on the menu bar.
2. In the dialog box that appears, put a check mark next to **Show Advanced Options**, and click **OK** (Figure 13.1).

   The point source fitting tools appear in the Tool Palette (Figure 13.1). For more details on the tools, see page *page 183*. 
13.3 Point Source Fitting

Point source fitting is performed separately on each image in a sequence.
1. Open the image sequence that you want to analyze.
2. In the Analyze tab of the Point Source Fitting tools, select an image in the sequence.
3. In the Surface Topography tools, generate or load a surface. For more details on generating the surface, see page 169.
NOTE

Confirm that the surface is good quality. If necessary, regenerate the surface using a higher level of smoothing.

4. Click the Params tab.

The default starting values for the source location, power, and tissue optical properties are displayed. The software automatically selects the correct model type for the image data.

5. To fix a parameter starting value, click the unlocked icon so that it becomes a closed lock.

6. If you want to construct the source only in a region of interest, make a selection from the Mask drop-down list.

7. Confirm the angle limit and spatial filter defaults or enter new values.

8. To specify different starting values for the optical properties:
   a. In the Properties tab, make a selection from the Tissue Properties drop-down list.
   b. Confirm the internal medium index of refraction or enter a new value.

9. In the Params tab, click **LM Fitting**.

The source appears on the surface and the Results tab displays the point source fitting results. For more details on the Results tab, see page 186.
13.4 Checking the Point Source Fitting Results

1. In the Results tab, click Photon Density Maps.
   The Photon Density Maps window appears.

2. Select the image from the Image sources drop-down list.

3. Compare the simulated and measured photon densities.

4. To rotate the surface and view it from a different angle, move the thumb wheel to the left or right.
5. To view the photon density profile at another location, drag the cross hairs or click a location.

13.5 Exporting Results

To export all results:
6. In the Results tab, click Export results.
7. In the dialog box that appears, select the destination folder for the results and click OK.
   The information in the Results tab is saved (.csv).

To export user-selected results:
1. Right-click the item of interest in the results list, and select Export Results on the shortcut menu.
2. In the dialog box that appears, choose a folder for the results, enter a file name (.txt), and click Save.
13.6 Managing Results

To save results:
1. Select the results of interest (LMFIT_<name>) from the Name drop-down list.
2. Click Save.

The point source fitting results are saved with the image.

To view results:
1. Select the results of interest from the Name drop-down list.
2. Click Load.

To delete results:
1. Select the results that you want to delete from the Name drop-down list.
2. Click Delete.

To copy selected results:
1. Right-click the results (row) of interest and select Copy from the shortcut menu that appears.

The selected results are copied to the system clipboard.

To copy all results:
1. In the Results tab, right-click the results table and choose Select All from the shortcut menu that appears.
2. Right-click the results table again and select Copy on the shortcut menu.
All of the results are copied to the system clipboard.

13.7 Point Source Fitting Tools

If the image sequence does not include a structure light image, the point source firing tools do not appear in the Tool Palette.

The Analyze tab shows the active image sequence. Select an image for analysis.

![Tool Palette](image)

**Figure 13.8** Point Source Fitting tools, Analyze tab

**Table 13.1** Analyze tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image #</td>
<td>Image number in the active sequence.</td>
</tr>
<tr>
<td>ExWL</td>
<td>Excitation wavelength</td>
</tr>
<tr>
<td>EmWL</td>
<td>Emission wavelength</td>
</tr>
<tr>
<td>MinRadiance</td>
<td>Minimum surface radiance used for model fitting.</td>
</tr>
<tr>
<td>x,y</td>
<td>x- and y-coordinates of the bottom illumination source.</td>
</tr>
</tbody>
</table>
Table 13.2  Params tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Type</td>
<td>Transmission - This model assumes that the light source comes from under the animal and is transmitted through the entire subject. Bioluminescence - Model for luminescent data. Transillumination Fluorescence - Model for fluorescent data acquired with bottom illumination. Epi-illumination Fluorescence - Model for fluorescent data acquired with top illumination.</td>
</tr>
<tr>
<td>Angle Limit (deg)</td>
<td>The angle limit refers to the angle between the object surface normal and the optical axis. The optical axis can be considered to be a line perpendicular to the stage. The surface normal is a line perpendicular to a plane tangent to the surface point. For example, in a dorsal view of a mouse, the highest point on its back would have a normal line perpendicular to the stage. In this case the angle is zero. The side of a mouse abdomen would have a normal line parallel to the stage, so the angle here would be close to 90°. The software uses luminescent image data for surface elements that are less than the angle limit. The default angle limit setting is 70° for the IVIS Imaging System 200 Series or the IVIS Spectrum. For IVIS Spectrum or 200 Series data, if there is significant signal on the side of the subject, a larger angle of 70-85° can be used.</td>
</tr>
<tr>
<td>Spatial Filter</td>
<td>Filters out the noisy data at the mouse edges. A setting of 0.1 means that the analysis includes 90% of the data from the center of mass to the edges.</td>
</tr>
<tr>
<td>Parameter starting values</td>
<td><strong>Note:</strong> Selecting a tissue Properties tab automatically updates MuaEm, MusEm/ MuaEx, and MusEx in the Params tab.</td>
</tr>
<tr>
<td>x, y, or z Source coordinates.d</td>
<td></td>
</tr>
<tr>
<td>F-yield/Power</td>
<td>Fluorescence yield/strength of illumination or luminescence source.</td>
</tr>
</tbody>
</table>
Table 13.2  Params tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MuaEm</td>
<td>Absorption coefficient at the emission wavelength.</td>
</tr>
<tr>
<td>MusEm</td>
<td>Reduced scattering coefficient at the emission wavelength.</td>
</tr>
<tr>
<td>MuaEx</td>
<td>Absorption coefficient at the excitation wavelength.</td>
</tr>
<tr>
<td>MusEx</td>
<td>Reduced scattering coefficient at the excitation wavelength.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>Resets the model type, algorithm starting parameters and algorithm options to the default values.</td>
</tr>
<tr>
<td>Mask</td>
<td>A drop-down list of ROIs in the selected image. Select an ROI to compute only the source in the ROI.</td>
</tr>
<tr>
<td>Statistics Weighting</td>
<td>Choose this option to apply a statistical weighting technique to help reduce the error associated with high radiance measurements.</td>
</tr>
<tr>
<td>LM Fitting</td>
<td>Click to begin the point source fitting.</td>
</tr>
</tbody>
</table>

Table 13.3  Properties tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tissue Properties</td>
<td>Make a selection from this drop-down list to specify starting values for the parameters other than the defaults.  Note: Selecting a tissue property automatically updates MuaEm, MusEm/ MuaEx, and MusEx in the Params tab.</td>
</tr>
<tr>
<td>Internal medium index of refraction</td>
<td>The internal medium index of the tissue selected from the Tissue Properties drop-down list. You can also enter a user-specified value.</td>
</tr>
</tbody>
</table>
Figure 13.11 Point Source Fitting tools, Results tab

Table 13.4 Results tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Error Estimation</strong></td>
<td></td>
</tr>
<tr>
<td>Starting ChiSquare</td>
<td>Error between the measured and simulated photon density at the start of the analysis.</td>
</tr>
<tr>
<td>Ending ChiSquare</td>
<td>Error between the measured and simulated photon density at the end of the analysis.</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>MuaEm (/cm)</td>
<td>Absorption coefficient at the emission wavelength.</td>
</tr>
<tr>
<td>MusEx (/cm)</td>
<td>Reduced scattering coefficient at the excitation wavelength.</td>
</tr>
<tr>
<td>Mueff (/cm)</td>
<td>Effective attenuation coefficient (Mueff = \sqrt[3]{Mua(Mua + Mus)})</td>
</tr>
<tr>
<td>Diff (cm)</td>
<td>Diffusion coefficient, (Diff = (Mua + Mus)/3)</td>
</tr>
<tr>
<td>X location of the source</td>
<td>X-coordinate of the source location.</td>
</tr>
<tr>
<td>Y location of the source</td>
<td>Y-coordinate of the source location.</td>
</tr>
<tr>
<td>Z location of the source</td>
<td>Z-coordinate of the source location.</td>
</tr>
<tr>
<td>Misfit improvement percentage 0.0%</td>
<td>The error between the measurement and the calculated fit.</td>
</tr>
</tbody>
</table>
14 3D Quantification Database

Preparing & Imaging the Samples ........................................... 187
Creating a Quantification Database ...................................... 188
Managing Quantification Results .......................................... 191

It is possible to determine the number of cells in a DLIT source or the number of dye molecules or cells in a FLIT source if a quantification database is available. The database is derived from an analysis of images of known serial dilutions of luminescent cells or fluorescent cells or dye molecules.

14.1 Preparing & Imaging the Samples

1. Prepare a well plate (4 x 6, 6 x 4, 8 x 12, or 12 x 8 well format) that contains a dilution series of luminescent cells or fluorescent dye at four or more concentrations.
2. Include at least four background wells that contain diluent only.
3. Place the well plate on the IVIS stage, positioning it so that it is centered and squared in the field of view.
4. Acquire the images:
   - **Bioluminescent samples** - Acquire one 'Open' filter image of the well plate
   - **Fluorescent samples** - Acquire reflectance-illumination Filter Scan images using the appropriate excitation and emission bandpass filters.

The well plate in Figure 14.1 contains a dilution series of a sample at four concentrations. The image sequence is a filter scan set of images with the excitation filter centered at 465 nm for all the images, and emission filter images centered at 520 nm, 540 nm, 560 nm, and 580 nm.

![Figure 14.1 Well plate data](image-url)
14.2 Creating a Quantification Database

1. Load the well plate image sequence.
2. Select `Tools → Well Plate Quantification for “<name>_SEQ”` on the menu bar.
   The Well Plate Quantification window appears.
3. Choose the Dye molecules or Cells option.
4. Select the well plate dimensions from the Well Plate Type drop-down list.
   The first image in the sequence opens and a grid ROI appears on the image.
5. Adjust the grid ROI to closely fit the plate wells.
6. In the well plate table, select the sample wells, and click **Set** (Figure 14.4). Clicking a row or column header selects the entire row or column.

![Figure 14.4 Select the sample wells and enter the number of cells or molecules](image1)

7. Enter the dilution values in the table cells.
8. Choose the Apply to Sequence option.
9. Choose the Background Wells option.
10. In the well plate table, select the background wells and click **Set**.

![Figure 14.5 Set the background wells](image2)
11. Click **Quantify**.

The results are displayed.

![Quantification plot and results](image)

**Figure 14.6** Quantification plot and results

12. Check the linear fit of the data for each image in the quantification plot.

A good straight line fit gives confidence to the results values. Large deviations from a straight line could indicate possible issues with the dilution series or errors when entering sample dilutions.

**Table 14.1** Quantification results

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excitation (nm)</td>
<td>The excitation and emission filter wavelengths for the image. 'Excitation' and 'Emission' filters will be specified for fluorescent images, and the 'Open' filter for 'Emission' will be specified for bioluminescent images.</td>
</tr>
<tr>
<td>Emission (nm)</td>
<td></td>
</tr>
<tr>
<td>Extinction Coeff</td>
<td>A measure of excitation photon absorption interaction with the well plate samples based on a base-10 logarithmic derivation. The quantum efficiency factor of the conversion of the absorbed photon to the emission wavelength is also included.</td>
</tr>
<tr>
<td>Cross Section</td>
<td>A measure of excitation photon absorption interaction with the well plate samples based on a natural logarithmic derivation. The quantum efficiency factor of the conversion of the absorbed photon to the emission wavelength is also included.</td>
</tr>
</tbody>
</table>
14.3 Managing Quantification Results

The quantification results can be saved with the image sequence and as a calibration database that is made available in the DLIT or FLIT 3D reconstruction tools (in the Properties tab). When you define the properties for performing a 3D reconstruction and a calibration database is specified, the 3D reconstruction results will be displayed in calibrated units for cell numbers or molecule quantities in picomole units.

![Image of quantification results]

**Figure 14.7** Save the quantification results

**Table 14.2** Managing quantification results

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence</td>
<td>Delete - Removes the active quantification results from the image sequence.</td>
</tr>
<tr>
<td></td>
<td>Load - Opens quantification results from the sequence path.</td>
</tr>
<tr>
<td></td>
<td>Save - Saves the quantification results with the selected image sequence.</td>
</tr>
<tr>
<td></td>
<td>Overwrite - Saves the results with the selected image sequence and overwrites previous results.</td>
</tr>
<tr>
<td>Database</td>
<td>Delete - Deletes the database from the system.</td>
</tr>
<tr>
<td></td>
<td>Load - Opens quantification results from the system path.</td>
</tr>
<tr>
<td></td>
<td>Save - Saves the quantification results to a system database that is available for DLIT or FLIT reconstruction.</td>
</tr>
<tr>
<td></td>
<td>Overwrite - Saves the results to the selected database name and overwrites previous results.</td>
</tr>
</tbody>
</table>
[This page intentionally blank.]
The Living Image software provides algorithms for 3D reconstruction of luminescent or fluorescent sources (tomographic analysis). For more details on the DLIT or FLIT algorithm, see Appendix H, page 285.

<table>
<thead>
<tr>
<th>Algorithm</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diffuse Tomography (DLIT)</td>
<td>DLIT provides a complete 3D reconstruction of the luminescent source distribution within the subject. DLIT places no constraints on the geometry or spatial variation of the source strength throughout the volume. DLIT is well-suited for analyzing complex and spatially extended luminescent sources. The 3D reconstruction is presented as voxels. If a luminescent calibration database is available, the number of cells per source can be determined in addition to source intensity (photons/sec).</td>
<td>196</td>
</tr>
<tr>
<td>Fluorescent Tomography (FLIT)</td>
<td>FLIT provides a complete 3D reconstruction of the fluorescent source distribution within the subject. The 3D reconstruction is presented as voxels. If a fluorescent calibration database is available, the number of fluorophore molecules or cells per source can be determined in addition to the total fluorescence yield.</td>
<td>202</td>
</tr>
</tbody>
</table>

The input data to the DLIT algorithm for a 3D reconstruction of luminescent light sources includes:

- A surface that defines the surface of the subject.
- A sequence of two or more images of the light emission from the surface of the subject acquired at different filter bandwidths (Table 15.1). Use the Imaging Wizard to acquire the images.

The input data to the FLIT algorithm for 3D reconstruction of fluorescent light sources includes:

- A surface that defines the surface of the subject.
- A sequence of images acquired at different transillumination source positions using the same excitation and emission filter at each position. Use the Imaging Wizard to acquire the images.
Table 15.1  IVIS System filters for luminescence & fluorescence tomography

<table>
<thead>
<tr>
<th>IVIS Imaging System</th>
<th>Filters</th>
<th>Bandwidth (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 Series</td>
<td>6 emission filters, 550-670 nm</td>
<td>20</td>
</tr>
<tr>
<td>Spectrum</td>
<td>10 excitation filters, 415-760 nm</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>18 emission filters, 490-850 nm</td>
<td></td>
</tr>
</tbody>
</table>

Figure 15.1 shows an example 3D reconstruction workflow.

1. Load an image sequence (see page 195 for image sequence requirements)
2. Generate or load a surface
3. Select tissue and source properties
4. Reconstruct and view source measurements

Figure 15.1  Basic workflow for 3D reconstruction of sources
15.1 Reconstructing Luminescent Sources

General Considerations

Animal Requirements

The best surface topography reconstruction is obtained from nude mice. It is possible to perform 3D imaging on white or light-colored furred mice if the fur is reasonably smooth over the mouse surface. Therefore it is recommended that you comb the fur before imaging to eliminate any "fluffy" areas that may trigger artifacts during the surface topography reconstruction. In this case, it is recommended that you shave the animals or apply a depilatory. 3D reconstructions are currently not possible on black or dark-colored furred mice.

Luminescent Exposure vs. Luciferin Kinetic Profile

It is important to consider the luciferin kinetic profile when you plan the image sequence acquisition. The DLIT algorithm currently assumes a flat luciferin kinetic profile. Therefore, to optimize the signal for DLIT 3D reconstruction, carefully plan the start and finish of image acquisition and ration the exposure time at each emission filter so that the sequence is acquired during the flattest region of the luciferin kinetic profile.

Image Sequence Requirements

Use the Imaging Wizard to setup the image sequence required for DLIT analysis. For more details on the Imaging Wizard, see page 32.

If you plan to manually set up the sequence, Table 15.2 shows the recommended image sequence. Analyzing more images usually produces more accurate results. At a minimum, the sequence must include data from at least two different emission filters (560-660 nm):

- Emission filter #1: Photographic, luminescent
- Emission filter #2: Luminescent image
- One structured light image

Table 15.2 Recommended image sequence for DLIT analysis

<table>
<thead>
<tr>
<th>Image Type</th>
<th>560</th>
<th>580</th>
<th>600</th>
<th>620</th>
<th>640</th>
<th>660</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photograph</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Structured light</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luminescent</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

NOTE

It is recommended that the binning level be the same for all of the luminescent images.

For more information on the DLIT algorithm and user-modifiable parameters, see Appendix H, page 285.
Steps to Reconstruct Luminescent Sources Using DLIT

1. Load an image sequence.
2. Generate or load a surface using the Surface Topography tools. For details on generating the surface, see page 159.
3. In the Tool Palette, choose **DLIT 3D Reconstruction**.

   The Analyze tab shows the data that the algorithm automatically selects for the reconstruction (Figure 15.2). For more details about the Threshold %, see page 199.

4. In the Properties tab, make a selection from the “Tissue Properties” and “Source Spectrum” drop-down lists (Figure 15.3).

   “Muscle” is usually the best choice of tissue properties for general *in vivo* reconstructions.
5. To view the tissue properties ($\mu_a$, $\mu_{\text{eff}}$, $\mu'_s$) for the tissue and source you selected, make a selection from the Plot drop-down.

6. To compute the number of cells per source, select a luminescent calibration database. For details on generating a luminescent calibration database, see page 187.

7. In the Analyze tab, click **Start**. The Data Preview window appears and displays the image data that will be included in the reconstruction. Usually, no data adjustment is required. However, it is possible to exclude or include user-selected pixel data from the analysis. For more details, see page 199.

8. Click **Reconstruct**.
The reconstruction requires about 1-5 minutes, depending on the parameter settings and the processor speed. When the analysis is finished:

- The 3D View window displays the animal surface and the reconstructed sources
- In the Tool Palette, the Results tab displays the results data and the algorithm parameter values
- The 3D Tools appear after a reconstruction is generated or loaded. For more details on the 3D Tools, see page 214-223.

For details on managing results (for example, save, load, or delete), see page 206.

---

**Figure 15.5** DLIT reconstruction results

**Table 15.3 3D view toolbar**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Image Tools](image) | A drop-down list of tools for viewing and working with the surface or DLIT results.  
  
  - Rotates or spins the surface in the x, y, or z-axis direction.  
  
  - Moves the surface in the x or y-axis direction.  
  
  - Zooms in or out on the image. To zoom in, right-click (Cmd key (apple key) +click for Macintosh users) and drag the towards the bottom of the window. To zoom out, right-click and drag the towards the top of the window. |
| ![ Dickinson Forceps](image) | Displays the x,y,z-axis display in the 3D view window. |
| ![ Dickinson Handle](image) | Displays coronal, sagittal, and transaxial cross-sections through the subject in the 3D view window. |
| ![ Dickinson Head](image) | Displays a bounding box around the subject. |
The Data Preview window shows the image data that the algorithm automatically selects for reconstruction. In special cases, you may want to include or exclude particular data from this default selection. There are two ways to do this:

- Change the Threshold % value - Applying a Threshold % value excludes or includes some pixels from the reconstruction. The software computes the minimum and maximum pixel values of an image based on an histogram of pixel intensities. If Threshold % = 0.5%, then pixels with intensity less than 0.5% of the maximum intensity value are excluded from the reconstruction. The Threshold % can be edited for individual images. The Data Preview window is updated when you change the Threshold % value.

- Region selection - Use the pencil tool to mark particular regions to include in the reconstruction. This may be useful for noisy images with high intensity pixels where changing the Threshold % value is not helpful. You can also use this method to focus on particular sources to reconstruct and ignore others.

**To change the Threshold % for a selected image:**

1. Click **Start** in the Analyze tab (Figure 15.6).
   
The Data Preview window appears.
2. Click an image in the Data Preview window.

**NOTE**

Changes to Threshold % are applied to the selected image only. To apply the change to all images, choose the **Select All** option.
3. Click **Data Adjustment**.
4. In the window that appears, enter a new Threshold % value. The new Threshold % appears in the Analyze tab.
5. To reset the Threshold % to the default value (for the selected images), click **Restore Threshold**.

![Data Preview window](image)

**Figure 15.6** Adjusting the Threshold %
To select particular regions for reconstruction:
1. Open the Data Preview window as shown in Figure 15.6.
2. Click Data Adjustment.
3. In the window that appears, choose the Draw option and put the mouse pointer over the image so that the pencil tool appears.
4. To automatically select all pixels in a source, right-click with the region with the pencil tool.
   Alternately, put the pencil over the image and click the mouse key or press and hold the mouse key while moving the pencil over an area of the image.

NOTE
If the pencil tool markings are applied to the image, only the marked pixels are included in the analysis.

Figure 15.7  Selecting regions to include in the reconstruction

Table 15.4  Region Selection Tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw</td>
<td>Choose this option to display the pencil tool. Use this tool to apply markings that select regions to include in the reconstruction.</td>
</tr>
<tr>
<td>Erase</td>
<td>Choose this option to display the eraser tool. Use the eraser to remove pencil tool markings (exclude pixels from the image).</td>
</tr>
<tr>
<td>Painting size</td>
<td>Adjusts the width of the pencil tool mark or the eraser tool.</td>
</tr>
<tr>
<td>Segment</td>
<td>Colors available for the pencil tool.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Adjusts the opacity of the pencil tool markings.</td>
</tr>
<tr>
<td>Reset</td>
<td>Removes all pencil tool markings.</td>
</tr>
</tbody>
</table>
15.2 Reconstructing Fluorescent Sources

Image Sequence Requirements

Use the Imaging Wizard to setup the image sequence required for FLIT analysis. (For more details on the Imaging Wizard, see page 32.) If you plan to manually set up the sequence, Figure 15.8 shows the an example image sequence. Acquire the images using transillumination on the IVIS Spectrum Imaging System using the same excitation and emission filters from at least four source locations that form a rectangle.

Acquire a fluorescent image, structured light image, and photograph at the first transillumination location

Acquire a fluorescent image at the remaining transillumination locations.

Figure 15.8 Example sequence setup for FLIT

Steps to Reconstruct Fluorescent Sources

1. Load an image sequence.
2. Generate or load a surface. For details on generating the surface, see page 159.
3. In the Tool Palette, choose **FLIT 3D Reconstruction**.

   The Analyze tab shows the images that the algorithm automatically selects for the reconstruction based on an appropriate signal level (Figure 15.2). For more details about the Threshold %, see page 199.

Image type: Radiance

Images selected for reconstruction

Figure 15.9 FLIT 3D Reconstruction tools, Analyze tab
4. Select the type of image displayed in the Sequence View window: Radiance or NTF Efficiency (Figure 15.9).

5. In the Properties tab, make a selection from the “Tissue Properties” and “Source Spectrum” drop-down lists (Figure 15.3).
   “Muscle” is usually the best choice of tissue properties for general in vivo reconstructions.

6. To view the tissue properties ($\mu_a$, $\mu_{eff}$, $\mu'_s$) for the tissue you selected, make a selection from the Plot drop-down.

7. To include the number of fluorescent molecules/source in the results, select a fluorescent calibration database.
   For details on generating a luminescent calibration database, see page 187.

8. In the Analyze tab, click Start.

9. The Data Preview window appears and displays the image data that will be included in the reconstruction. Usually, no data adjustment is required. However, it is possible to exclude or include user-selected pixel data from the analysis. For more details, see page 199.
   You can also include or exclude image data by adding or removing the check mark next to the images listed in the Analyze tab (Figure 15.9).

10. Click Reconstruct.
    The reconstruction requires about 1-5 minutes, depending on the parameter settings and the processor speed. When the analysis is finished:
    • The 3D View window displays the surface and the reconstructed sources
    • In the Tool Palette, the Results tab displays the results data and the algorithm parameter values (Figure 15.12).
• The 3D Tools appear in the Tool Palette. For more details on the 3D Tools, see page 214-223.

For details on managing results (for example, save, load, or delete), see page 206.

![3D View toolbar](image)

**Figure 15.11** FLIT results: 3D View window and Results tab
For details on the 3D View toolbar, see Table 15.3, page 198.

### 15.3 3D Reconstruction Results

The Results tab displays information about the photon density, voxels, and algorithm parameters.

**DLIT or FLIT Results**

![Example DLIT 3D reconstruction results](image)

**NOTE**

For more details on DLIT, see Appendix H, page 285. Sometimes adjusting the DLIT algorithm parameters improves the fit of the simulated photon density to the measured photon density data.

**Figure 15.12** Example DLIT 3D reconstruction results
### Table 15.5 DLIT or FLIT 3D reconstruction results

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final voxel size (mm)</td>
<td>The voxel size (length of a side, mm) that produces the optimum solution to the DLIT or FLIT analysis.</td>
</tr>
<tr>
<td>Number of voxels</td>
<td>The number of voxels that describe the light source(s).</td>
</tr>
<tr>
<td>Reduced Chi2</td>
<td>A measure of the difference between the computed and measured photon density maps at the optimum solution. A smaller $\chi^2$ value indicates a better quality of fit.</td>
</tr>
<tr>
<td>Starting voxel size</td>
<td>The voxel size at the start of the analysis. The length of the side of the voxel cube in mm units for the coarsest initial grid size in the adaptive gridding scheme.</td>
</tr>
<tr>
<td>Nsurf (best)</td>
<td>The number of surface element data analyzed per wavelengths/images.</td>
</tr>
<tr>
<td>Total surf samples</td>
<td>The total number of surface element data analyzed for all wavelengths/images.</td>
</tr>
<tr>
<td>Threshold angle</td>
<td>The angle that the object surface normal makes with the optical axis. The optical axis can be considered to be a line perpendicular to the stage. The default setting for this limit is $70^\circ$ for IVIS Spectrum or IVIS 200 data.</td>
</tr>
<tr>
<td>Uniform Surface Sampling</td>
<td>TRUE = the option is chosen and the surface data for each wavelength is sampled spatially uniformly on the signal area. FALSE = the option is not chosen and the N brighter surface elements are used as data in the reconstruction.</td>
</tr>
<tr>
<td>NNLS Weighted Fit</td>
<td>TRUE = the option is chosen and the DLIT or FLIT algorithm weights the wavelength data inversely proportional to data uncertainty in the NNLS reconstruction. FALSE = the option is not chosen.</td>
</tr>
<tr>
<td>Bkgd Fluorescence (FLIT)</td>
<td>The background fluorescence is derived from the data. Background fluorescence can be due to non-specific dye or tissue autofluorescence.</td>
</tr>
<tr>
<td>Image Threshold</td>
<td>The percentage of the minimum radiance at each wavelength (DLIT) or source location (FLIT) is of the maximum radiance. This defines the minimum intensity included in the data.</td>
</tr>
<tr>
<td>Tissue Properties</td>
<td>The tissue properties for modeling the photon propagation.</td>
</tr>
<tr>
<td>Source Spectrum</td>
<td>The emission spectrum of the type of luminescent source.</td>
</tr>
<tr>
<td>Photon Density Maps</td>
<td>Click to view the photon density maps. For more details, see page 207.</td>
</tr>
<tr>
<td>Export Results</td>
<td>Opens a dialog box that enables you to save the results (.csv).</td>
</tr>
<tr>
<td>Save Results</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The default name for the active DLIT or FLIT results. Select results from this drop-down list.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click to delete the selected DLIT or FLIT results.</td>
</tr>
<tr>
<td>Load</td>
<td>Click to load the selected DLIT or FLIT results.</td>
</tr>
<tr>
<td>Save</td>
<td>Click to save the active DLIT or FLIT results.</td>
</tr>
<tr>
<td>Overwrite</td>
<td>If you reanalyze saved results, click to save the new results and overwrite the previous results.</td>
</tr>
</tbody>
</table>
Managing Reconstruction Results

To save 3D results:
1. In the Results tab of the DLIT/FLIT 3D reconstruction tools, confirm the default name or enter a new name.
2. Click **Save**.
   The results are saved to the sequence click number folder and are available in the Name drop-down list.

To open 3D results:
1. In the Results tab, make a selection from the Name drop-down list.
2. Click **Load**.
   The 3D results appear in the 3D View window

To copy user-specified results:
1. In the Results tab, select the text of interest.
2. Right-click the results table and select **Copy** from the shortcut menu that appears.
   The selected results are copied to the system clipboard

To copy all results:
1. In the Results tab, right-click the results table and choose **Select All** from the shortcut menu that appears.
2. Right-click the results table again and select **Copy** from the shortcut menu.
   All of the results are copied to the system clipboard.

To export results:
1. In the results tab, right-click the results table and select Export Results from the shortcut menu that appears.
2. In the dialog box that appears, choose a folder for the results, enter a file name, and click **Save**. The exported results are saved in .csv file format.

### 15.4 Checking the Reconstruction Quality

To check the quality of a 3D reconstruction, it is useful to compare the measured and simulated photon density plots. The photon density is closely related to the measured radiance. Photon density is the steady state measure of the number of photons in a cubic millimeter. Light sources inside the tissue contribute to photon density in other portions of the tissue.

The reconstruction algorithms first convert the luminescent image of surface radiance to photon density just below the animal surface because this is what can be observed. Then the algorithm solves for point source locations inside the tissue which would produce the observed photon density near the surface.

**To view photon density maps:**

1. After the reconstruction is finished or results are loaded, click **Photon Density Maps** in the Results tab. The photon density maps for all wavelengths are displayed (Figure 15.14).
2. To rotate the surface and view it from a different angle, move the thumb wheel to the left or right.

![Figure 15.14 Photon density maps](image)

3. Select a wavelength from the drop-down list. The photon density profiles at the crosshairs location are displayed. In a good reconstruction, the simulated (red) photon density curves closely resemble the measured (blue) photon density curves.
Figure 15.15 Simulated and measured photon density plots

4. To view the photon density profile at another location on the animal surface, drag the crosshairs or click a point on the photon density map.

Table 15.6 Photon Density Maps window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image sources</td>
<td>A list of images used in the reconstruction. Select all images or a particular image number to display.</td>
</tr>
<tr>
<td>Angle of View</td>
<td>The thumb wheel position. Turn the thumb wheel to rotate the surface on the vertical axis.</td>
</tr>
<tr>
<td>Log Scale</td>
<td>Choose this option to display the photon density using a log scale.</td>
</tr>
<tr>
<td>Simulated</td>
<td>The photon density computed from DLIT or FLIT source solutions which best fit the measured photon density.</td>
</tr>
<tr>
<td>Measured</td>
<td>The photon density determined from the image measurements of surface radiance.</td>
</tr>
<tr>
<td>Horizontal Profile</td>
<td>The photon density line profile at the horizontal plane through the subject at the crosshairs location.</td>
</tr>
<tr>
<td>Vertical Profile</td>
<td>The photon density line profile at the vertical plane through the subject at the crosshairs location.</td>
</tr>
<tr>
<td>Position (mm)</td>
<td>Horizontal Profile: The y-axis position of the crosshairs horizontal line. Vertical Profile: The x-axis position of the crosshairs vertical line.</td>
</tr>
</tbody>
</table>
15.5 Measuring Sources

Here is a convenient way to measure the source (total flux or total fluorescence yield, or if calibrated, the abundance in cells or picomoles. The volume and center of mass are also reported in the 3D Tools-Source tab.

**Determine Source Center of Mass**

1. Click the toolbar button and then drawing a box around the source.
2. Click **Center of mass** in the 3D tools-Source tab (Figure 15.16).

The integrated source intensity, volume, and center of mass are displayed in the Source tab. The coronal, sagittal, and transaxial planes intersect at the center of mass of the selected source (Figure 15.17).

**Measure Source Depth**

1. Select the source (see Figure 15.16).
2. Click the button.

The distance from the center of mass to the surface is measured in the three planes (Figure 15.17).
- Coronal and transaxial planes display the shortest distance from the center of mass to the surface
- The sagittal plane displays the distance from the center of mass to the bottom of the subject.
3. To display slice planes through the center of mass, click the button. For more details on planes, see page 210.
Viewing Coordinates

1. In the Coronal, Sagittal, or Transaxial windowpane, click a location in the reconstruction slice.
   The coordinates (mm) of the position are displayed. The coordinates are updated when you press and hold the mouse button while you drag the cursor.
   - Coronal plane - Displays the x-y coordinates.
   - Sagittal plane - Displays the y-z coordinates.
   - Transaxial plane - Displays the x-z coordinates.

Figure 15.17 Slice planes through the source center of mass & distance measurements from the source center of mass to the surface

Displaying Slices Through a Reconstruction

1. Click a location on a source. Alternately, click the toolbar button, draw a box around a source, then click **Center of mass** in the 3D Source tools.
2. Click the toolbar button.
   The Coronal, Sagittal, and Transaxial windowpanes show a slice through the surface taken by the associated plane.

Figure 15.18 Viewing y,z coordinates in the sagittal plane
Figure 15.19  Planes cutting a reconstruction

3. To move a plane, put the mouse cursor over a line in the coronal, sagittal, or transaxial windowpane. When the cursor becomes a \( \uparrow \) or \( \rightarrow \) arrow, drag the line.

   The view is updated in the windowpanes as you move the line.

Figure 15.20  Moving the coronal plane
15.6 Displaying Luminescent & Fluorescent Sources on One Surface

If an experiment includes luminescent and fluorescent reporters, DLIT and FLIT reconstructions can be displayed on one surface.

NOTE
If the DLIT and FLIT image sequences are acquired during the same session, the generated surfaces are nearly identical.

1. Load a DLIT reconstruction and a FLIT reconstruction.
2. Choose one of the reconstructions, click the \( \text{button} \) and select Copy source voxels.
3. In the other reconstruction, click the \( \text{button} \) and choose Paste source voxels.

15.7 Exporting a 3D Scene

The items in the 3D View comprise a 3D scene. For example, the 3D scene in Figure 15.21 includes a surface and voxels. The 3D scene can be exported to DICOM format and viewed in third party software.

1. Load the results that you want to export.
2. Select File → Export → 3D Scene as DICOM on the menu bar.
3. In the dialog box that appears, set the export options, and click Export.

   For more details on the 3D Scene Exporter, see Table 15.7.
4. In the Browse For Folder dialog box that appears, choose a folder for the DICOM files and click **OK**.

During the export operation, the 3D View window displays each slice in the export. For example, if Transaxial Slice is selected for export, then the transaxial windowpane cycles through a display of each exported slice.

**Table 15.7** 3D Scene Exporter dialog box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save DICOM as:</strong></td>
<td>Single-Frame DICOMs - Exports multiple files that contain a single frame each.</td>
</tr>
<tr>
<td></td>
<td>Multi-Frame DICOM - Exports a single file that contains multiple frames.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Choose the Single-Frame or Multi-Frame DICOM option, depending on the third party software you will use to import and view the 3D scene. Some applications cannot reconstruct multi-frame DICOM files.</td>
</tr>
<tr>
<td><strong>Slice Orientation</strong></td>
<td>Choose transaxial, coronal, or sagittal slices for the export.</td>
</tr>
<tr>
<td><strong>Export voxels using original resolution</strong></td>
<td>Choose this option to export source voxels without any smoothing or binning. The original resolution of the source voxels is the resolution obtained after DLIT or FLIT reconstruction (approximately 1mm resolution).</td>
</tr>
<tr>
<td><strong>Total Slices</strong></td>
<td>Parameters that determine the number and resolution of the slices to export.</td>
</tr>
<tr>
<td><strong>Slice spacing</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Pixel spacing</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Slice dimensions</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Solid mesh</strong></td>
<td>The intensity of the pixels inside the surface is set to a small value so that the exported surface appears as a solid structure.</td>
</tr>
<tr>
<td><strong>Axial range</strong></td>
<td>The axial range min/max can be used to select a particular section of the mouse surface or 3D scene for export. The default values select the entire surface along the axis selected in the Slice Orientation drop-down list.</td>
</tr>
<tr>
<td><strong>Hollow mesh</strong></td>
<td>The intensity of pixels inside the surface is set to zero so that the exported surface appears as a hollow empty structure.</td>
</tr>
</tbody>
</table>
15.8 3D Tools Overview

The Tool Palette includes the 3D Tools after you reconstruct or load a surface or 3D sources. The tools are organized by tabs:

<table>
<thead>
<tr>
<th>3D Tools</th>
<th>Functions</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface Tools</td>
<td>Adjust the appearance of the reconstructed animal surface</td>
<td>See below</td>
</tr>
<tr>
<td></td>
<td>and photon density maps</td>
<td></td>
</tr>
<tr>
<td>Source Tools</td>
<td>Adjust the appearance of reconstructed sources, make</td>
<td>216</td>
</tr>
<tr>
<td></td>
<td>source measurements, export voxel measurements</td>
<td></td>
</tr>
<tr>
<td>Registration Tools</td>
<td>Display organs on the reconstructed surface, adjust the</td>
<td>218</td>
</tr>
<tr>
<td></td>
<td>location or scale of organs on the surface, import an organ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>atlas</td>
<td></td>
</tr>
<tr>
<td>Animate Tools</td>
<td>Display preset animations of the 3D View scene. Enables you</td>
<td>223</td>
</tr>
<tr>
<td></td>
<td>to create custom animations and record an animation to a</td>
<td></td>
</tr>
<tr>
<td></td>
<td>movie file</td>
<td></td>
</tr>
</tbody>
</table>

15.9 3D Tools - Surface

Use these tools to adjust the appearance of the reconstructed animal surface and photon density maps.

![3D Tools](image)

Figure 15.23 Surface tools and example DLIT reconstruction with photon density maps

Table 15.8 Surface tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Subject</td>
<td>Choose this option to display the surface in the 3D View window.</td>
</tr>
<tr>
<td>Surface</td>
<td></td>
</tr>
</tbody>
</table>
### Table 15.8 Surface tools (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Drawing styles" /></td>
<td>Drawing styles for the surface.</td>
</tr>
</tbody>
</table>

![Shading styles](image2)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Shading styles" /></td>
<td>Shading styles for the surface.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="Opacity" /></td>
<td>Click to open the color palette from which you can select a display color for the surface and the cross section views.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opacity</strong></td>
<td>Adjusts the surface opacity.</td>
</tr>
<tr>
<td><strong>Display Photon Density Map</strong></td>
<td>Choose this option to display the photon density on the surface.</td>
</tr>
<tr>
<td><strong>Apply</strong></td>
<td>Choose measured or simulated photon density maps for display.</td>
</tr>
<tr>
<td><strong>Wavelengths (DLIT)</strong></td>
<td>Choose the data to display in the photon density map.</td>
</tr>
<tr>
<td><strong>Images (FLIT)</strong></td>
<td>Choose the data to display in the photon density map.</td>
</tr>
<tr>
<td><strong>Intensity</strong></td>
<td>Set the maximum intensity of the photon density map using the slider or by entering a value.</td>
</tr>
<tr>
<td><strong>Color Table</strong></td>
<td>Color scheme for the photon density map.</td>
</tr>
<tr>
<td><strong>Reverse</strong></td>
<td>Choose this option to apply the colors of the selected color table in reverse order. For example, the BlackRed color table represents the source intensity (photons/sec) from low to high using a color scale from black to red. If <strong>Reverse</strong> is chosen, the source intensity (photons/sec) from low to high is represented using the color scale from red to black.</td>
</tr>
</tbody>
</table>
15.10 3D Tools - Source

Use the source tools to:

- Adjust the appearance of sources in DLIT or FLIT reconstructions
- Make source measurements (page 209)
- Export voxel measurements (.csv)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Scale</td>
<td>Choose this option to apply a logarithmic scale to the photon density scale.</td>
</tr>
</tbody>
</table>

Table 15.8 Surface tools (continued)

Table 15.9 Source tools

![Figure 15.24 Source tools and example DLIT reconstruction](image)

Drawing styles for the source surface (see “Display Source Surface”).
Table 15.9  Source tools (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shading styles for the source surface (see “Display Source Surface”).</td>
<td>Click to open the color palette from which you can select a display color for the source surface.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Adjusts the source surface opacity.</td>
</tr>
<tr>
<td>Display Voxels</td>
<td>Choose this option to display the sources reconstructed using DLIT.</td>
</tr>
<tr>
<td>Threshold (DLIT/FLIT only)</td>
<td>Choose this option to apply a minimum threshold intensity to the voxel display.</td>
</tr>
<tr>
<td>Gradation (DLIT/FLIT only)</td>
<td>Use this slider to set a threshold for the percentage voxel intensity above which voxels are opaque and below which voxels will gradually face to transparent. The percentage voxel intensity is the percentage relative to the maximum intensity.</td>
</tr>
<tr>
<td>Voxel size</td>
<td>The 3D grid-spacing size for interpolation of the reconstructed source.</td>
</tr>
<tr>
<td>Smoothing</td>
<td>The smoothing box filter size.</td>
</tr>
<tr>
<td>Display voxels as</td>
<td>The voxel display mode (cubes, spheres, points, or texture).</td>
</tr>
<tr>
<td>Color Table</td>
<td>Color scheme for voxel display.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Choose this option to apply the colors of the selected color table in reverse order to the photon density scale. For example, the BlackRed color table represents the source intensity (photons/sec) from low to high using a color scale from black to red. If Reverse is chosen, the source intensity (photons/sec) from low to high is represented using the color scale from red to black.</td>
</tr>
<tr>
<td>Log Scale</td>
<td>Choose this option to apply a logarithmic scale to the color table.</td>
</tr>
<tr>
<td>Quantification (DLIT)</td>
<td>For uncalibrated sources, the total flux measured for the sources selected using the Measure Source tool. For calibrated sources, this unit will be in [cell] units. For details on using this tool, see page 209.</td>
</tr>
<tr>
<td>Quantification (FLIT)</td>
<td>For uncalibrated sources, the fluorescence yield measured for the voxels selected using the Measure Source tool. Fluorescence yield is expressed in units of [pmol M⁻¹cm⁻¹] here for uncalibrated sources. For calibrated sources, this unit will be in either [cells] or [pmol]. For details using this tool, see page 209.</td>
</tr>
<tr>
<td>Volume</td>
<td>Volume of the selected source (mm³).</td>
</tr>
<tr>
<td>Center of Mass (DLIT or FLIT)</td>
<td>The weighted average x, y, and z-coordinates of the selected voxels, where the weights are the flux of each highlighted voxel.</td>
</tr>
<tr>
<td>Host Organ</td>
<td>The location of the selected source can be referenced to an organ atlas, and the organ from the atlas that is closest to the source will be reported here. This information is available if you select and register an organ atlas with the reconstruction. For more details, see page 222.</td>
</tr>
<tr>
<td>Center of mass</td>
<td>Click to compute the center of mass for the source selected with the Measure Source tool. For details using this tool, see page 209.</td>
</tr>
<tr>
<td>Export Voxel</td>
<td>Enables you to export the voxel measurements in their x-, y-, and z-coordinates and source intensities (.csv file).</td>
</tr>
</tbody>
</table>
15.11 3D Tools - Registration

Use the registration tools to:

- Display organs in the surface (page 219)
- Manually adjust the location or scale of organs in the surface (page 220)
- Check the organ fit (page 221)
- Import an organ atlas (page 222)

You can check the organ fit in the 3D View window (page 221)

Figure 15.25 3D registration tools and surface with fitted organs (“skin” not displayed)

Table 15.10 Registration tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Tool Image]</td>
<td>Use this tool to manually adjust the scale of location of organs. For more details, see page 220.</td>
</tr>
<tr>
<td>![Tool Image]</td>
<td>Fits the organs to the surface using a linear transformation that keeps the shape of the atlas surface.</td>
</tr>
<tr>
<td>![Tool Image]</td>
<td>Fits the organs to the surface using linear transformation and volume deformation.</td>
</tr>
<tr>
<td>![Tool Image]</td>
<td>After fitting organs to the surface using the or tool, if necessary, you can click this button to restore the default fit.</td>
</tr>
<tr>
<td>![Tool Image]</td>
<td>Choose this option to display the organs on the surface. Organs that are check marked will be displayed. For more details, see page 219.</td>
</tr>
<tr>
<td>![Tool Image]</td>
<td>Drawing styles for the organs (see “Display Organs”).</td>
</tr>
</tbody>
</table>
Displaying Organs With the Reconstruction

1. Load reconstruction results and confirm that the surface is in the perspective view (click the toolbar button in the 3D View window or press the R key).

2. In the 3D registration tools, choose the Display Organs option and select an organ atlas.

   The organs in the selected atlas appear on the surface.

3. To fit the organs to the surface, click a registration tool:

   - Rigid registration - Performs linear transformation, but keeps the shape of the atlas surface.
   - Full registration - Performs linear transformation and volume deformation.

   **NOTE**

   For an optimum fit when there is a large difference between the orientation or size of the atlas organs and surface, first use the transformation tool to manually register the surface and atlas organs, then click a registration tool to automatically fit the organs. (For more details on manual registration, see below.)

4. If necessary, adjust the opacity of the organs using the slider or enter a number in the box.

   The organs are easier to view if you uncheck Skin in the Organs list.

5. To clear all organs from the surface, click the Deselect All button. To hide a particular organ, remove the check mark next to the organ name.

6. To display a specific organ(s), choose the organ name. To display all organs on the surface, click the Select All button.

### Table 15.10 Registration tools (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Shading styles for the organs (see “Display Organs”).</td>
</tr>
<tr>
<td>Opacity</td>
<td>Adjusts the opacity of the organ display.</td>
</tr>
<tr>
<td>Organ Atlas</td>
<td>Choose a type of organ atlas.</td>
</tr>
<tr>
<td></td>
<td>Click to select all organs in the database and display them on the surface.</td>
</tr>
<tr>
<td></td>
<td>Click to clear the selected organs and remove all organ diagrams from the</td>
</tr>
<tr>
<td></td>
<td>surface.</td>
</tr>
</tbody>
</table>

### Displaying Organs With the Reconstruction

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Rigid registration - Performs linear transformation, but keeps the shape of</td>
</tr>
<tr>
<td></td>
<td>the atlas surface.</td>
</tr>
<tr>
<td></td>
<td>Full registration - Performs linear transformation and volume deformation.</td>
</tr>
</tbody>
</table>
NOTE
After fitting organs to the surface using the or tool, if necessary, you can click Reset button to restore the default fit.

To manually adjust the scale or location of organs:
1. Load reconstruction results and confirm that the surface is in the perspective view (click the toolbar button in the 3D View window or press the R key).
2. In the 3D registration tools, choose the Display Organs option and select an organ atlas.
   The organs in the selected atlas appear on the surface. In Figure 15.26, only Skin is selected.
3. Click the Transform tool button.
   The transform tool appears.
4. To adjust the x, y, or z-position of the organ, drag the transform tool.
5. Press the Tab key to put the transform tool in scale mode.
   A red cube appears at each corner of the transform tool.
6. To increase or decrease (scale) the size of the organ, drag a red cube at a corner of the transform tool. To restrict scaling to a particular axis, press the X, Y, or Z key, then drag a red cube.
7. Press the Tab key again to put the transform tool in rotate mode.
   A red, green, and blue circle appear around the surface.
8. To rotate the organ on the x,y, or z-axis, click the blue, green, or red circle and drag the mouse arrow in the direction of interest.

To return the digital organ to the default position and size, click the **Reset** button, then **button**.

9. To turn off the transform tool, click the **Transform tool** button.

**To check the organ fit:**

1. Check the fit in the coronal, sagittal, and transaxial windowpanes.
2. Click the **Change view** toolbar button.

The Top view is displayed.

3. Press the **V** key or the **button** to display alternative views of the surface.
Importing an Organ Atlas

An organ atlas (.iv, .dxf, or .stl, one organ per file) consisting of segmented organ surfaces derived from an MRI or CT scan can be imported into the Living Image software for registration with the animal surfaces derived from IVIS data. Organ files must be segmented from MRI or CT 3D volumetric data in third party medical imaging analysis software.

**NOTE**

The imported atlas must include a surface (skin) file which delineates the animal surface. The file name must include the word “skin”, for example *rat skin.iv*.

1. Load a DLIT or FLIT image sequence that is associated with the mouse comprising the organ files in *.iv, *.dxf or *.stl format.
2. Select **File → Import → Organ Atlas** on the menu bar.
3. In the dialog box that appears, click **Add Organ Files** *(Figure 15.30).*
4. In the next dialog box that appears, select all of the files (.iv, .dxf, .stl) that you want to include in the atlas (one file per organ) and click Open.

5. In the Select Skin Mesh drop-down list, select the skin organ file, which must include ‘skin’ in the file name.

6. Click Generate Mesh Coefficients.

7. Enter a name for the atlas and click Save Organ Atlas.

   The organ atlas (.atlas) is created and is added to the Organ Atlas drop-down list (in the 3D tools, Registration tab).

15.12 3D Tools - Animate

The Living Image software can create an animation from a sequence of 3D views or key frames. For example, an animation can depict a rotating 3D scene (Figure 15.31). The animation (series of key frames) can be recorded to a movie file (.mov, .mp4, or .avi).
Use the animation tools to:

- View a preset animation (derived from a factory loaded animation setup) (page 225)
- Create a custom animation (generated from your custom animation setup) (page 227)
- Save an animation setup (page 229)
- Record an animation to a movie file (page 229)
- Edit an animation setup (page 229)

**Figure 15.31** Individual 3D views (key frames) in the preset animation “Spin CW on Y-Axis”

The box shows the key frames in the current animation setup. Click a key frame in this box to display the associated 3D view and time stamp (position in the time scale (0-100) at which the frame occurs in the animation).

Click to view the animation composed of the key frames.

**Table 15.11** 3D animation tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Scale%</td>
<td>The time stamp of a key frame in the animation on a time scale of 0-100. For example, if the animation is 10 sec long and includes five key frames: Key frame 1: Time stamp = 0; first frame of the animation. Key frame 2: Time stamp = 25%; frame occurs 2.5 seconds after the start of animation. Key frame 3: Time stamp = 50%; frame occurs 5.0 seconds after the start of animation. Key frame 4: Time stamp = 75%; frame occurs 7.5 seconds after the start of animation. Key frame 5: Time stamp = 100%; last frame of the animation.</td>
</tr>
<tr>
<td>Presets</td>
<td>A drop-down list of predefined animation setups.</td>
</tr>
<tr>
<td>Key frame</td>
<td>A 3D view. The software interpolates the key frames to create intermediate frames in real time, then generates an animated sequence from all of the frames. Each successive key frame in a sequence should differ slightly from the preceding one, so that motion is smoothly depicted when the frames are shown at a proper frame rate (frames/second). The Living Image software provides preset key frames or you can specify the 3D views for the key frames.</td>
</tr>
<tr>
<td>Preset Key Frame Factor</td>
<td>Determines how many key frames are used to generate one revolution in a spinning animation (No. of frames = (4 x Key Frame Factor) + 1). Increasing the key frame factor reduces the time period between key frames and creates the appearance of finer movement. Decreasing the key frame factor increases the time period between key frames and creates the appearance of coarser movement.</td>
</tr>
<tr>
<td>FPS</td>
<td>Frames displayed per second in the animation sequence.</td>
</tr>
</tbody>
</table>
Table 15.11 3D animation tools (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Creates a new key frame from the current 3D view.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Updates the selected key frame to the current 3D view.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Deletes a selected or all key frames from the key frame box.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Moves a selected key frame up in the key frame box.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Moves the selected key frame down in the key frame box.</td>
</tr>
</tbody>
</table>

| Total Duration | The total time of the animation sequence.       |
| Play           | Click to view the animation sequence defined by the current key frames and animation parameters. |
| Record         | Displays a dialog box that enables you to save the current animation to a movie (.mov, .mp4, or .avi). |

**Animation Setup**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td>Displays a dialog box that enables you to open an animation setup (.xml).</td>
</tr>
<tr>
<td>Save</td>
<td>Displays a dialog box that enables you to save the current key frames and animation parameters to an animation setup (.xkf).</td>
</tr>
</tbody>
</table>

**Viewing a Preset Animation**

Preset animations are factory loaded animation setups. They include predefined key frames which are used to generate the animation.

Table 15.12 Preset animations

<table>
<thead>
<tr>
<th>Name</th>
<th>Choose This Animation Setup to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spin CW</td>
<td>Rotate the 3D reconstruction clockwise.</td>
</tr>
<tr>
<td>Spin CCW</td>
<td>Rotate the 3D reconstruction counterclockwise.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Magnify the 3D reconstruction.</td>
</tr>
<tr>
<td>Fade In</td>
<td>Increase opacity from 0-100%.</td>
</tr>
<tr>
<td>Fade Out</td>
<td>Decrease opacity from 100-0%.</td>
</tr>
</tbody>
</table>

1. Open the reconstruction results.
2. Select properties to display in the 3D View window (for example, organs, sources, surface, or photon density maps).
3. In the 3D tools, click the Animate tab.
4. If necessary, clear the key frame box (click the **Delete All** button).

5. To view a preset animation, make a selection from the Presets drop-down list. See **Table 15.12** for a description of the preset animations.

   After a preset animation is selected, a list of the key frames appears.

   ![3D animation tools](image)

   **Figure 15.32** 3D animation tools
   
   For more details on the animation tools, see **Table 15.11, page 224**

6. To view the animation, click **Play**.

   ![Key frames for the selected animation](image)

   **Figure 15.33** Key frames for the selected animation

**NOTE**

You can view multiple animations sequentially. For example, if you select Spin CW on X-Axis and Spin CW on Y-axis from the Presets drop-down list, the animation shows the 3D reconstruction spinning clockwise on the x-axis, then spinning clockwise on the y-axis.
Creating a Custom Animation

To create an animation, specify a custom animation setup or edit an existing setup.

1. Open 3D reconstruction results.
2. Select properties to display in the 3D View window (for example, organs, sources, surface, or photon density maps).

3. In the 3D tools, click the Animation tab.
4. If necessary, clear the key frame box (click the button and select Delete All.)
5. To capture the first key frame, click the button.
   The first key frame is added to the key frame box.
6. Adjust the position of the reconstruction in the 3D View using an image tool (for example, , , or ). For more details on the image tools, see page 198.
7. Click the button.
   The second key frame is added to the key frame box.
8. Repeat step 6 to step 7 until all of the key frames are captured. For details on how to edit the key frame sequence, see page 229.

Click a key frame to display the associated 3D view and the time stamp (position in the time scale (0-100) at which the frame occurs in the animated sequence).

9. Confirm the defaults for FPS (frames per second) and Total Duration (length of animation) or enter new values.

\[ \text{FPS} \times \text{Total Duration} = \text{No. of frames generated to create the animation.} \]

The number of generated frames should be \( \geq \) to the number of key frames. Otherwise, the frames may not be properly animated.

10. To view the animation, click Play. To stop the animation, click Stop.

An animation setup (series of key frames) can be saved (.xkf) or recorded to a movie (.mov, mp4, .avi).
To save an animation setup:
1. Click Save.
2. In the dialog box that appears, select a directory and enter a file name (.xkf)

To record the animation to a movie:
1. Click Record.
2. In the dialog box that appears, choose a directory, enter a file name (.mov, mp4, .avi), and click Save.

To edit an animation setup:
1. Open a reconstruction.
2. Open an animation setup. To select a predefined setup, make a selection from the Preset drop-down list.
To select a saved user-defined setup:
   a. Click Load.
   b. In the dialog box that appears, select an animation setup (.xkf).

3. To add a key frame:
   a. Adjust the position of the reconstruction in the 3D view using an image tool (for example, 🎯, or 🕒). For more details on the image tools, see page 198.
   b. Click the 🟢 button.
4. To reorder a key frame in the sequence, select the key frame and click the 🔵 or 🔴 arrow.
5. To update a key frame:
   a. Select the key frame and adjust the 3D view.
   b. Click the ✔️ button.
6. To delete a key frame:
   a. Select the key frame that you want to remove.
   b. Click the ❌ button and select Delete Current.
### 15.13 DLIT/FLIT Troubleshooting

<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No sources in solution</td>
<td>- In DLIT or FLIT, this can occur if the surface is not correct. That is, if a surface is imported into the 3D View from another source other than from the Structured Light Analysis.</td>
</tr>
</tbody>
</table>
| Surfaces are spiky     | - The most common source of spiky surfaces are folds in the animal skin or fur, which corrupt the desired smooth lines projected on the animal from the laser galvanometer.  
- Choose the ‘Fur Mouse’ option for ‘Subject’  
- Smoothing the surface by using the ‘Smooth’ feature in the Surface Topography tools can help improve the surface |
| Bad Photon Density fit | - The optical properties or source spectrum may have been chosen erroneously. For example, for mice, ‘Muscle’ optical property is appropriate while ‘XPM-2’ is only appropriate for the Caliper phantom. |
Appendix A   IVIS Acquisition Control Panel

A.1 Control Panel

The control panel provides the image acquisition functions (Figure A.1).

![IVIS acquisition control panel, auto exposure selected](image)

To acquire an image using auto exposure, click the \( \Rightarrow \) arrow and select **Auto**.

**NOTE**

The options available in the IVIS acquisition control panel depend on the selected imaging mode, the imaging system, and the filter wheel or lens option that are installed.

**Table A.1**   IVIS acquisition control panel

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luminescent</td>
<td>Choose this option to acquire a luminescent image.</td>
</tr>
<tr>
<td>Fluorescent</td>
<td>Choose this option to acquire a fluorescent image.</td>
</tr>
<tr>
<td></td>
<td>If the Fluorescent option is selected on the IVIS Spectrum Imaging System,</td>
</tr>
<tr>
<td></td>
<td>the following options also appear in the control panel:</td>
</tr>
<tr>
<td></td>
<td>Transillumination - Choose this option to acquire a fluorescent image using</td>
</tr>
<tr>
<td></td>
<td>transillumination (excitation light located below the stage).</td>
</tr>
<tr>
<td></td>
<td>Normalized - This option is selected by default when the Fluorescent and</td>
</tr>
<tr>
<td></td>
<td>Transillumination options are chosen so that NTF Efficiency images can be</td>
</tr>
<tr>
<td></td>
<td>produced.</td>
</tr>
</tbody>
</table>
Exposure time

The length of time that the shutter is open during acquisition of a photographic or luminescent image. The luminescent or fluorescent signal level is directly proportional to the exposure time. The goal is to adjust the exposure time to produce a signal that is well above the noise (>600 counts recommended), but less than the CCD camera saturation of ~60,000 counts.

Luminescent exposure time is measured in seconds or minutes. The minimum calibrated exposure time is 0.5 seconds. The exposure time for fluorescent images is limited to 60 seconds to prevent saturation of the CCD. There is no limit on the maximum exposure time for luminescent images; however, there is little benefit to exposure times greater than five minutes. The signal is linear with respect to exposure time over the range from 0.5 to 10 minutes. Integration times less than 0.5 seconds are not recommended due to the finite time required to open and close the lens shutter.

Binning

Controls the pixel size on the CCD camera. Increasing the binning increases the pixel size and the sensitivity, but reduces spatial resolution. Binning a luminescent image can significantly improve the signal-to-noise ratio. The loss of spatial resolution at high binning is often acceptable for in vivo images where light emission is diffuse. For more details on binning, see Appendix C, page 248.

Recommended binning: 1-4 for imaging of cells or tissue sections, 4-8 for in vivo imaging of subjects, and 8-16 for in vivo imaging of subjects with very dim sources.

F/stop

Sets the size of the camera lens aperture. The aperture size controls the amount of light detected and the depth of field. A larger f/stop number corresponds to a smaller aperture size and results in lower sensitivity because less light is collected for the image. However, a smaller aperture usually results in better image sharpness and depth of field.

A photographic image is taken with a small aperture (f/8 or f/16) to produce the sharpest image and a luminescent image is taken with a large aperture (f/1) to maximize sensitivity. For more details on f/stop, see Appendix C, page 247.

Excitation Filter

A drop-down list of fluorescence excitation filters. For fluorescent imaging, choose the appropriate filter for your application. For luminescent imaging, Block is selected by default. If you select Open, no filter is present. For systems equipped with spectral imaging capability, choose the appropriate emission filter for your application.

Note: The excitation filter selection automatically sets the emission filter position.

Emission Filter

A drop-down list of fluorescence emission filters located in front of the CCD lens. The emission filter wheel is equipped with filters for fluorescence or spectral imaging applications. The number of filter positions (6 to 24) depends on the system. For luminescent imaging, the Open position (no filter) is automatically selected by default.

Photograph

Choose this option to automatically acquire a photograph. The illumination lights at the top of the imaging chamber are on during a photographic image so that the system can acquire a black and white photograph of the sample(s).

Note: You can adjust the appearance of the photographic image using the Bright and Contrast controls (see Adjusting Image Appearance, page 89).

X-ray

Choose this option to acquire an X-ray image.
### Table A.1 IVIS acquisition control panel (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>Choose this option to take a structured light image (an image of parallel laser lines scanned across the subject) when you click Acquire. The structured light image is used to reconstruct the surface topography of the subject which is an input to the Diffuse Luminescence Imaging Tomography (DLIT™) algorithm that computes the 3D location and brightness of luminescent sources. When this option is chosen, the f/stop and exposure time are automatically set to defaults for the structured light image (f/8 and 0.2 sec, respectively). The spatial resolution of the computed surface depends on the line spacing of the structured light lines. The line spacing and binning are automatically set to the optimal values determined by the FOV (stage position) and are not user-modifiable.</td>
</tr>
<tr>
<td>Overlay</td>
<td>If this option is chosen, the system automatically displays the overlay after acquisition is completed (for example, luminescent image on photograph).</td>
</tr>
<tr>
<td>Lights</td>
<td>Turns on the lights located at the top of the imaging chamber.</td>
</tr>
<tr>
<td>Fluor Lamp Level</td>
<td>Sets the illumination intensity level of the excitation lamp used in fluorescent imaging (Off, Low, High, and Inspect). The Low setting is approximately 18% of the High setting. Inspect turns on the illumination lamp so that you can manually inspect the excitation lamp. <strong>Note:</strong> Make sure that the filters of interest are selected in the filter drop-down lists before you select Inspect. The Inspect operation automatically positions the selected filters in the system before turning on the lamp. Subsequent changes to the filter popup menus will have no effect until another Inspect operation is performed.</td>
</tr>
<tr>
<td>Field of View</td>
<td>Sets the size of the stage area to be imaged by adjusting the position of the stage and lens. The FOV is the width of the square area (cm) to be imaged. A smaller FOV gives a higher sensitivity measurement, so it is best to set the FOV no larger than necessary to accommodate the subject or area of interest. The FOV also affects the depth of field (range in which the subject is in focus). A smaller FOV results in a narrower depth of field. Select the FOV by choosing a setting from the drop-down list. For more details on the calibrated FOV positions A-E, see Table A.3, page 235.</td>
</tr>
<tr>
<td>Service</td>
<td>Click to move the stage to a position for cleaning the imaging chamber below the stage. Only available on the IVIS Imaging System 200 Series and IVIS Spectrum.</td>
</tr>
<tr>
<td>Load</td>
<td>Click to move the stage from the cleaning position back to the home position.</td>
</tr>
<tr>
<td>XFOV-24</td>
<td><strong>Note:</strong> This check box is only available on an IVIS® System that includes the XFO-24 lens option. When the XFO-24 lens is installed, choose the XFOV-24 option. For more details on how to install the XFO-24 lens, see the XFOV-24 Lens Instructions.</td>
</tr>
</tbody>
</table>

**IMPORTANT**

**ALERT!** If you remove the XFO-24 lens from the system, be sure to remove the check mark from the XFOV-24 check box.

<table>
<thead>
<tr>
<th>VIC</th>
<th>Select this option when using the Ventral Imaging Chamber to acquire ventral kinetic images on the IVIS Kinetic Imaging System.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Select this option to install and acquire images using the Zoom lens on the IVIS Lumina, IVIS Lumina XR, or IVIS Kinetic Imaging System. After the Zoom lens is installed, the stage automatically moves to the Z position, adjusted by the specified subject height. The Zoom lens is focused to this position.</td>
</tr>
</tbody>
</table>
Table A.1  IVIS acquisition control panel (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject height (cm)</td>
<td>Sets the position of the focal plane of the lens/CCD system by adjusting the stage position. The subject height is the distance above the stage that you are interested in imaging. For example, to image a mouse leg joint, set the subject height to a few mm. To image the uppermost dorsal side of a mouse, set the subject height to the 1.5 - 2.0 cm. The default subject height is 1.5 cm.</td>
</tr>
<tr>
<td><strong>IMPORTANT</strong></td>
<td><strong>ALERT!</strong> The IVIS® System has a protection system to prevent instrument damage, however always pay close attention to subject height, particularly on the IVIS Imaging System 200 Series. For example, it is possible for a large subject (10 cm ventral-dorsal height) to contact the top of the imaging chamber if you set the subject height = 0 and choose a small FOV.</td>
</tr>
<tr>
<td>Focus</td>
<td>Drop-down list of focusing methods available:</td>
</tr>
<tr>
<td><strong>Use subject height</strong></td>
<td>Choose this option to set the focal plane at the specified subject height.</td>
</tr>
<tr>
<td><strong>Manual</strong></td>
<td>Choose this option to open the Focus Image window so that you can manually adjust the stage position. For more details on manual focusing, see page 236.</td>
</tr>
<tr>
<td>Temperature</td>
<td>The temperature box color indicates the temperature and status of the system:</td>
</tr>
<tr>
<td></td>
<td>System not initialized.</td>
</tr>
<tr>
<td></td>
<td>System initialized, but the CCD temperature is out of range.</td>
</tr>
<tr>
<td></td>
<td>System is initialized and the CCD temperature is at or within acceptable range of the demand temperature and locked. The system is ready for imaging.</td>
</tr>
<tr>
<td></td>
<td>Click the temperature box to display the actual and demand temperature of the CCD and stage. For more details, see page 17.</td>
</tr>
<tr>
<td>Acquire</td>
<td>Click to acquire an image using the settings and options selected in the control panel or to acquire an image sequence specified in the Sequential Setup table.</td>
</tr>
<tr>
<td>Sequence Setup</td>
<td>Click to display the Sequence Editor so that you can access the Imaging Wizard, specify and manage sequence acquisition parameters, or open sequence acquisition parameters (xsq). For more details on setting up an image sequence, see page 32.</td>
</tr>
<tr>
<td>Image Setup</td>
<td>Click to close the Sequence Editor.</td>
</tr>
<tr>
<td>Initialize</td>
<td>Click to initialize the IVIS Imaging System. For more details on initializing the system, see page 17.</td>
</tr>
</tbody>
</table>
Table A.2 Additional controls for the IVIS Imaging System 200 Series or IVIS Spectrum

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment grid</td>
<td>Choose this option to activate a laser-generated alignment grid on the stage when the imaging chamber door is opened. The alignment grid is set to the size of the selected FOV. The grid automatically turns off after two minutes. If subject alignment is not completed in two minutes, place a check mark next to <strong>Enable Alignment Grid</strong> to turn on the grid. <strong>Note:</strong> The horizontal cross hair of the alignment grid is offset appropriately to take into account the height entered in the Subject height box.</td>
</tr>
<tr>
<td>Focus</td>
<td><strong>Scan Mid Image</strong> - Choose this option in the Focus drop-down list to set the focal plane at the maximum dorso-ventral height of the subject at the middle of the animal. This focusing method uses the laser to scan horizontally across the middle of the subject to determine the maximum subject height along this line. This option is well suited for animal imaging because the peak height is clearly identified as the maximum height on the dorsal side along the mid-plane of the animal. <strong>Note:</strong> This focusing method is not recommended for microplates or when using a high magnification field of view (FOV A = 4.0 cm). In these situations, Manual or Subject Size focus methods are recommended.</td>
</tr>
<tr>
<td>Transillumination Setup (IVIS Spectrum only)</td>
<td>Choose this option to display the transillumination setup window that enables you to select the locations for image acquisition using bottom illumination that originates beneath the stage.</td>
</tr>
</tbody>
</table>

Table A.3 Typical field of view (FOV) settings

<table>
<thead>
<tr>
<th>FOV Setting</th>
<th>Lumina</th>
<th>Lumina XR</th>
<th>100 Series</th>
<th>200 Series</th>
<th>Spectrum</th>
<th>Kinetic</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FOV (cm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>5</td>
<td>5</td>
<td>10</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>7.5</td>
<td>7.5</td>
<td>15</td>
<td>6.5</td>
<td>6.5</td>
<td>7</td>
</tr>
<tr>
<td>C</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>13</td>
<td>13</td>
<td>10</td>
</tr>
<tr>
<td>D</td>
<td>12.5</td>
<td>12.5&lt;sup&gt;a&lt;/sup&gt;</td>
<td>25</td>
<td>22.5 (19.5)&lt;sup&gt;c&lt;/sup&gt;</td>
<td>22.5 (19.5)&lt;sup&gt;c&lt;/sup&gt;</td>
<td>12</td>
</tr>
<tr>
<td>E</td>
<td>24&lt;sup&gt;b&lt;/sup&gt;</td>
<td>N/A</td>
<td>N/A</td>
<td>22.5 (26)&lt;sup&gt;f&lt;/sup&gt;</td>
<td>22.5 (26)&lt;sup&gt;f&lt;/sup&gt;</td>
<td>24&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Z&lt;sup&gt;d&lt;/sup&gt;</td>
<td>2.6</td>
<td>2.6</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>2.6</td>
</tr>
</tbody>
</table>

<sup>a</sup> Position D is not available for X-ray imaging on the Lumina XR.<br />
<sup>b</sup> Available with removable lens option XFOV-24. Not available on the IVIS Lumina XR.<br />
<sup>c</sup> Some imaging systems may have the FOV in parentheses. FOV 19.5 and 26 were replaced by FOV 22.5.<br />
<sup>d</sup> Position Z is available when the Zoom lens is installed on the IVIS Lumina, IVIS Lumina XR, or IVIS Kinetic Imaging System.
A.2 Manually Setting the Focus

The IVIS Imaging System automatically focuses the image based on subject height. If you do not want to use the automatic focus feature, you can manually set the focus.

1. In the control panel, choose **Manual Focus** in the Focus drop-down list. The Manual Focus window appears.

2. To mark the center of the camera in the window, put a check mark next to **Display CCD Center**.

3. Select the size of the step increment that the stage moves: **Coarse**, **Normal**, or **Fine**.

4. Click **Up** or **Down** to move the stage and change the focus.

5. If necessary, select another F/stop setting from the drop-down list and adjust the light level using the arrows.

6. Click **Update** to apply the settings.

   The resulting focal plane (cm above the stage) is automatically entered in the Subject height box.

7. Click **OK** when the image is focused.

---

**Figure A.2** Opening the Manual Focus window
Appendix B  Preferences

You can manage user IDs and specify defaults for some parameters that are associated with the user ID selected at the start of a new session.

To view the user-modifiable preferences after you log on, select Edit → Preferences on the menu bar.

![Preferences dialog box](image)

**Figure B.1** Preferences dialog box

**NOTE**

Any changes made to the Preferences are implemented at the start of the next session. The Acquisition tab is only available in the Living Image software that controls the IVIS Imaging System.
B.1 General Preferences

Figure B.2 General preferences

Table B.1 General preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Up Defaults</strong></td>
<td>Dock Tool Palette - Choose this option to set the position of the Tool Palette in the application window. Choose left or right.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To undock the Tool Palette, click on the palette title bar and drag it a distance greater than its width.</td>
</tr>
<tr>
<td><strong>Window Size</strong></td>
<td>Specifies the dimensions of the main application window.</td>
</tr>
<tr>
<td></td>
<td>Width, Height - Sets the dimensions of the image window.</td>
</tr>
<tr>
<td></td>
<td>Restore Defaults - Click to apply the default settings.</td>
</tr>
<tr>
<td><strong>Apply Individual Color Scale for Sequences</strong></td>
<td>Choose this option to apply a separate color scale to each thumbnail of a sequence. If this option is not chosen, all of the thumbnails are displayed using the same color scale.</td>
</tr>
<tr>
<td><strong>Show Transillumination Locations</strong></td>
<td>Choose this option to display a cross hair at each transillumination location when you load transillumination data. When you mouse over a cross hair, a tool tip displays the transillumination coordinates. If this option is not chosen, you can choose the Transillumination Location option in the sequence view window to display the transillumination locations.</td>
</tr>
<tr>
<td><strong>Show Advanced Options</strong></td>
<td>If this option is chosen, the Tool Palette includes the Point Source Fitting tools.</td>
</tr>
<tr>
<td><strong>Show Activity Window on:</strong></td>
<td>A drop-down list of options for when to display the activity log (Figure B.3).</td>
</tr>
<tr>
<td><strong>Save Settings</strong></td>
<td>Save float-corrected image - Saves an image after all corrections are applied (read bias subtraction, flat field correction, cosmic correction).</td>
</tr>
<tr>
<td></td>
<td>Color Selections - Applies the color settings of the active image data to subsequently opened image data.</td>
</tr>
<tr>
<td></td>
<td>Folder Locations - Sets the default folder path to the current folder path setting. Click the <strong>Export</strong> button in the image window to view the current folder path setting (Figure B.3).</td>
</tr>
<tr>
<td></td>
<td>Window Size &amp; Position - Applies the active image window size and position settings to subsequently opened image data.</td>
</tr>
<tr>
<td></td>
<td>Most Recently Used Dataset History - Applies the active image window size and position settings to subsequently opened image data.</td>
</tr>
</tbody>
</table>
Some of the general preferences specify how the main application window is organized. To undock the Tool Palette, click on the palette title bar and drag it a distance greater than its width. To dock the Tool Palette in the main window, drag the palette to the right or left side of the window and release.

### Table B.1 General preferences (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display ROI Label As Measurement</td>
<td>Photon - Select the type of measurement (in photons) to show in the ROI label.</td>
</tr>
<tr>
<td></td>
<td>Counts - Select the type of measurement (in counts) to show in the ROI label.</td>
</tr>
</tbody>
</table>

![Figure B.3 Main application window](image-url)
B.2 User Preferences

![User Preferences](image)

**Figure B.4** User preferences

**Table B.2** User preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User’s Settings</td>
<td>Existing User ID - The user ID displayed in the log on dialog box at startup</td>
</tr>
<tr>
<td></td>
<td>New User ID - Opens the Add New User box. A new user is added to the</td>
</tr>
<tr>
<td></td>
<td>Existing User ID drop-down list.</td>
</tr>
<tr>
<td></td>
<td>Delete User ID - Deletes the user selected from the Existing User ID drop-</td>
</tr>
<tr>
<td></td>
<td>down list.</td>
</tr>
<tr>
<td>Preferences/Defaults</td>
<td>Edit User label Choices - Opens a dialog box that enables you to edit the</td>
</tr>
<tr>
<td></td>
<td>Living Image Universal label set</td>
</tr>
<tr>
<td></td>
<td>Default Units - Choose counts or radiance (photons) for image display.</td>
</tr>
</tbody>
</table>
B.3 Acquisition

Figure B.5 Acquisition preferences, Auto Exposure

Table B.3 Auto exposure settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Luminescent/Fluorescent Auto Exposure Preferences | During auto exposure, the software acquires a luminescent or fluorescent image so that the brightest pixel is approximately equal to the user-specified target max count.  
If the target max count cannot be closely approximated by adjusting the first preference (for example, exposure time), the software uses the first and second or first, second and third preferences to attempt to reach the target max count during image acquisition. |
| First Preference                          |                                                                                                                                          |
| Second Preference                         |                                                                                                                                          |
| Third Preference                          |                                                                                                                                          |
| Target Max Count (Minimum)                | A user-specified intensity.                                                                                                               |
| Range Values                              | The minimum and maximum values define the range of values for exposure time, F/Stop, or binning that the software can use to attempt to reach the target max count during image acquisition. |
| Exp Time (sec)                            |                                                                                                                                          |
| Binning                                   |                                                                                                                                          |
| F/Stop                                    |                                                                                                                                          |
| Restore Defaults                          | Click to apply default settings.                                                                                                          |
Figure B.6 Acquisition preferences, Camera Settings

Table B.4 Camera settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Image Exposure</td>
<td>Sets the default exposure settings that appear in the IVIS acquisition control panel.</td>
</tr>
</tbody>
</table>
| Default Image Binning | **Standard** - Binning choices include Small, Medium and Large. These are predetermined, factory-loaded binning values that depend on the imaging system camera.  
**Manual** - Allows the user to choose a binning value (1, 2, 4, or 16) |
| Auto Save             | Specifies the folder where images are automatically saved. Click the button to select a folder. |
| Restore Defaults      | Click to apply the default settings. |

B.4 Theme

Figure B.7 Image view preferences

Table B.5 Image view preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Palette</td>
<td>Use these controls to select a color table for luminescent and fluorescent image data. Choose the Reverse option to reverse the min/max colors of the selected color table.</td>
</tr>
</tbody>
</table>
Table B.5 Image view preferences (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use saved color palette while loading datasets</td>
<td>If this option is chosen, data are displayed using a user-specified color palette. For example, after you load data, specify a color table in the Image Adjust tools, and save the data. The user-specified color table is automatically applied whenever the data are loaded.</td>
</tr>
<tr>
<td>Background &amp; Text Color</td>
<td>Sets the colors for the background and text in the image window. To change a color, click the button that opens the color palette.</td>
</tr>
<tr>
<td>ROI Color</td>
<td>Sets the colors for the ROI outline. To change a color, click the button that opens the color palette.</td>
</tr>
<tr>
<td></td>
<td>Luminescent - Color of the ROI outline on a luminescent image.</td>
</tr>
<tr>
<td></td>
<td>Fluorescent - Color of the ROI outline on a fluorescent image.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>Click to apply the default settings.</td>
</tr>
</tbody>
</table>
Table B.6 3D view preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Theme</td>
<td>Predefined color schemes available for the 3D View window. Click the button to restore the defaults for the selected color theme.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Settings that modify the appearance of the background in the 3D View window.</td>
</tr>
<tr>
<td></td>
<td>Solid Color - Choose this option to apply a non-gradient background color to the 3D view in the image window.</td>
</tr>
<tr>
<td></td>
<td>Gradient Color - Choose this option to apply a gradient background color to the 3D view in the image window. Top = the color at the top of the window; Bottom = the color at the bottom of the window.</td>
</tr>
<tr>
<td>Surface &amp; Text Color</td>
<td>Settings that modify the display of the surface and text in the 3D View window.</td>
</tr>
<tr>
<td>Color Palette</td>
<td>Source voxels - Choose a color table for voxel display.</td>
</tr>
<tr>
<td></td>
<td>Reverse - Choose this option to reverse the min/max colors of the selected color table.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>Click to apply the default settings.</td>
</tr>
</tbody>
</table>
B.5 Tissue Properties

Figure B.9 Set the default tissue properties preferences (left) for the Properties tab in the Planar Spectral Imaging DLIT, or FLIT tools.

Table B.7 Tissue properties preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tissue Properties</td>
<td>Choose a default tissue type that is most representative of the area of interest. This tissue type will be used if a Subject Type is not selected in the Imaging Wizard and saved during acquisition.</td>
</tr>
<tr>
<td>Source Spectrum</td>
<td>Choose the default luminescent source. This Source Spectrum will be used if a Subject Type is not selected in the Imaging Wizard and saved during acquisition for DLIT sequences.</td>
</tr>
<tr>
<td>Plot</td>
<td>Tissue Properties - Choose this option to display a graph of the absorption coefficient ($\mu_a$), effective attenuation coefficient ($\mu_{\text{eff}}$), and reduced scattering coefficient ($\mu_s'$ or $\mu_{sp}$). Source Spectrum - Choose this option to display the source spectrum for DLIT reconstructions.</td>
</tr>
</tbody>
</table>
[This page intentionally blank.]
Appendix C  Detection Sensitivity

The parameters that control the number of photons collected (signal) and the image background (noise) determine the sensitivity of low light imaging. To maximize sensitivity, the goal is to increase signal and decrease background.

Several factors affect the number of photons collected, including the lens f/stop, image magnification, size and detection efficiency (quantum efficiency) of the CCD, transport efficiency of the imaging optics, and the image exposure time.

C.1 CCD Detection Efficiency

IVIS Imaging Systems use a back-thinned, back-illuminated CCD cooled to -90° to -105° C (depending on the system). This type of CCD provides high quantum efficiency of over 80% across the visible and near infrared part of the spectrum.

Figure C.1 shows detection efficiencies for several commonly used photon detectors. The back-illuminated CCD has the highest efficiency, particularly in the 600-800 nm region of the spectrum, the area of greatest interest for in vivo imaging.

Lens Aperture

IVIS Imaging Systems are equipped with a high-light-collection f/1 lens. The sensitivity of the IVIS Imaging System can be adjusted by changing the f/stop setting that controls the lens aperture. The detected signal scales approximately as 1/(f/stop)^2. For maximum sensitivity, select f/1, the largest aperture setting on the IVIS Imaging System (Figure C.2). This provides the greatest light collection efficiency, but results in the minimum depth of field for the image. The depth of field refers to the depth over which the image appears to be in focus and is determined by the f/stop and the field of view (FOV).

At f/1, the depth of field ranges from ~0.2 cm at FOV= 3.9 cm (IVIS Imaging System 200 Series only) to ~2 cm at FOV= 25 cm. You can use the manual focus option on the Control panel to easily assess the depth of field at any f/stop and FOV setting. For more details on...
manual focusing, see page 236. Generally f/1 is recommended for low light luminescent images and f/2 or f/4 is recommended for brighter luminescent or fluorescent images.

Image Exposure Time

The image exposure time also affects sensitivity. The number of photons collected is directly proportional to the image exposure time. For example, an image acquired over a two minute exposure contains twice as many detected photons as an image acquired over a one minute exposure. Longer exposure times are usually beneficial when imaging very dim samples. However, this may not always be true because some types of background, dark charge in particular, increase with exposure time. (For more details on backgrounds, see Appendix E, page 257.) An IVIS Imaging System has extremely low background that enables exposures of up to 30 minutes. However, animal anesthesia issues and luciferin kinetics limit practical exposure times for in vivo imaging to 5-10 minutes.

Field of View (FOV)

The FOV indirectly affects sensitivity. Changing the FOV without changing the binning or the f/stop does not significantly affect sensitivity. However, CCD pixels are effectively smaller at a smaller FOV (higher magnification) so that higher levels of binning can be applied without loss of spatial resolution.

For example, an image acquired at binning=4 and FOV=20 cm has the same spatial resolution as an image acquired at binning=8 and FOV=10 cm. Due to the increase in binning, the latter image has a four-fold increase in sensitivity compared to the former.

C.2 Binning

A charge coupled device (CCD) is a photosensitive detector constructed in a two-dimensional array of pixels. After an image is acquired, each pixel contains an electrical charge that is proportional to the amount of light that the pixel was exposed to. The software measures the electrical charge of each CCD pixel and assigns a numerical value (counts). (For more details on counts and other measurement units, see Appendix D, page 251.) The resulting image data comprise a two-dimensional array of numbers; each pixel contains the counts associated with the amount of light detected.

IVIS Imaging Systems are equipped with a CCD that ranges from 1024×1024 to 2048×2048 pixels in size, and thus have a high degree of spatial resolution. At binning=1, each pixel is read and the image size (number of pixels) is equal to the physical number of CCD pixels (Figure C.3).
At binning=2, four pixels that comprise a $2 \times 2$ group on the CCD are summed prior to read out and the total number of counts for the group is recorded (Figure C.3). This produces a smaller image that contains one fourth the pixels compared to an image at binning=1. However, due to summing, the average signal in each pixel is four times higher than at binning=1. At binning=4, 16 pixels are summed prior to read out.

Binning significantly affects the sensitivity of the IVIS Imaging System. Binning at higher levels (for example, $\geq 4$) improves the signal-to-noise ratio for read noise, an electronic noise introduced into the pixel measurement at readout. If four pixels are summed before readout, the average signal in the summed pixel (super pixel) is four times higher than at binning=1.

The read noise for the super pixel is about the same as it was for the individual pixels. Therefore, the signal-to-noise ratio for the read noise component of the image noise is improved by a factor of four. Read noise is often the dominant source of noise in in vivo images, so a high binning level is a very effective way to improve the signal-to-noise ratio.

Unfortunately, binning reduces the spatial resolution in an image. For example, at binning=2, a super pixel is twice as wide as a pixel at binning=1. This results in a factor of two loss in image spatial resolution. However, for in vivo imaging, the added sensitivity is usually more important than the spatial resolution. Further, since in vivo signals are often diffuse due to scattering in tissue, little is gained by increasing spatial resolution.

For more background on the propagation of light through tissue, see Diffusion Model of Light Propagation Through Tissue, page 278.) In such cases, high levels of binning may be appropriate (up to 10 or 16, depending on the CCD of the IVIS Imaging System). If signal levels are high enough that sensitivity is not an issue, then it is better to image at a lower binning level (two or four) in order to maintain a higher degree of spatial resolution.

NOTE
For application-specific questions regarding the appropriate binning level, please contact Caliper Corporation.

The IVIS System Control panel provides several binning options. The actual binning numbers associated with these settings depends on the CCD chip and type of image (Table C.1). These choices should satisfy most user needs. However, if you want to manually control binning, you can specify Manual Binning in the Living Image Tools-Preference-Camera Settings box.
You can also apply soft binning after an image is acquired. Conceptually, soft binning is the same as hardware binning—groups of pixels are summed and a smaller, lower resolution image is produced. However, in soft binning the summing is performed digitally on the stored image data, not on the electronic charge before readout as in hardware binning.

Although soft binning does not improve the signal-to-noise ratio for read noise, it may enhance the signal visibility because it reduces the statistical scatter of nearby pixel contents. Usually, hardware binning is preferred, but if it is not possible to take another image, applying soft binning to the data may provide a worthwhile solution.

### C.3 Smoothing

Smoothing is a filtering method that reduces noise in the image data. To apply smoothing, the software replaces the intensity of each pixel with the average intensity of a nearby pixel neighborhood that includes the pixel. Figure C.4 shows a 3x3 pixel neighborhood.

Smoothing does not change the pixel size and helps:

- Eliminate outlier pixel values that are extremely high or low.
- Reduce noise (fluctuations) in the image to help reveal small signals.

<table>
<thead>
<tr>
<th>Binning</th>
<th>EEV</th>
<th>ROPER</th>
<th>SiTe</th>
<th>Andor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medium Lumin</td>
<td>Bin 8</td>
<td>Bin 5</td>
<td>Bin 4</td>
<td>Bin 4</td>
</tr>
<tr>
<td>Small (high-resolution) Lumin</td>
<td>Bin 4</td>
<td>Bin 2</td>
<td>Bin 2</td>
<td>Bin 2</td>
</tr>
<tr>
<td>Large (high-sensitivity) Lumin</td>
<td>Bin 16</td>
<td>Bin 10</td>
<td>Bin 8</td>
<td>Bin 8</td>
</tr>
<tr>
<td>Medium Photo</td>
<td>Bin 4</td>
<td>Bin 2</td>
<td>Bin 2</td>
<td>Bin 2</td>
</tr>
<tr>
<td>Small (high-resolution) Photo</td>
<td>Bin 2</td>
<td>Bin 1</td>
<td>Bin 1</td>
<td>Bin 1</td>
</tr>
</tbody>
</table>

**Figure C.4** 3x3 pixel neighborhood

Center pixel value = the mean value of the nine pixels in the 3x3 neighborhood
Appendix D   Image Data Display & Measurement

D.1 Image Data

Scientific Image Data

Scientific image data is a two-dimensional array of numbers. Each element of the array \((\text{pixel})\) is associated with a number that is proportional to the light intensity on the element. A charge coupled device (CCD) camera used for scientific imaging is essentially an array of photo-sensitive pixels and each pixel collects photons during an image exposure.

The subsequent electronic readout provides a photon intensity number associated with each pixel. In a bright area of the image, more photons are detected and the photon intensity number is greater than the number in a dim area of the image.

The image data can be visualized in different ways, including pseudocolor images (generated by the Living Image software), contour plots, or isometric displays.

Graphic Image Data

A graphic image is a two-dimensional array of pixels with a color assigned to each pixel. There are several schemes for digitally storing the images. For example, a common scheme assigns a red-green-blue (RGB) color code to each pixel. The RGB code defines how much of each color to apply in order to create the final pixel color. Color photographs or color screenshots are examples of RGB images.

An RGB image is also a two-dimensional array of numbers, but unlike a scientific image, the numbers are only color codes and are not related to light intensity. A graphic image can be exported to a graphic display application.

Pseudocolor Images

An image can be generated from scientific image data by assigning a color to each numerical value and plotting the array so that each pixel is filled with the color that corresponds to its numerical value. A color table defines the relationship between the numerical data and the displayed color. For example, a grayscale color table assigns black to the smallest number in the array, white to the largest number, and shades of gray to the values in between (Figure D.1). The resulting image is equivalent to a black and white photograph. An illuminated photographic image acquired on an IVIS Imaging System is an example of a grayscale pseudoimage.

The reverse rainbow color table is also commonly used and assigns violet to the smallest number on the array, red to the largest number, and all of the spectral colors of the rainbow to the values in between (Figure D.1).
A pseudocolor scheme is typically used to display the numerical contents of scientific image data like the luminescent or fluorescent images acquired on an IVIS Imaging System. The pseudocolor scheme makes it easy to see areas of bright light emission. The amount of light emission can be quantified using measurement ROIs. (For more details, page 112.)

Measurement data is independent of the colors displayed in the pseudocolor image. You can change the appearance of the image data without affecting the underlying numeric pixel values. For example, you apply a different color table to the data or adjust the range of numeric values associated with the color table. Measurements that quantify pixel data produce the same results independent of the appearance of the pseudocolor display.

A pseudocolor image can be converted to an RGB color code and saved as an RGB image. The RGB image looks like a pseudocolor image, but does not include the numerical information derived from the light detected in each pixel. Therefore, the amount of light in an RGB image cannot be quantified.

Overlays

In the overlay display mode, the pseudocolor luminescent or fluorescent image is displayed on the associated grayscale photographic image (Figure D.1). Pixels in the luminescent or fluorescent image that are less than the minimum color table setting are not displayed. As a result, the lowest intensity color in the table is transparent and this enables you to view the underlying photographic image in regions where the luminescent light emission is low.

Figure D.1 Example pseudoimages
D.2 Quantifying Image Data

The Living Image software can quantify and display scientific image data several types of measurements.

Table D.1 Data display units

<table>
<thead>
<tr>
<th>Data Display</th>
<th>Description</th>
<th>Recommended For:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counts</td>
<td>An uncalibrated measurement of the photons incident on the CCD camera.</td>
<td>Image acquisition to ensure that the camera settings are properly adjusted.</td>
</tr>
<tr>
<td>Radiance (photons)</td>
<td>A calibrated measurement of the photon emission from the subject.</td>
<td>Luminescent measurements</td>
</tr>
</tbody>
</table>
| Radiant Efficiency (fluorescence) | Epi-fluorescence - A fluorescence emission radiance per incident excitation power.  
                                    | Transillumination fluorescence - Fluorescence emission radiance per incident excitation power |
| Efficiency (epi-fluorescence) | Fluorescent emission normalized to the incident excitation intensity (radiance of the subject/illumination intensity) | Epi-fluorescent measurements                                                     |
| NTF Efficiency     | Fluorescent emission image normalized to the transmission image which is measured with the same emission filter and open excitation filter. | Transillumination fluorescent measurements                                       |

Counts

When image data is displayed in counts, the image pixel contents are displayed as the numerical output of the charge digitizer on the charge coupled device (CCD) (Figure D.2). The counts measurement (also known as analog digitizer units (ADU) or relative luminescence units (RLU)) is proportional to the number of photons detected in a pixel.

Counts are uncalibrated units that represent the raw amplitude of the signal detected by the CCD camera. A signal measured in counts is related to the photons incident on the CCD camera. The signal varies, depending on the camera settings (for example, integration time, binning, f/stop, or field of view setting).

All IVIS Imaging Systems include a CCD digitizer that is a 16-bit device, which means that the signal count range is from zero to 65,535. Sometimes the displayed signal count may appear outside of this range due to corrections applied to the image data (for example, background corrections).
When image data is displayed in photons, the photon emission from the subject or radiance is displayed in photons/sec/cm²/sr. Counts are a relative measure of the photons incident on the CCD camera and photons are absolute physical units that measure the photon emission from the subject.

The radiance unit of photons/sec/cm²/sr is the number of photons per second that leave a square centimeter of tissue and radiate into a solid angle of one steradian (sr) (Figure D.3).

**Figure D.2** ROI measurements (counts mode)

**Photons**

When image data is displayed in photons, the photon emission from the subject or radiance is displayed in photons/sec/cm²/sr. Counts are a relative measure of the photons incident on the CCD camera and photons are absolute physical units that measure the photon emission from the subject.

The radiance unit of photons/sec/cm²/sr is the number of photons per second that leave a square centimeter of tissue and radiate into a solid angle of one steradian (sr) (Figure D.3).

**Figure D.3** Isotropic radiation

Isotropic radiation from a cell is called photon flux (photons/sec). When cells occur in tissue, photon emission from the tissue surface is called surface radiance (photons/sec/cm²/sr).
A steradian can be thought of as a three-dimensional cone of light emitted from the surface that has a unit solid angle. Much like a radian is a unit of arc length for a circle, a steradian is a unit of solid angle for a sphere. An entire sphere has $4\pi$ steradians. Lens systems typically collect light from only a small fraction of the total $4\pi$ steradians.

When image data is displayed in photons mode, the units change to photons/sec/cm²/sr. These are units of photon radiance on the surface of the animal. A very important distinction between these absolute physical units and the relative units of counts is that the radiance units refer to photon emission from the subject animal itself, as opposed to counts that refers to photons incident on the detector.

Measurements in units of radiance automatically take into account camera settings (for example, integration time, binning, f/stop, and field of view). As a result, images of the same subject acquired during the same session have the same signal amplitude regardless of the camera settings because the radiance on the animal surface does not change. The advantage of working with image data in photons mode is that camera settings can be changed during an experiment without having to adjust the images or the measured ROI data. Images or ROI data can be quantitatively compared across different IVIS Imaging Systems.

Caliper Corporation calibrates the camera settings of each IVIS Imaging System at 600 nm. The response of the CCD is relatively flat (~10%) over the range from 500-700 nm which includes the spectral variation found in bacterial or firefly luciferase. Therefore, calibration is accurate over this range.

### Efficiency

The fluorescent signal detected from a sample depends on the amount of fluorophore present in the sample and the intensity of the incident excitation light. The excitation light incident on the sample stage is not uniform over the field of view (FOV). At FOV=10, there is a slightly dished illumination profile due to the close proximity of the stage to the illumination reflectors, while the profiles for the other stage locations are peaked near their center. The illumination intensity profile varies by up to ±30% across the entire FOV (Figure D.4).

![Figure D.4 Illumination profiles at different FOVs](image)

Measurements were taken at the center of the FOV on the IVIS Imaging System 100 Series.

Displaying fluorescent image data in terms of efficiency eliminates the variable excitation light from the measurement and enables a more quantitative comparison of fluorescent signals. When you select efficiency for the image data (Figure D.2), the software normalizes the fluorescent emission image to a reference image and computes:

\[
\text{Efficiency} = \frac{\text{Radiance of the subject}}{\text{Illumination intensity}}
\]
Prior to instrument delivery, Caliper Life Sciences generates a reference image of the excitation light intensity (no emission filter) incident on a highly reflective white plate for each excitation filter at every FOV and lamp power. The data are stored in the Living Image folder.

Image efficiency data does not have units. The efficiency number for each pixel represents the fraction of fluorescent photons relative to each incident excitation photon and is typically in the range of $10^{-2}$ to $10^{-9}$. When ROI measurements are made, the total efficiency within the ROI is the efficiency per pixel integrated over the ROI area, so the resulting units of total efficiency is area or cm$^2$.

**D.3 Flat Fielding**

Flat fielding refers to the uniformity of light collected across the field of view (FOV). A lens usually collects more light from the center of the FOV than at the edges. The Living Image software provides a correction algorithm to compensate for the variation in the collection efficiency of the lens. This enables uniform quantitation of ROI measurements across the entire FOV.

To apply the correction algorithm, choose the Flat Field Correction option in the Corrections/Filtering tools. The algorithm multiplies each pixel by a predetermined scale factor. The scale factor for each pixel depends on its distance from the center of the image. The scale factor near the center of the field of view is one, but can be up to two or three near the corners on the IVIS Imaging System 100 Series. (The IVIS Imaging System 200 Series has a larger lens with a smaller flat field correction.)

You may notice an increase in noise near the edges and corners of the FOV when flat field correction is applied—this is normal.

**D.4 Cosmic Ray Corrections**

Cosmic rays are extraterrestrial high-energy particles that register a false signal on a CCD detector. Cosmic rays as well as other sources of ionizing radiation cause infrequent interactions (a few per minute) on the CCD. These interactions result in large signals that are usually isolated to a single pixel, making them easy to correct.

The Living Image software searches for isolated, high amplitude *hot pixels* and replaces them with a collective average of surrounding pixels. The Cosmic Correction option should always be selected for *in vivo* image data because hot pixels can significantly affect an ROI measurement.

Cosmic ray correction is not recommended when imaging very small objects such as individual cells. An individual cell may only light up one or two pixels and can sometimes be misinterpreted as a cosmic ray. In this case, clear the Cosmic Correction option in the Corrections/Filtering tools to avoid filtering out single-cell images.
Appendix E  Luminescent Background Sources & Corrections

The background sources of light from luminescent images are inherently very low. This appendix discusses sources of background and how to manage them. Due to the extreme sensitivity of the IVIS Imaging System, residual electronic background (dark current) and luminescent emission from live animals (autoluminescence) are measurable and must be taken into account.

For information on fluorescent background, see Appendix F, page 269.

E.1 Electronic Background

The cooled CCD camera used in an IVIS Imaging System has electronic background that must be accurately measured and subtracted from the image data before the light intensity is quantified. Raw data that is not corrected for electronic background results in erroneous ROI measurements. Incorrect background subtraction may also result in serious errors. However, it is not necessary to subtract the electronic background when making a simple visual inspection of an image.

The types of electronic background include:

- **Read bias** - An electronic offset that exists on every pixel. This means that the zero photon level in the readout is not actually zero, but is typically a few hundred counts per pixel. The read bias offset is reproducible within errors defined by the read noise, another quantity that must be determined for quantitative image analysis.

- **Dark current** - Electronic background generated by the thermal production of charge in the CCD. To minimize dark current, the CCD is cooled during use.

**Read Bias & Drift**

Prior to a luminescent image exposure, the Living Image software initiates a series of zero-time exposures (image readout) to determine a read bias measurement.

If a dark charge background is available for the luminescent image, the average bias offset for the read bias image stored with the dark charge measurement is compared to the average bias offset determined with the read bias measurement made prior to the image. The difference, or drift correction, is stored with the luminescent image data, and is later used to correct minor drift (typically less than two counts/pixel) that may occur in the bias offset since measuring the dark charge background.

If a dark charge background is not available at the time of the luminescent image exposure, the software checks to see if the selected image parameters warrant a dark charge measurement (large binning and long exposure time). If a dark charge image is not required, the read bias will be used. If a dark charge is recommended, the software provides the option of using the read bias measurement instead. Since the read bias is by far the largest component of background, using a read bias measurement instead of a dark charge measurement is often acceptable. If read bias is used instead of a dark charge background, the read bias image is stored with the image data rather than the usual background information.
If the amount of dark charge associated with an image is negligible, read bias subtraction is an adequate substitute for dark charge background subtraction. Dark charge increases with exposure time and is more significant at higher levels of binning. A good rule of thumb is that dark charge is negligible if:

\[ \tau B^2 < 1000 \]

where \( \tau \) is the exposure time (seconds) and \( B \) is the binning factor.

Under these conditions, dark charge contributes less than 0.1 counts/pixel and may be ignored.

**Dark Charge**

_Dark charge_ refers to all types of electronic background, including dark current and read bias. Dark charge is a function of the exposure time, binning level, and camera temperature. A dark charge measurement should be taken within 48 hours of image acquisition and the system should remain stable between dark charge measurement and image acquisition. If the power to the system or camera controller (a component of some IVIS Imaging Systems) has been cycled or if the camera temperature has changed, a new dark charge measurement should be taken.

The dark charge is measured with the camera shutter closed and is usually performed automatically overnight by the Living Image software. The software acquires a series of zero-time exposures to determine the bias offset and read noise, followed by three dark exposures. The dark charge measurement usually takes more than three times as long to complete as the equivalent luminescent exposure.

**E.2 Background Light On the Sample**

An underlying assumption for _in vivo_ imaging is that all of the light detected during a luminescent image exposure is emitted by the sample. This is not accurate if there is an external light source illuminating the sample. Any reflected light will be detected and is indistinguishable from emission from the sample.

The best way to deal with external light is to physically eliminate it. There are two potential sources of external light: a light leak through a crack or other mechanical imperfection in the imaging chamber or a source of external illumination.

IVIS Imaging Systems are designed to be extremely light tight and are thoroughly checked for light leaks before and after installation. Light leaks are unlikely unless mechanical damage has occurred. To ensure that there are no light leaks in the imaging chamber, conduct an imaging test using the High Reflectance Hemisphere (Figure E.1).

A more subtle source of external illumination is the possible presence of light emitting materials inside the imaging chamber. In addition to obvious sources such as the light emitting diodes (LEDs) of electronic equipment, some materials contain phosphorescent compounds.

_Do not place equipment that contains LEDs in the imaging chamber._

Phosphorescence is a physical process similar to fluorescence, but the light emission persists for a longer period. Phosphorescent materials absorb light from an external source (for example, room lights) and then re-emit it. Some phosphorescent materials may re-
emit light for many hours. If this type of material is introduced into the imaging chamber, it produces background light even after the chamber door is closed. If the light emitted from the phosphorescent material illuminates the sample from outside of the field of view during imaging, it may be extremely difficult to distinguish from the light emitted by the sample.

IVIS Imaging Systems are designed to eliminate background interference from these types of materials. Each system is put through a rigorous quality control process to ensure that background levels are acceptably low. However, if you introduce such materials inadvertently, problems may arise.

Problematic materials include plastics, paints, organic compounds, plastic tape, and plastic containers. Contaminants such as animal urine can be phosphorescent. To help maintain a clean imaging chamber, place animal subjects on black paper (for example, Artagain black paper, Strathmore cat. no. 445-109) and change the paper frequently. Cleaning the imaging chamber frequently is also helpful.

**IMPORTANT**

**ALERT!** Use only cleaning agents approved by Caliper. Many cleaning compounds phosphoresce! Contact Caliper technical support for a list of tested and approved cleaning compounds.

If it is necessary to introduce suspect materials into the imaging chamber, screen the materials by imaging them. Acquire an image of the material alone using the same settings (for example, FOV and exposure time) that will be used to image the sample to determine if the material is visible in the luminescent image.

Microplates (white, black, or clear plastic) can be screened this way. Screen all three types with a test image. White plates appear extremely bright by IVIS Imaging System standards and interfere with measurements. Black or clear plastic microplates do not phosphoresce, making them better choices.

The High Reflectance Hemisphere provides a more definitive way to determine the presence of an undesirable light source (Figure E.1). It is a small white hemisphere that is coated with a non-phosphorescent material. A long exposure image of the hemisphere should produce a luminescent image in which the hemisphere is not visible.

![Figure E.1](image)

**Figure E.1** High Reflectance Hemisphere and a plastic marker pen

Left: Photographic image. Right: Photograph with luminescent overlay. The hemisphere is illuminated by phosphorescence emitted from the pen.

If any part of the hemisphere exhibits what appears to be luminescent emission, it is actually the light reflected from a source illuminating the hemisphere. Observe the side of the hemisphere that is illuminated to help determine the source location.

In Figure E.1, the pen appears very bright due to phosphorescent emission that is also illuminating the portion of the hemisphere next to the pen. If the pen had been outside the
field of view, it would not have been imaged, and the source of the phosphorescence would be less obvious. However, the illumination of the hemisphere would still be very apparent and indicative of a light pollution problem.

**IMPORTANT**

**ALERT!** Handle the High Reflectance Hemisphere by its black base plate while wearing cotton gloves provided by Caliper. Skin oils can phosphoresce and will contaminate the hemisphere. Latex gloves and the powder on them may also phosphoresce. If the hemisphere becomes contaminated, contact Caliper technical support for a replacement. There are no known agents that can clean the hemisphere. To check the hemisphere for contamination, take several images of the hemisphere, rotating it slightly between images. A glowing fingerprint, for example, will rotate with the hemisphere, while a glowing spot due to external illumination most likely will not.

### E.3 Background Light From the Sample

Another source of background is the natural light emitted from a sample that is not due to emission from the source of interest in the sample. This type of background may be due to a material associated with the experimental setup. For example, the cell culture medium may phosphoresce. Materials should be screened so you can identify and eliminate problematic materials. If a background source is phosphorescent and the phosphorescent lifetime is relatively short, you can try keeping the sample in the dark for a long period before imaging to reduce background light emission.

Occasionally there is no way to eliminate the natural light emission of the sample. The natural light emission associated with living animals (*autoluminescence*) is a major area of interest in *in vivo* luminescent imaging. Most animals exhibit a low level of autoluminescence. Usually this is only a problem when looking for very low signals at the highest levels of sensitivity.

Caliper has conducted tests to try to minimize the source of the background light emission in mice.

<table>
<thead>
<tr>
<th>Test Description</th>
<th>Observation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test 1: Subject animals were housed in the dark 12 hours prior to imaging.</td>
<td>Background emission levels were not reduced. A phosphorescent component in mouse fur or skin is not the source of light emission.</td>
</tr>
<tr>
<td>Test 2: White-furred animals were shaved prior to imaging</td>
<td>No increase or decrease in background emission levels.</td>
</tr>
<tr>
<td>Test 3: Alfalfa (known to be phosphorescent) was eliminated from the animal diet.</td>
<td>An alfalfa-free diet reduced background emission slightly, but not significantly.</td>
</tr>
</tbody>
</table>

The sources of autoluminescence are not yet fully understood. No external sources have been proven to cause natural light emissions, so it is possible that a chemiluminescent process associated with metabolic activity in living animals is the source of animal background. This is supported by the observation that the level of background light drops significantly in euthanized animals.

In Figure E.2, the background light emission is clearly visible in the images of a control white-furred mouse and a nude mouse. The images are five minute, high-sensitivity (high binning) exposures. The average emission from a white-furred mouse and a nude mouse is approximately 1600 photons/s/cm²/sr and 1000 photons/s/cm²/sr, respectively. Since these values are well above the lower limit of detection of the IVIS Imaging System (~100
photons/s/cm²/sr), the background light emission from the mouse determines the limit of detection.

An approximation of this background (determined by making similar measurements on either control animals or regions of the subject animal that do not contain the primary signal) can be subtracted from ROI measurements. (For more information on ROI measurements, see Chapter 8, page 120.)

Note that the background light emission is not uniform over the entire animal. In Figure E.2, images of control animals (mice) show a somewhat higher background component originating from the abdominal and thoracic regions. Therefore, care must be taken when selecting a representative background area.

![Figure E.2 Background light emission](image)

Background light emission from a female white furred (Swiss Webster) (left) and a female nude (Nu/nu) mouse (right).

Usually only very low signals at the highest level of sensitivity require this type of background subtraction. For more information on how best to handle these types of measurements, please contact Caliper technical support.
F.1 Description and Theory of Operation

System Components

The IVIS Imaging System 200 Series and IVIS Lumina offer built-in fluorescence imaging capability as standard equipment. The IVIS Imaging System 100 and 50 Series use the XFO-6 or XFO-12 Fluorescence Option to perform fluorescence imaging. The fluorescence equipment enables you to conveniently change between luminescent and fluorescent imaging applications (Figure F.1). For more details, see the IVIS Imaging System 200 Series System Manual, the IVIS Lumina System Manual, or the XFO-6 or XFO-12 Fluorescence Option Manual.

A 150-watt quartz tungsten halogen (QTH) lamp with a dichroic reflector provides light for fluorescence excitation. The relative spectral radiance output of the lamp/reflectors combination provides high emission throughout the 400-950 nm wavelength range (Figure F.2). The dichroic reflector reduces infrared coupling (>700 nm) to prevent overheating of the fiber-optic bundles, but allows sufficient infrared light throughput to enable imaging at these wavelengths. The Living Image software controls the illumination...
intensity level (off, low, or high). The illumination intensity at the low setting is approximately 18% that of the high setting.

![Quartz Halogen Lamps with Dichroic Reflectors](image)

**Figure F.2** Relative spectral radiance output for the quartz halogen lamp with dichroic reflector.

The lamp output is delivered to the excitation filter wheel assembly located at the back of the IVIS Imaging System (**Figure F.3**). Light from the input fiber-optic bundle passes through a collimating lens followed by a 25 mm diameter excitation filter. The IVIS Imaging System provides a 12-position excitation filter wheel, allowing you to select from up to 11 fluorescent filters (five filters on older systems). A light block is provided in one filter slot for use during luminescent imaging to prevent external light from entering the imaging chamber. The Living Image software manages the motor control of the excitation filter wheel.

![Excitation filter wheel cross section](image)

**Figure F.3** Excitation filter wheel cross section.

Following the excitation filter, a second lens focuses light into a 0.25 inch fused silica fiber-optic bundle inside the imaging chamber. Fused silica fibers (core and clad), unlike ordinary glass fibers, prevent the generation of autofluorescence.

The fused silica fiber bundle splits into four separate bundles that deliver filtered light to four reflectors in the ceiling of the imaging chamber (**Figure F.1**). The reflectors provide a diffuse and relatively uniform illumination of the sample stage. Analyzing image data in terms of efficiency corrects for nonuniformity in the illumination profile. When the efficiency mode is selected, the measured fluorescent image is normalized to a reference illumination image. (For more details on efficiency, see page 255.)

The emission filter wheel at the top of the imaging chamber collects the fluorescent emission from the target fluorophore and focuses it into the CCD camera. All IVIS Imaging Systems require that one filter position on each wheel always be open for luminescent imaging.
F.2 Filter Spectra

High quality filters are essential for obtaining good signal-to-background levels (contrast) in fluorescence measurements, particularly in highly sensitive instruments such as the IVIS Imaging Systems. Figure F.4 shows typical excitation and emission fluorophore spectra, along with idealized excitation and emission filter transmission curves. The excitation and emission filters are called bandpass filters. Ideally, bandpass filters transmit all of the wavelengths within the bandpass region and block (absorb or reflect) all wavelengths outside the bandpass region. This spectral band is like a window, characterized by its central wavelength and its width at 50% peak transmission, or full width half maximum. Figure F.5 shows filter transmission curves of a more realistic nature.

Because the filters are not ideal, some leakage (undesirable light not blocked by the filter but detected by the camera) may occur outside the bandpass region. The materials used in filter construction may also cause the filters to autofluoresce.

![Diagram of excitation and emission spectra](image)

**Figure F.4** Typical excitation and emission spectra for a fluorescent compound. The graph shows two idealized bandpass filters that are appropriate for this fluorescent compound.
In Figure F.5, the vertical axis is optical density, defined as $OD = -\log(T)$, where $T$ is the transmission. An $OD=0$ indicates 100% transmission and $OD=7$ indicates a reduction of the transmission to $10^{-7}$.

For the high quality interference filters in the IVIS Imaging Systems, transmission in the bandpass region is about 0.7 ($OD=0.15$) and blocking outside of the bandpass region is typically in the $OD=7$ to $OD=9$ range. The band gap is defined as the gap between the 50% transmission points of the excitation and emission filters and is usually 25-50 nm.

There is a slope in the transition region from bandpass to blocking (Figure F.5). A steep slope is required to avoid overlap between the two filters. Typically, the slope is steeper at shorter wavelengths (400-500 nm), allowing the use of narrow band gaps of 25 nm. The slope is less steep at infrared wavelengths (800 nm), so a wider gap of up to 50 nm is necessary to avoid cross talk.

### Fluorescent Filters and Imaging Wavelengths

Eight excitation and four emission filters come standard with a fluorescence-equipped IVIS Imaging System (Table F.1). Custom filter sets are also available. Fluorescent imaging on the IVIS Imaging System uses a wavelength range from 400-950 nm, enabling a wide range of fluorescent dyes and proteins for fluorescent applications.

For *in vivo* applications, it is important to note that wavelengths greater than 600 nm are preferred. At wavelengths less than 600 nm, animal tissue absorbs significant amounts of light. This limits the depth to which light can penetrate. For example, fluorophores located deeper than a few millimeters are not excited. The autofluorescent signal of tissue also increases at wavelengths less than 600 nm.

### Table F.1 Standard filter sets and fluorescent dyes and proteins used with IVIS Imaging Systems

<table>
<thead>
<tr>
<th>Name</th>
<th>Excitation Passband (nm)</th>
<th>Emission Passband (nm)</th>
<th>Dyes &amp; Passband</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFP</td>
<td>445-490</td>
<td>515-575</td>
<td>GFP, EGFP, FITC</td>
</tr>
<tr>
<td>DsRed</td>
<td>500-550</td>
<td>575-650</td>
<td>DsRed2-1, PKH26, CellTracker™ Orange</td>
</tr>
<tr>
<td>Cy5.5</td>
<td>615-665</td>
<td>695-770</td>
<td>Cy5.5, Alexa Fluor® 660, Alexa Fluor® 680</td>
</tr>
<tr>
<td>ICG</td>
<td>710-760</td>
<td>810-875</td>
<td>Indocyanine green (ICG)</td>
</tr>
<tr>
<td>GFP Background</td>
<td>410-440</td>
<td>Uses same as GFP</td>
<td>GFP, EGFP, FITC</td>
</tr>
<tr>
<td>DsRed Background</td>
<td>460-490</td>
<td>Uses same as DsRed</td>
<td>DsRed2-1, PKH26, CellTracker™ Orange</td>
</tr>
<tr>
<td>Cy5.5 Background</td>
<td>580-610</td>
<td>Uses same as Cy5.5</td>
<td>Cy5.5, Alexa Fluor® 660, Alexa Fluor® 680</td>
</tr>
</tbody>
</table>
**Appendix F | Fluorescent Imaging**

**F.3 Working with Fluorescent Samples**

There are a number of issues to consider when working with fluorescent samples, including the position of the subject on the stage, leakage and autofluorescence, background signals, and appropriate signal levels and f/stop settings.

**Tissue Optics Effects**

In *in vivo* fluorescence imaging, the excitation light must be delivered to the fluorophore inside the animal for the fluorescent process to begin. Once the excitation light is absorbed by the fluorophore, the fluorescence is emitted. However, due to the optical characteristics of tissue, the excitation light is scattered and absorbed before it reaches the fluorophore as well as after it leaves the fluorophore and is detected at the animal surface (Figure F.6).

The excitation light also causes the tissue to autofluoresce. The amount of autofluorescence depends on the intensity and wavelength of the excitation source and the type of tissue. Autofluorescence can occur throughout the animal, but is strongest at the surface where the excitation light is strongest.

![Figure F.6](image)

**Figure F.6** Illustration of the *in vivo* fluorescence process.

At 600-900 nm, light transmission through tissue is highest and the generation of autofluorescence is lower. Therefore it is important to select fluorophores that are active in the 600-900 nm range. Fluorophores such as GFP that are active in the 450-600 nm range will still work, but the depth of detection may be limited to within several millimeters of the surface.

**Specifying Signal Levels and f/stop Settings**

Fluorescent signals are usually brighter than luminescent signals, so imaging times are shorter, typically from one to 30 seconds. The bright signal enables a lower binning level that produces better spatial resolution. Further, the f/stop can often be set to higher values; f/2 or f/4 is recommended for fluorescence imaging. A higher f/stop improves the depth of field, yielding a sharper image. For more details on the f/stop, see *Lens Aperture, page 247.*
F.4 Image Data Display

Fluorescent image data can be displayed in units of counts or photons (absolute, calibrated), or in terms of efficiency (calibrated, normalized). For more details, see Quantifying Image Data, page 253.

If the image is displayed in photons, you can compare images with different exposure times, f/stop setting, or binning level. When an image is displayed in terms of efficiency, the fluorescent image is normalized against a stored reference image of the excitation light intensity. Efficiency image data is without units and represents the ratio of emitted light to incident light. For more details on efficiency, see page 255.

Fluorescent Efficiency

The detected fluorescent signal depends on the amount of fluorophore present in the sample and the intensity of the incident excitation light. At the sample stage, the incident excitation light is not uniform over the FOV. It peaks at the center of the FOV and drops off slowly toward the edges (Figure F.7). To eliminate the excitation light as a variable from the measurement, the data can be displayed in terms of efficiency (Figure F.8).

**Figure F.7** Illumination profiles for different FOVs on an IVIS Imaging System 100 Series measured from the center of the FOV.

**Figure F.8** Fluorescent image data displayed in terms of radiant efficiency
When efficiency is selected, the fluorescent image data is normalized (divided) by a stored, calibrated reference image of the excitation light intensity incident on a highly reflective white plate. The resulting image data is without units, typically in the range of $10^{-2}$ to $10^{-9}$.

**NOTE**

On each IVIS Imaging System, a reference image of the excitation light intensity is measured for each excitation filter at every FOV and lamp power. The reference images are measured and stored in the Living Image folder prior to instrument delivery.

### F.5 Fluorescent Background

**Autofluorescence**

Autofluorescence is a fluorescent signal that originates from substances other than the fluorophore of interest and is a source of background. Almost every substance emits some level of autofluorescence. Autofluorescence may be generated by the system optics, plastic materials such as microplates, and by animal tissue. Filter leakage, which may also occur, is another source of background light.

The optical components of the IVIS Imaging Systems are carefully chosen to minimize autofluorescence. Pure fused silica is used for all transmissive optics and fiber optics to reduce autofluorescence. However, trace background emissions exist and set a lower limit for fluorescence detection.

To distinguish real signals from background emission, it is important to recognize the different types of autofluorescence. The following examples illustrate sources of autofluorescence, including microplates, other materials, and animal tissue.

**Microplate Autofluorescence**

When imaging cultured cells marked with a fluorophore, be aware that there is autofluorescence from the microplate as well as native autofluorescence of the cell.

**Figure F.9** shows autofluorescence originating from four different plastic microplates. The images were taken using a GFP filter set (excitation 445-490nm, emission 515-575nm).
Two types of autofluorescent effects may occur:

- **Overall glow of the material** - Usually indicates the presence of autofluorescence.
- **Hot spots** - Indicates a specular reflection of the illumination source (Figure F.10). The specular reflection is an optical illumination autofluorescence signal reflecting from the microplate surface and is not dependent on the microplate material.

Black polystyrene microplates are recommended for *in vitro* fluorescent measurements. Figure F.9 and Figure F.10 show that the black polystyrene microplate emits the smallest inherent fluorescent signal, while the white polystyrene microplate emits the largest signal. The clear polystyrene microplate has an autofluorescent signal that is slightly higher than that of the black microplate, but it is still low enough that this type of microplate may be used.

Control cells are always recommended in any experiment to assess the autofluorescence of the native cell.
Miscellaneous Material Autofluorescence

It is recommended that you place a black Lexan® sheet (Caliper part no. 60104) on the imaging stage to prevent illumination reflections and to help keep the stage clean.

NOTE
The black paper recommended for luminescent imaging (Swathmore, Artagain, Black, 9”x12”, Caliper part no. 445-109) has a measurable autofluorescent signal, particularly with the Cy5.5 filter set.

Figure F.11 shows a fluorescent image of a sheet of black Lexan on the sample stage, as seen through a GFP filter set. The image includes optical autofluorescence, light leakage, and low level autofluorescence from inside the IVIS® System imaging chamber. The ring-like structure is a typical background autofluorescence/leakage pattern. The image represents the minimum background level that a fluorophore signal of interest must exceed in order to be detected.

![Figure F.11 Light from black Lexan](image)
This image shows the typical ring-like structure of light from a sheet of black Lexan, a low autofluorescent material that may be placed on the imaging stage to prevent illumination reflections. (Imaging parameters: GFP filter set, Fluorescence level High, Binning=16, FOV=18.6, f/2, Exp=5sec.)

Other laboratory accessories may exhibit non-negligible autofluorescence. The chart in Figure F.12 compares the autofluorescence of miscellaneous laboratory materials to that of black Lexan. For example, the autofluorescence of the agar plate with ampicillin is more than 180 times that of black Lexan. Such a significant difference in autofluorescence levels further supports the recommended use of black polystyrene well plates.

NOTE
It is recommended that you take control measurements to characterize all materials used in the IVIS Imaging System.
Despite the presence of various background sources, the signal from most fluorophores exceeds background emissions. Figure F.13 shows the fluorescent signal from a 96-well microplate fluorescent reference standard (TR 613 Red) obtained from Precision Dynamics Co. Because the fluorescent signal is significantly bright, the background autofluorescent sources are not apparent.

Animal Tissue Autofluorescence

Animal tissue autofluorescence is generally much higher than any other background source discussed so far and is likely to be the most limiting factor in in vivo fluorescent imaging. Figure F.14 shows ventral images of animal tissue autofluorescence for the GFP, DsRed, Cy5.5, and ICG filter set in animals fed regular rodent food and alfalfa-free rodent food (Harlan Teklad, TD97184). Animals fed the regular rodent diet and imaged using the GFP and DsRed filter sets, show uniform autofluorescence, while images taken with the Cy5.5 and ICG filter sets show the autofluorescence is concentrated in the intestinal area.

The chlorophyll in the regular rodent food causes the autofluorescence in the intestinal area. When the animal diet is changed to the alfalfa-free rodent food, the autofluorescence
in the intestinal area is reduced to the levels comparable to the rest of the body. In this situation, the best way to minimize autofluorescence is to change the animal diet to alfalfa-free rodent food when working with the Cy5.5 and ICG filter sets. Control animals should always be used to assess background autofluorescence.

Figure F.14 Images of animal tissue autofluorescence in control mice (Nu/nu females) Animals were fed regular rodent food (top) or alfalfa-free rodent food (bottom). Images were taken using the GFP, DsRed, Cy5.5, or ICG filter set. The data is plotted in efficiency on the same log scale.

Figure F.15 shows a comparison of fluorescence and luminescence emission in vivo. In this example, $3 \times 10^6$ PC3M-luc/DsRed prostate tumor cells were injected subcutaneously into the lower back region of the animal. The cell line is stably transfected with the firefly luciferase gene and the DsRed2-1 protein, enabling luminescent and fluorescent expression. The fluorescence signal level is 110 times brighter than the luminescence signal. However, the autofluorescent tissue emission is five orders of magnitude higher. In this example, fluorescent imaging requires at least $3.8 \times 10^5$ cells to obtain a signal above tissue autofluorescence while luminescent imaging requires only 400 cells.

Figure F.15 Fluorescent (left) and luminescent (right) images of stably transfected, dual-tagged PC3M-luc DsRed cells. The images show the signal from a subcutaneous injection of $3 \times 10^6$ cells in an 11-week old male Nu/nu mouse.

NOTE

When you make ROI measurements on fluorescent images, it is important to subtract the autofluorescence background. For more details, see Subtracting Tissue Autofluorescence, page 146.
F.6 Subtracting Instrument Fluorescent Background

The fluorescence instrumentation on an IVIS Imaging System is carefully designed to minimize autofluorescence and background caused by instrumentation. However, a residual background may be detected by the highly sensitive CCD camera. Autofluorescence of the system optics or the experimental setup, or residual light leakage through the filters can contribute to autofluorescence background. The Living Image software can measure and subtract the background from a fluorescence image.

Fluorescent background subtraction is similar to the dark charge bias subtraction that is implemented in luminescent mode. However, fluorescent background changes day-to-day, depending on the experimental setup. Therefore, fluorescent background is not measured during the night, like dark charge background is.

After you acquire a fluorescent image, inspect the signal to determine if a fluorescent background should be subtracted (Figure F.16). If background subtraction is needed, remove the fluorescent subject from the imaging chamber and measure the fluorescent background (select Acquisition → Fluorescent Background → Measure Fluorescent Background on the menu bar). In the Living Image software, the Sub Fluor Bkg check box appears on the Control panel after a background has been acquired. You can toggle the background subtraction on and off using this check box.

NOTE

The fluorescence background also contains the read bias and dark charge. Dark charge subtraction is disabled if the Sub Fluor Bkg option is checked.

Figure F.16 Comparison of dark charge bias subtraction (left) and fluorescent background subtraction (right).
The autofluorescence from the nose cone and filter leakage have been minimized in the image on the right by using Sub Fluor Bkg option.

F.7 Adaptive Background Subtraction

Adaptive background subtraction is a simple way to reduce the "instrument fluorescent background" by fitting and removing the background using the existing image (for example, the left image in Figure F.16).

Unlike the method described in section F.6, Subtracting Instrument Fluorescent Background, where you acquire an actual instrument fluorescent background image by removing the fluorescent subject from the imaging chamber to correct the background, the new method uses software correction. To perform adaptive background subtraction:
• Identify the fluorescent subject in the original image using the photo mask
• The software automatically fits the instrument background to the whole image using the pixels outside of the subject
• The software subtracts the fitted instrument background from the original image

In most situations, such adaptive software correction works as effectively as the traditional method except the following cases:

• The subject is dark, making it is difficult to mask the subject using the photo (for example, experiments that use black well plates)
• The subject occupies most of the FOV (for example, high magnification or multiple mice in the FOV). As a result, there is not enough information outside the subject that can be used to help fit the background.

F.8 Subtracting Tissue Autofluorescence Using Background Filters

High levels of tissue autofluorescence can limit the sensitivity of detection of exogenous fluorophores, particularly in the visible wavelength range from 400 to 700 nm. Even in the near infrared range, there is still a low level of autofluorescence. Therefore, it is desirable to be able to subtract the tissue autofluorescence from a fluorescent measurement.

The IVIS Imaging Systems implement a subtraction method based on the use of blue-shifted background filters that emit light at a shorter wavelength (see Table 9.2, page 146). The objective of the background filters is to excite the tissue autofluorescence without exciting the fluorophore. The background filter image is subtracted from the primary excitation filter image using the Image Math tool and the appropriate scale factor, thus reducing the autofluorescence signal in the primary image data. (For more details, see Chapter 9, page 146.) The assumption here is that the tissue excitation spectrum is much broader than the excitation spectrum of the fluorophore of interest and that the spatial distribution of autofluorescence does not vary much with small shifts in the excitation wavelength.

Figure F.17 shows an example of this technique using a fluorescent marker. In this example, $1 \times 10^6$ HeLa-luc/PKH26 cells were subcutaneously implanted into the left flank of a 6-8 week old female Nu/nu mouse. Figure F.18 shows the spectrum for HeLa-luc/PKH26 cells and the autofluorescent excitation spectrum of mouse tissue. It also shows the passbands for the background filter (DsRed Bkg), the primary excitation filter (DsRed), and the emission filter (DsRed). Figure F.17 shows the IVIS® images using the primary excitation filter, the background excitation filter, as well as the autofluorescent-corrected image.

The corrected image was obtained using a background scale factor of 1.4, determined by taking the ratio of the autofluorescent signals on the scruff of the animal. The numbers shown in the figures are the peak radiance of the animal background within the region of interest. In the corrected image, the RMS error is used to quantify the background. The signal-to-background ratio of the original fluorescent image (DsRed filter) is 6.5. The ratio increases to 150 in the corrected image, an improvement factor of 23. This improvement reduces the minimum number of cells necessary for detection from $1.5 \times 10^5$ to $6.7 \times 10^3$. 
Figure F.17 Example of the autofluorescent subtraction technique using a background excitation filter.
a) primary excitation filter (DsRed), b) blue-shifted background excitation filter (DsRed Bkg), and c) corrected data. The corrected image was obtained by subtracting the scaled background filter image (multiplied by 0.47) from the primary filter image. The 6-week old female Nu/nu mouse was injected subcutaneously with $1 \times 10^6$ HeLa-luc/PKH26 cells in the left flank.

Figure F.18 Spectral data describing the autofluorescent subtraction technique using a background filter. The graph shows the excitation and emission spectrum of PKH26 and the autofluorescent excitation spectrum of mouse tissue. Also included are the spectral passbands for the blue-shifted background filter (DsRed Bkg), the primary excitation filter (DsRed), and the emission filter used with this dye.
Appendix G  Planar Spectral Imaging

The unique spectral signatures of the luciferase emission spectrum and the optical properties of tissue enable the Living Image software to determine the depth and intensity of light sources inside a living animal. The planar spectral imaging algorithm relies on a diffusion model of light propagation in tissue and assumes a point source of light embedded in a flat surface approximation of the mouse. The algorithm is designed to provide a fast and robust method to approximate source location and brightness. The analysis requires two or more single-view images at wavelengths between 560 and 660 nm.

The Diffuse Tomography (DLIT) algorithm is a more complete and accurate model. It analyzes images of surface light emission to produce a three-dimensional (3D) reconstruction of the luminescent light sources in a subject. For more details on DLIT analysis, see Chapter 15, page 193 and Appendix H, page 285.

G.1 Planar Spectral Imaging Theory

An image acquired on an IVIS Imaging System is a diffuse projection on the surface of the animal from the luminescent sources located deeper inside. Information about the depth of the luminescent cells can help quantify the source brightness and provide information on the location of the cells.

The Living Image software uses spectroscopic information from a single-view image to estimate the depth of the luminescent cells. The method takes advantage of the fact that firefly luciferase bioluminescence is emitted from 500 to 700 nm, a region of the spectrum where there are major contrasts in tissue optical properties (Figure G.1).

In this portion of the spectrum, tissue absorption drops off dramatically between 500-580 nm (green/yellow wavelengths) and 600-750 nm (red wavelengths), due mainly to the presence hemoglobin. As a result, the luminescent signal observed on the surface of the animal is dependent on both the wavelength and the thickness of the tissue through which it travels.

The depth and absolute photon flux of a single point source can be determined from two or more images acquired at different wavelengths using relatively simple analytical expressions derived from the diffusion model of the propagation of light through tissue.
Diffusion Model of Light Propagation Through Tissue

Light propagating through tissue undergoes scattering and absorption. The diffusion model assumes that scattering is the predominant phenomenon and the reduced scattering coefficient $\mu'_s$ $\gg$ absorption coefficient $\mu_a$. This is valid mostly for wavelengths in the red and near infrared part of the spectrum. The model also assumes that the light is produced by a single point source and that the tissues are optically homogeneous.

Under these conditions, if we model the animal surface as flat and infinite in extent and integrate the light that is collected over the animal surface, the total integrated intensity $I(\lambda)$ is reduced to a relatively simple expression:

$$I(\lambda) = S K(\lambda) \exp(-\mu_{eff} d)$$

where $S$ is the absolute total photon flux emitted by the luminescent source and $d$ is the source depth.

The term $\mu_{eff}$ is the effective attenuation coefficient. It is determined by the tissue coefficient of absorption ($\mu_a$) and reduced scattering ($\mu'_s$) that quantify the two main phenomena light undergoes in tissue.

The function $K(\lambda)$ is a more complex expression that is derived from the model and includes terms that describe the effect of the tissue-air boundary on the light propagation. Both $\mu_{eff}$ and the function $K$ are dependent on the wavelength, $\lambda$.

Equation 1 shows that if the total integrated intensity (ROI measurement) is measured at several wavelengths, it is proportional to an exponential function of the product of the depth and the optical property, $\mu_{eff}$. Therefore, the steps to planar spectral image analysis include:

- Acquire two or more images at different wavelengths.
- Measure the total integrated intensity on each image.
- Fit the measured values to the exponential function of Equation 1.

The results of the fit are the total flux of the luminescence source $S$ and the source depth $d$. 

---

**Figure G.1** Optical Properties of Mouse Tissue and Firefly Luciferase Spectra

The luminescent signal from firefly luciferase (right) is emitted from wavelengths of 500-700 nm, which spans a region of the spectrum where there are major contrasts in the optical properties of mouse tissue (left). The firefly spectrum was measured at 37°C using PC3M cells.
G.2 Optical Properties

Planar spectral image analysis requires prior knowledge of the tissue optical properties at the wavelength used at image acquisition. The two main optical parameters are the:

- **Absorption coefficient** ($\mu_a$) that defines the inverse of the mean path before photons are absorbed by the tissue.
- **Reduced scattering coefficient** ($\mu_s'$) that defines the inverse of the mean path before photons are scattered isotropically in the tissue.

The effective attenuation coefficient ($\mu_{\text{eff}}$) is a function of the absorption and reduced scattering coefficients:

$$\mu_{\text{eff}} = (3\mu_a (\mu_s' + \mu_a))^{1/2}$$

(2)

Calculation of the function $K$ in Equation 1 requires all three coefficients ($\mu_a$, $\mu_s'$, and $\mu_{\text{eff}}$) as input. The function $K$ includes a term called the effective reflection coefficient to account for the reflection of light at the air-tissue boundary due to a mismatch in the index of refraction. The tissue index of refraction is generally assumed to be close to 1.4.

The model assumes that the tissues are optically homogeneous and the Living Image software provides several factory set tissue optical property values to choose from.

G.3 Luciferase Spectrum

Analyzing spectrally filtered images requires knowledge of the spectral dependence of luminescent light emission. The luciferase luminescence spectrum was measured *in vitro* at 37° C and pH ≈ 7 in various cell lines. This spectrum is used to normalize the photon flux values that the software measures at each wavelength.

Source spectra for several reporters are included in the database, including firefly, click beetle, renilla, and bacteria (Figure G.1).

**NOTE**

The firefly luciferase spectrum is temperature and pH dependent. The luciferase spectra included in the software are only valid for measurements performed at 37° C and pH 7.0-7.5. If you use other temperature or pH conditions for an experiment, the associated luciferase spectral curve is required for planar spectral image analysis. For more information on the pH and temperature dependence of the luciferase spectrum, please contact Caliper Corporation.
**G.4 An Example of Planar Spectral Imaging**

Melanoma cells were injected intravenously into the tail vein of nude mice. After 13 days, metastases developed in the lungs, kidney, and hind limb bone. An image sequence was acquired on the IVIS Imaging System 200 Series using filters at six wavelengths from 560 to 660 nm, in 20 nm intervals.

**NOTE**

When using the 560 nm and 580 nm band pass filters, tissue optics result in a larger attenuation of light (due mainly to hemoglobin absorption). A longer exposure time is recommended at these wavelengths.

Figure G.2 shows the metastasis sites. The signals from the lungs and right kidney are well defined in both animals. However, in the lower back area of the left mouse, the signals are in close proximity, causing an artifact in the planar spectral analysis.

To perform the planar spectral analysis, draw a measurement ROI that captures the entire signal of each site of interest without including a neighboring metastasis (Figure G.3).

After the ROI is defined, start the planar spectral analysis (for more details, see page 149). The software:

- Measures the total flux inside the ROI on each filtered image.
- Normalizes the data to the luciferase spectrum (Plot of Intensity vs. Lambda, Figure G.4).
- Fits the normalized data to the analytical expression in Equation 1, page 278 where \( S \) = absolute total photon flux emitted by the luminescence source and \( d \) = source depth (Plot of Linear Fit Results, Figure G.4)
To estimate the cell count, divide the absolute photon flux by the flux per cell. This is best determined by making independent *in vitro* measurements of the cell line used in the experiment.
The Plot of Linear Fit Results is weighted by the uncertainty of the measured images and takes into account the uncertainty in the determination of the optical properties. The precision of the method is largely determined by the known precision of the optical properties. In most cases, the relative uncertainty in the depth determination is equal to the relative uncertainty in the optical properties.

An analysis of the dorsal and ventral views of the mouse left lung in Figure G.5 results in total flux values that are very similar. The measured depth values are also close, indicating that the cells are distributed about the same distance from the front and back of the animal.

Figure G.5 Planar spectral analysis results
Top: Dorsal view of the left lung, bottom: ventral view of the left lung
G.5 Optimizing the Precision of Planar Spectral Analysis

The accuracy of the planar spectral analysis is highly dependent on the quality of the:

- Measured data for the firefly luciferase spectrum and the tissue optical properties.
- Fit of the experimentally measured total flux at each wavelength to $\mu_{\text{eff}}$ (effective attenuation coefficient).

In general, more experimental values produce a better fit of the data. It is particularly important to be able to extract signals at all wavelengths to optimize the quality of the fit. If the software detects no signal above the animal background level at 560 nm and 580 nm (the wavelengths that absorb the most light), the dynamic range of the optical properties is reduced and with it, the precision of the fit.

If a luminescent signal is dim or buried deep in the tissue, it may barely exceed the tissue autoluminescence at the shorter, more absorbing wavelengths (560 and 580 nm). In this case, it is recommended that you subtract the tissue autoluminescence from the image data. (For more details on subtracting tissue autoluminescence, see Appendix E, page 260). It is also recommended that you inspect all images in the sequence to confirm that the luminescent signal is greater than the tissue autoluminescence. If the luminescent signal does not exceed the tissue autoluminescence at a particular wavelength, do not include that wavelength in the analysis.
[This page intentionally blank.]
# Appendix H  DLIT & FLIT Reconstruction of Sources

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determining Surface Topography</td>
<td>285</td>
</tr>
<tr>
<td>Converting Light Emission to a Photon Density Map</td>
<td>286</td>
</tr>
<tr>
<td>Defining the Linear Relationship Between a Source and Photon Density or NTF Efficiency</td>
<td>287</td>
</tr>
<tr>
<td>Determining the Best Approximate Solution to the Linear System</td>
<td>288</td>
</tr>
<tr>
<td>Source &amp; Tissue Properties</td>
<td>288</td>
</tr>
</tbody>
</table>

Diffuse Tomography (DLIT) is a technique that analyzes images of the surface light emission from a living subject to generate a three-dimensional (3D) reconstruction of luminescent light source distribution inside the subject.

Fluorescent Tomography (FLIT) analyzes images of surface light emission to generate a 3D reconstruction of fluorescent light source distribution inside the subject.

**NOTE**

To reconstruct luminescent sources, the Living Image software requires a photograph, a structured light image, and luminescent images obtained at two or more wavelength filters from 560-660 nm. To reconstruct fluorescent sources, the software requires a structured light and fluorescent images obtained using the same excitation and emission filters at different transillumination source positions on the IVIS Spectrum.

To localize and quantify the light sources in a subject, the software:

- Reconstructs the subject surface topography (*surface*) from structured light images. The surface is defined by a set of connected polygons or surface elements.
- Maps the surface radiance (photons/s/cm²/steradian) to the photon density (photons/mm³) just beneath the surface of each element of the surface.
- Divides the interior of the subject into a solid surface of volume elements or *voxels*. Each voxel is considered to contain a point light source at its center that contributes to the photon density at each surface element.
- Defines equations that relate the source strength of each voxel to the photon density at each surface element.
- Determines the optimum approximate solution to the system of linear equations to reconstruct the source strength in each voxel.

## H.1 Determining Surface Topography

The software determines the surface topography from a structured light image. Parallel laser lines are projected onto the subject to produce a structured light image (Figure H.1).

**NOTE**

If the Structure option is chosen in the Control panel, a structured light image is automatically acquired.

The surface topography of the subject is determined by analyzing the displacement ($\Delta x$) or bending of the laser lines as they pass over the subject. The displacement is defined as...
the difference between where the line should fall on the stage in the absence of the subject and where it appears in the image due to occlusion by the subject.

Figure H.1 Parallel laser lines projected onto a subject. Given knowledge of the angle $\theta$, the height of the subject ($h$) can be determined by analyzing the displacement, $\Delta x$, of the laser lines as they pass over the object.

The parallel lines are projected onto the surface of the subject at an angle ($\theta$). The angle is known by instrument calibrations of the distance between the structured light projector and the optical axis ($D$) and the distance between the stage and the structured light projector ($l$) (Figure H.2).

$D$ and $l$ form two perpendicular sides of a triangle giving:

$$\tan \theta = \frac{D}{l}$$

Together $\Delta x$ and $h$ comprise a smaller version of this triangle. The height ($h$) can be determined from:

$$h = \frac{\Delta x}{\tan \theta}$$

by measuring the displacement $\Delta x$.

The software utilizes fast numerical methods to rapidly evaluate $\Delta x$ over the entire image to determine the surface topography. The surface topography determination is limited to the topside of the object facing the lens.

**H.2 Converting Light Emission to a Photon Density Map**

The input data to the FLIT algorithm for 3D reconstruction of fluorescent light sources includes:

- A surface that defines the surface of the subject.
• A sequence of images acquired at different transillumination source positions using the same excitation and emission filter at each position. Use the Imaging Wizard to acquire the images.

The input data to the DLIT algorithm for a 3D reconstruction of luminescent light sources includes:

• A surface that defines the surface of the subject.
• A sequence of two or more images of the light emission from the surface of the subject acquired at different filter bandwidths (Table A.1). Use the Imaging Wizard to acquire the images.

**Table A.1** IVIS System filters for luminescence & fluorescence tomography

<table>
<thead>
<tr>
<th>IVIS Imaging System</th>
<th>Filters</th>
<th>Bandwidth (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 Series</td>
<td>6 emission filters, 550-670 nm</td>
<td>20</td>
</tr>
<tr>
<td>Spectrum</td>
<td>10 excitation filters, 415-760 nm, 18 emission filters, 490-850 nm</td>
<td>20</td>
</tr>
</tbody>
</table>

The IVIS Imaging System 200 Series and the IVIS Spectrum are absolutely calibrated so that the electron counts on each CCD pixel can be mapped back to the surface of the object to produce an absolute value of the surface radiance (photon/s/cm²/steradian) from each imaged surface element (Figure H.3).

![Figure H.3](Image)

**Figure H.3** Light emission from a surface element passes through the lens entrance pupil and is recorded in the image.

The imaging system collects the light emitted from the surface element at an angle ($\theta_e$) (measured with respect to the normal to the surface element) into the solid angle $d\Omega$ subtended by the entrance pupil. The value of the surface radiance $L(\theta_e)$ is directly related to the photon density $\rho$ (photons/mm$^3$) just inside the surface of the element. FLIT analysis uses NTF Efficiency data and takes into account the photon density of both the fluorescent image and transmission image.

**H.3 Defining the Linear Relationship Between a Source and Photon Density or NTF Efficiency**

The software divides the interior of the subject into a solid mesh of volume elements (voxels). Each voxel is considered to contain a point light source at its center. The index $i$ enumerates the set of voxels. $S_i$ is the value of the strength of the point source inside the $i^{th}$ voxel. The solid mesh defines a collection of point sources that approximate the actual source distribution. The accuracy of the approximation is improved by increasing the density of the solid mesh.
The reconstruction method is based on the principle that there is an approximately linear relationship between the source strength in each voxel \( S_i \) and the photon density or NTF Efficiency \( \rho_j \) at each surface element described by a Green’s function \( G_{ij} \). The photon density at the \( j^{th} \) surface element is the sum of the contributions from all the voxels:

\[
\rho_j \equiv \sum_i G_{ij} S_i \tag{1}
\]

The Green's function contains information about the transport of photons through the tissue and the effects of the tissue-air boundary. By using a planar boundary approximation, the Green's function can be calculated analytically as a solution to the diffusion equation. Having an analytic expression for \( G \) allows Equation 1 to be computed very rapidly.

### H.4 Determining the Best Approximate Solution to the Linear System

Once the Green's functions, \( G_{ij} \), are known, the goal is to solve Equation 1 for the source strength \( S_i \) in each voxel. The DLIT algorithm attempts to minimize \( \chi^2 \) (Equation 2) while requiring that the source strength in each voxel is positive (Equation 3).

\[
\chi^2 = \sum_j \frac{1}{\sigma_j^2} \left[ \rho_j - \sum_i G_{ij} S_i \right]^2 \tag{2}
\]

\[
S_i \geq 0 \tag{3}
\]

A Non-Negative Least Squares algorithm is used to find the approximate solution which minimizes \( \chi^2 \). In order to reduce the number of variables in the problem, the code only uses surface elements with signal above a certain threshold (minimum radiance) and only keeps the voxels that contribute significantly to these surface elements.

### H.5 Source & Tissue Properties

DLIT analysis of spectrally filtered images requires knowledge of the spectral dependence of luminescent light emission. Table H.1 shows the factory set source spectra provided by the software.

**NOTE**

The source spectra is not an input to the 3D reconstruction of fluorescent sources.
NOTE
The firefly luciferase spectrum is dependent on temperature and pH. The data provided are valid only for measurements performed at 37°C and at pH 7.0-7.5. Selecting other temperature and pH conditions for a specific experiment requires the use of the associated spectral curve for the spectral analysis. For more information about pH and temperature dependence of the luciferase spectrum, please contact Caliper Life Sciences technical support.

You can view tissue optical property values ($\mu_{\text{eff}}$, $\mu'_s$, $\mu_a$) in the Tissue Properties drop-down list. The tissue properties are plotted as a function of wavelength. Select the tissue or organ most representative of the source location. Muscle is a good choice for general reconstructions in vivo.

NOTE
Default tissue optical properties and source spectra are specified in the Preferences box. For more details, see Appendix B, page 245.
[This page intentionally blank.]
Appendix I  IVIS Syringe Injection System

Controlling the Infusion Pump .................................................. 291
Tracking Infusion in the Maximum vs. Time Graph .................. 293
Closing the Infusion Pump Control Panel ................................. 293

The IVIS Syringe Injection system is designed for use with the IVIS Kinetic Imaging System. You can control the infusion pump in the Living Image software or manually.

For more details on the setup and manual control of the infusion pump, see the IVIS Syringe Injection System instructions from Caliper or the PHD 22/2000 Syringe Pump Series User’s manual from Harvard Apparatus. Both are included on the Living Image installation CDROM.

The IVIS Syringe Injection system can be used during kinetic or still image acquisition; however, subjects must remain immobile.

I.1 Controlling the Infusion Pump

After the IVIS Kinetic Imaging System is initialized and locked, you can access the infusion pump controls.

1. Select Acquisition → Infusion Pump Setup on the menu bar.
   — The Infusion Pump control panel appears above the IVIS acquisition control panel.

![Figure I.1 Display the Infusion Pump control panel](image)

   **Figure I.1** Display the Infusion Pump control panel

**NOTE**

If you are going to acquire kinetic data, open the infusion pump control panel before you open the kinetic acquisition control panel. When the kinetic control panel is open, the Acquisition menu is unavailable.

2. Set the volume and flow rate.
3. Make a selection from the Syringe Type drop-down list (the associated syringe diameter is automatically entered).

   To enter a custom syringe:
   a. Select **Custom** from the drop-down list.
   b. Click **OK** in the dialog box that appears.
   c. Enter the syringe diameter in the infusion pump control panel.

   **NOTE**
   Custom syringe information that is entered in the infusion pump control panel is not saved to the system.

4. To automatically start the infusion pump after data acquisition begins, choose **Auto Start After** and enter the amount of seconds. For example, enter 10 to start infusion 10 seconds after acquisition begins.

   To manually start infusion, click **Start Now**.

5. To automatically stop infusion, choose **Auto Stop After Acquisition**. To manually stop infusion at any time, click **Stop Now**.

   If the auto stop option is not chosen and you do not manually stop the pump, the pump continues to run after acquisition ends until the specified infusion volume is reached.

   **NOTE**
   The information in the infusion pump control panel is saved in the click info file. During acquisition, if you start infusion, then manually stop and restart the infusion, only the last actual start and stop is saved to the click info file, not the start/stop settings in the panel.
I.2 Tracking Infusion in the Maximum vs. Time Graph

During kinetic acquisition, the blue shaded region in the Max vs. Time graph indicates the infusion period. During acquisition, if you start infusion, then manually stop and restart infusion, only the last actual start and stop is recorded in the Maximum vs. Time graph. The graph stops recording infusion when acquisition stops (even though the pump may not be stopped).

Figure I.4 Tracking infusion

I.3 Closing the Infusion Pump Control Panel

1. Close the kinetic control panel.
2. Click Acquisition → Infusion Pump Setup on the menu bar. — The check mark is removed and the panel closes.
### Appendix J  Menu Commands, Tool Bar, & Shortcuts

#### Figure J.1  Living Image toolbar

#### Table J.1  Menu bar commands and toolbar buttons

<table>
<thead>
<tr>
<th>Menu Bar Command</th>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File ➞ Open</td>
<td><img src="image" alt="Open icon" /></td>
<td>Displays the Open box so that you can select and open an image data file.</td>
</tr>
<tr>
<td>File ➞ Browse</td>
<td><img src="image" alt="Browse icon" /></td>
<td>Displays the Browse For Folder box so that you can select and an image data folder. The selected folder is displayed in the Living Image browser.</td>
</tr>
<tr>
<td>File ➞ Save</td>
<td><img src="image" alt="Save icon" /></td>
<td>Saves (overwrites) the AnalyzedClickInfo text file to update the analysis parameters, but the original image data files are not altered.</td>
</tr>
<tr>
<td>File ➞ Save As</td>
<td><img src="image" alt="Save As icon" /></td>
<td>Displays the Browse For Folder box so that you can specify a folder in which to save the image data. The original data is not overwritten.</td>
</tr>
<tr>
<td>File ➞ Import ➞ 3D Surface</td>
<td><img src="image" alt="Import 3D Surface icon" /></td>
<td>Opens a dialog box that enables you to import a surface. <strong>Note:</strong> This menu item is only available if “Show Advanced Options” is selected in the Preferences (see page 238).</td>
</tr>
<tr>
<td>File ➞ Import ➞ 3D Voxels</td>
<td><img src="image" alt="Import 3D Voxels icon" /></td>
<td>Opens a dialog box that enables you to import a source volume. <strong>Note:</strong> This menu item is only available if “Show Advanced Options” is selected in the Preferences (see page 238).</td>
</tr>
<tr>
<td>File ➞ Import ➞ Organ Atlas</td>
<td><img src="image" alt="Import Organ Atlas icon" /></td>
<td>Opens a dialog box that enables you to import an organ atlas (.atlas).</td>
</tr>
<tr>
<td>File ➞ Export ➞ Image/Sequence as DICOM</td>
<td><img src="image" alt="Export Image/Sequence as DICOM icon" /></td>
<td>Opens the Browse for Folder dialog box that enables you to export the active image data to DICOM format (.dcm).</td>
</tr>
<tr>
<td>File ➞ Export ➞ 3D Surface</td>
<td><img src="image" alt="Export 3D Surface icon" /></td>
<td>Opens a dialog box that enables you to save the 3D surface of the active data to a file such as Open Inventor format (.iv).</td>
</tr>
<tr>
<td>File ➞ Export ➞ 3D Voxels</td>
<td><img src="image" alt="Export 3D Voxels icon" /></td>
<td>Opens a dialog box that enables you to save the voxels from the active data in Open Inventor format (.iv).</td>
</tr>
<tr>
<td>File ➞ Export ➞ 3D Scene as DICOM</td>
<td><img src="image" alt="Export 3D Scene as DICOM icon" /></td>
<td>Opens a dialog box that enables you to save a 3D reconstruction and/or surface in DICOM format. The Multi-Frame DICOM option supports 3D CT reconstruction in third party software.</td>
</tr>
<tr>
<td>File ➞ Print</td>
<td><img src="image" alt="Print icon" /></td>
<td>Displays the Print box.</td>
</tr>
<tr>
<td>File ➞ Print Preview</td>
<td><img src="image" alt="Print Preview icon" /></td>
<td>Displays the Print Preview box that shows what will be printed.</td>
</tr>
<tr>
<td>File ➞ Recent Files</td>
<td><img src="image" alt="Recent Files icon" /></td>
<td>Shows recently opened data sets. <strong>Note:</strong> The number of files displayed can be set in the Preferences box (select Edit ➞ Preferences and click the General tab).</td>
</tr>
<tr>
<td>File ➞ Exit</td>
<td></td>
<td>Closes the Living Image software.</td>
</tr>
<tr>
<td>Edit ➞ Copy</td>
<td><img src="image" alt="Copy icon" /></td>
<td>Copies the active image window to the system clipboard.</td>
</tr>
<tr>
<td>Edit ➞ Image Labels</td>
<td><img src="image" alt="Image Labels icon" /></td>
<td>Opens the Edit Image Labels dialog box that enables you to edit the label set information for the active data.</td>
</tr>
<tr>
<td>Edit ➞ Preferences</td>
<td></td>
<td>Opens the Preferences box.</td>
</tr>
<tr>
<td>View ➞ Tool Bar</td>
<td></td>
<td>Choose this option to display the toolbar.</td>
</tr>
<tr>
<td>View ➞ Status Bar</td>
<td></td>
<td>Choose this option to display the status bar at the bottom of the main window.</td>
</tr>
</tbody>
</table>
Table J.1 Menu bar commands and toolbar buttons (continued)

<table>
<thead>
<tr>
<th>Menu Bar Command</th>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View ➞ Tool Palette</td>
<td></td>
<td>Choose this option to display the Tool Palette.</td>
</tr>
<tr>
<td>View ➞ Activity Window</td>
<td></td>
<td>Displays the Activity window at the bottom of the main application window. The Activity window shows a log of the system activity.</td>
</tr>
<tr>
<td>View ➞ Image Information</td>
<td></td>
<td>Displays the Image Information box that shows the label set and image acquisition information for the active data.</td>
</tr>
<tr>
<td>View ➞ ROI Properties</td>
<td></td>
<td>Displays the ROI Properties dialog box.</td>
</tr>
<tr>
<td>View ➞ ROI Measurements</td>
<td></td>
<td>Displays the ROI Measurements table.</td>
</tr>
<tr>
<td>View ➞ Image Layout Window</td>
<td></td>
<td>Opens the Image Layout window that enables you to paste an image of the active data in the window.</td>
</tr>
<tr>
<td>Tools ➞ Well Plate Quantification for ...</td>
<td></td>
<td>Opens the Well Plate Quantification window.</td>
</tr>
<tr>
<td>Tools ➞ Image Overlay for...</td>
<td></td>
<td>Opens the Image Overlay window for the active data.</td>
</tr>
<tr>
<td>Tools ➞ Colorize</td>
<td></td>
<td>Opens the Colorized View tab for the active sequence.</td>
</tr>
<tr>
<td>Tools ➞ Transillumination Overview</td>
<td></td>
<td>Combines the images of a FLIT sequence into a single image (intensities are summed) that can be analyzed using tools in the Tool Palette.</td>
</tr>
<tr>
<td>Tools ➞ Image Math for...</td>
<td></td>
<td>Opens the Image Math window for the active data.</td>
</tr>
<tr>
<td>Acquisition ➞ Background ➞ Measure Dark Charge</td>
<td></td>
<td>Opens a dialog box that enables you to acquire a dark charge measurement.</td>
</tr>
<tr>
<td>Acquisition ➞ Background ➞ Add or Replace Dark Charge</td>
<td></td>
<td>Opens a dialog box that enables you to select an instrument luminescent background. This background measurement is subtracted from luminescent images.</td>
</tr>
<tr>
<td>Acquisition ➞ Background ➞ Measure and Replace Dark Charge</td>
<td></td>
<td>Measures the dark charge under the same conditions as the currently selected image. When the measurement is complete, the newly acquired dark charge image will be included in the dataset of the current image, replacing any existing dark charge image that may be present in the dataset.</td>
</tr>
<tr>
<td>Acquisition ➞ Background ➞ View Available Dark Charge</td>
<td></td>
<td>Opens a dialog box that enables you to view the dark charge measurements for the system.</td>
</tr>
<tr>
<td>Acquisition ➞ Background ➞ Clear Available Dark Charge</td>
<td></td>
<td>Opens a dialog box that enables you to remove the dark charge measurements from the system.</td>
</tr>
<tr>
<td>Acquisition ➞ Background ➞ Auto Background Setup</td>
<td></td>
<td>Opens a dialog box that enables you to acquire background images, or schedule or disable automatic background acquisition.</td>
</tr>
<tr>
<td>Acquisition ➞ Fluorescent Background ➞ Measure Fluorescent Background</td>
<td></td>
<td>Starts a measurement of the instrument fluorescent background.</td>
</tr>
<tr>
<td>Acquisition ➞ Fluorescent Background ➞ Add or Replace Fluorescent Background</td>
<td></td>
<td>Opens a dialog box that enables you to select an instrument fluorescent background measurement for the active image data. If the Sub Fluor Bkg option is chosen in the control panel, the background measurement is subtracted from the image data.</td>
</tr>
<tr>
<td>Acquisition ➞ Fluorescent Background ➞ Measure and Replace Fluorescent Background</td>
<td></td>
<td>Opens a dialog box that enables you to select a fluorescent background measurement.</td>
</tr>
<tr>
<td>Acquisition ➞ Fluorescent Background ➞ View Available Fluorescent Background</td>
<td></td>
<td>Opens a dialog box that displays the fluorescent background measurements for the system. If a fluorescent background is selected, the Sub Fluor Bkg option appears in the control panel. Choose the Sub Fluor Bkg option to subtract the user-specified background measurement from the image data.</td>
</tr>
</tbody>
</table>
Table J.1  Menu bar commands and toolbar buttons (continued)

<table>
<thead>
<tr>
<th>Menu Bar Command</th>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition ➞ Fluorescent Background ➞ Clear Available Fluorescent Background</td>
<td></td>
<td>Opens a dialog box that enables you to remove the fluorescent background measurements from the system.</td>
</tr>
<tr>
<td><strong>Window ➞ Close</strong></td>
<td></td>
<td>Closes the active image window.</td>
</tr>
<tr>
<td><strong>Window ➞ Close All</strong></td>
<td></td>
<td>Closes all image windows.</td>
</tr>
<tr>
<td><strong>Window ➞ Cascade</strong></td>
<td></td>
<td>Organizes the open image windows in a cascade arrangement (see page 109).</td>
</tr>
<tr>
<td><strong>Window ➞ Tile</strong></td>
<td></td>
<td>Organizes the open image windows in a tiled arrangement (see page 109).</td>
</tr>
<tr>
<td><strong>Window ➞ 1. &lt;Image or Sequence name&gt;</strong></td>
<td></td>
<td>A list of the open image windows. Click a window in the list to make it the active window (indicated by a check mark).</td>
</tr>
<tr>
<td><strong>Window ➞ 2. &lt;Image or Sequence name&gt;</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Window ➞ etc.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Window ➞ Other Windows ➞ Living Image Browser</strong></td>
<td></td>
<td>If the Living Image browser and/or control panel is open, use these commands to make the browser or the control panel the active window and display it on top of all other open windows.</td>
</tr>
<tr>
<td><strong>Window ➞ Other Windows ➞ Acquisition Control Panel</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Help ➞ About Living Image</strong></td>
<td></td>
<td>Displays information about the Living Image software and Caliper technical support contact information.</td>
</tr>
<tr>
<td><strong>Help ➞ License information</strong></td>
<td></td>
<td>Displays the license information.</td>
</tr>
<tr>
<td><strong>Help ➞ Plug-in Information</strong></td>
<td></td>
<td>Displays a list of tool plug-ins and tool palette plug-ins.</td>
</tr>
</tbody>
</table>

Table J.2  Keyboard shortcuts

<table>
<thead>
<tr>
<th>Keys</th>
<th>Shortcut Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + B</td>
<td>Opens the Living Image browser.</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copies the active image to the system clipboard.</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Arranges open windows in a cascade.</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Displays a dialog box that enables you to open data.</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Open the Print dialog box.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Saves the active file or window.</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Tiles the open windows.</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Closes the active window.</td>
</tr>
<tr>
<td>Shift + F1</td>
<td>Changes the mouse pointer to the “What’s This” tool. Click this button, then click an item in the user interface to display information about the item.</td>
</tr>
</tbody>
</table>

NOTE

Macintosh users use the Cmd key (apple key) instead of the Ctrl key.
[This page intentionally blank.]
Index

Numerics
3D quantification database 187–191
   create 188–190
   manage results 191
   samples 187
3D reconstruction
   fluorescent sources 202–204
   luminescent sources 195–201
   reconstruct particular regions 201
3D reconstruction results
   DLIT or FLIT 204–205
3D surface 169–175
3D tools 214–229
   Animate tab 223–229
   Registration 218–223
   Source tab 216–217
   Surface tab 214–216
3Dsurface
   export or import 174–175
   generate 170–171
   manage 174
   view perspective 172–173
A
   accumulate signal 68, 70
   acquire
      image sequence using Imaging Wizard 32–35
      image sequence with X-ray images 52–59
      kinetic data 65
      single fluorescent image (epi-illumination) 24–27
      single fluorescent image (transillumination) 28–31
      single luminescent image 21–24
      single X-ray image 47–52
   activity window 19
   adaptive fluorescent background subtraction 274
   adjusting image appearance 89
   animation 223–229
      custom 227–228
      edit an animation setup 229
      preset 225
   animation tools 223–229
   auto exposure feature 18
   autofluorescence 120, 269
      miscellaneous material 271–272
      See tissue autofluorescence.
      subtract using background filters 275–276
      well plate 269–270
   autoluminescence 120
   automatically draw ROIs 117–119
   average background ROI 112, 120
B
   background
      adaptive fluorescent background subtraction 274
      fluorescent 269–274
      light on sample 258–260
      tissue autofluorescence 275–276
   background light
      from sample 260–261
      on sample 258–260
   background-corrected signal 120–122
   band gap 266
   bandpass filter 265
   binning 92, 248–250
   browse image data 81–84
   browser 83
C
   Caliper Corporation
      technical support 3
   cascade images 109
   color table 251
   colorize data 104–105
   composite image 143–145
   control panel 18, 231–235
   conventions 2
   copy
      ROI measurements 138
   correction/filtering tools
      binning 92
      cosmic correction 92
      dark background subtraction 92
      flat field correction 92
      smoothing 92
   cosmic correction 92
   cosmic ray corrections 256
   counts 253
   crop box 99
D
   dark background subtraction 92
   dark charge 258
   dark current 257
   data
      graphic image 251
      scientific image 251
   Data Preview window 199–201
   detection efficiency 247
detection sensitivity
   adjusting the lens aperture 247
exposure time 248
field of view 248
DICOM file
   size limit 74
diffusion model 278
display units
   counts 253
   efficiency 255
   photons 254
DLIT
   sequence requirements 195
DLIT results 204–205
   manage 206
DLIT/FLIT troubleshooting 230
   drift correction 257
E
edit image label 88
edit image sequence 107–108
efficiency 255, 264, 268–269
electronic background
   dark charge 258
   dark current 257
   drift 257
   read bias 257
EM gain 68
export
   image data 45
   point source fitting results 181
   surface 174–175
export image data 45
export images 106–107
exposure time 248
F
f/stop 247, 248
   fluorescent imaging 267
field of view 248
filter
   bandpass 265
   fluorescent 266
filter spectra 265
flat field correction 92
flat fielding 256
FLIT
   sequence requirements 202
FLIT results 204–205
   manage 206
fluorescence
   adaptive background subtraction 274
   reconstruct 3D sources 202–204
fluorescence efficiency 268–269
fluorescence imaging components 263–265
fluorescent filters 266
fluorescent imaging
   efficiency 264
   f/stop 267
   normalization 264
   single image (epi-illumination) 24–27
   focus manually 236
G
graphic image data 251
H
help 20
High Reflectance Hemisphere 259
high resolution imaging
   kinetic imaging 70–72
   luminescent or fluorescent imaging 43–44
   X-ray imaging 59–61
histogram 95
I
image
   adjusting appearance 89
   cascade 109
   correct or filter 91–92
   correcting/filtering tools 91–92
   export 106–107
   histogram 95
   information 87
   line profile 96
   magnify or pan 91
   measurements 98
   pixel data 94
   print 106–107
   tag 100
   tile 109
image data
   browse 81–84
   colorize 104–105
   export 45
   open 84
   save manually 44
image layout window 106–107
image math 143–145
image overlay tool 101–104
image sequence
   application-specific 10
   create from individual images 108–109
   edit 107–108
   include X-ray images 52–59
   manual setup 38–42
image window 85
imaging modes 7–9
imaging system capabilities 10
Imaging Wizard 32–35
import
    organ atlas 222
    surface 174–175
information about an image 87
infusion pump 291
infusion syringe injection system
    control panel 292
    infusion pump 291
initialization
    See system initialization.
instrument fluorescent background
    background
        instrument fluorescent background 274
IVIS Imaging System
    fluorescence imaging components 263–265
K
kinetic
    acquisition settings 67
    acquisition window 66
kinetic data
    acquire 65
    save 74, 75
    view and edit 72–73
kinetic ROI
    plot 124
    draw 124
    draw 123
L
    lens aperture 247
    line profile 96
    Living Image browser 83
    Living Image software
        starting 15
    luciferase spectrum 279
    luminescence
        reconstruct 3D sources 195–201
    luminescent imaging (single image) 21–24
M
    magnify image 91
    manual
        focusing 236
        save data 44
    manual conventions 2
    manual sequence setup 38–42
    maximum vs time graph
        tracking infusion 293
maximum vs. time graph 66
measurement ROI
    automatically draw 117–119
    measurement ROIs 112, 116–119
    free draw 119
    measurements 98
    measuring relative density 61–63
    menu commands 295
miscellaneous material autofluorescence 271–272
multiple reporters per photograph 101–104
N
    NNLS
        weighted fit 205
    normalization 264
    NTF Efficiency 28, 137, 231, 253, 287
O
    open image data 84
    optical density 266
    optical properties for planar spectral imaging 279
    organ atlas - import 222
    organ display 219–222
    organ registration tools 218–223
    overlay 252
    overlaying images 101–104
P
    pan image 91
    PCA biplot 167
    PCA explained variance 167
    photon density 207
    photon density map
        measured 208
        simulated 208
    photon density maps 207
    photon radiance 255
    photons 254
    pixel 251
    pixel data 94
    planar spectral analysis
        optimizing precision 283
    planar spectral image analysis 149–151
    planar spectral imaging 277–283
        diffusion model 278
        intensity graph 152
        linear fit graph 152
        luciferase spectrum 279
        optical properties 279
        sequence requirements 149
        tools 151–152
    point source fitting 177–179
    export results 181
    manage results 182
results 180–183
sequence requirements 177
tools 177–178, 183–186
preferences 237–245
print images 106–107
pseudocolor image 251

Q
quantification database 187–191
create 188–190
manage results 191
samples 187

R
radiance
photon 255
radiance units 254
read bias 257
reconstruct 3D fluorescent sources 202–204
reconstruct 3D luminescent sources 195–201
reconstruct particular pixels 201
reduced Chi2 205
ROI 111
automatically draw 117–119
background-corrected signal 120–122
delete 134
edit dimensions 130
free draw 119
managing 125
manually draw 116–117
measurement ROI
free draw 119
measurement ROIs 116–119
Measurements table 113
move 129
move or edit label 133
quick guide 112
ROI line 132
save 133
subject 120
tools 114–115
ROI (kinetic)
quick guide 123, 124
ROI Measurements table 136–138
configure 138–140
copy or export 141
ROI properties 125–129
ROI types
average background 112, 120
measurement 112
subject 112

S
save
data manually 44
ROI 133
save
kinetic data 75
save
kinetic data 74
scientific image data 251
segment 40
sequence requirements
DLIT 195
FLIT 202
planar spectral imaging 149
point source fitting 177
spectral unmixing 157
smoothing 92, 250
software help 20
source depth 209
source spectrum 205
Spectra window 162–164
spectral imaging
See planar spectral imaging.
spectral unmixing 157–167
options 165–166
parameters 164–165
PCA biplot 167
PCA explained variance 167
results 160
sequence requirements 157
starting the software 15
starting the system
See system initialization.
steradian 255
subject ROI 112, 120
surface 169–175
export or import 174–175
generate 170–171
manage 174
view perspective 172–173
syringe injection system 291–293
system
initialization 17
optics autofluorescence 274
temperature 17
system activity 19

T
tag an image 100
technical support 3
temperature 17
threshold angle 205
tile images 109
tissue autofluorescence 275–276
eliminate by spectral unmixing 157–167
subtracting with background filters 146–148
tissue properties 205
tool palette 87
  3D tools 214–229
correcting/filtering 91–92
point source fitting 177–178, 183–186
ROI tools 114
toolbar 295
transillumination overview 100
troubleshooting DLIT/FLIT 230

U
uniform surface sampling 205
units
  See display units.
user activity 19
user preferences 237–245

V
ventral imaging chamber 65
voxel 287
vsize
  starting 205

W
well plate autofluorescence 269–270

X
X-ray
  acquire image 47–52
  acquire sequence 52–59

Z
Zoom Lens attachment 43–44, 59–61, 70–72